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1 What�s New in This Release
What�s New in Siebel Marketing User Guide, Version 7.7
Siebel Marketing User Guide is a new book for the 7.7 version of Siebel Marketing.

Table 1 lists changes described in this version of the documentation to support release 7.7 of the 
software.

 

Table 1. New Product Features in Siebel Marketing User Guide, Version 7.7

Topic Description

Enhanced budget requests

See, �Developing and Tracking 
Budgets for a Marketing Plan� on 
page 13.

Members of the marketing organization can use the Budget 
Request module to submit quarterly or annual budget items 
for funding and approval. Items can include important details 
such as business justification, funding amount needed, and 
specific tactics related to the item.

Enhanced expense tracking

See, �Tracking Marketing Expenses 
and Associating Invoices with 
Expenses� on page 16.

This enhanced feature allows the marketing team to keep 
accurate records of how much of the budget has been 
committed and spent in the following ways:

■ Each campaign, program, and event can provide a 
detailed expense budget to track the line item expenses 
for the project. 

■ Each expense item can also be tied to the vendor invoice 
and invoice items. 

Enhanced segmentation

See, �Marketing Segments and 
Segment Trees� on page 35.

The following are enhanced and new capabilities of Marketing 
segmentation:

■ Users can view the impact of adding and removing criteria 
as criteria are applied to a segment.

■ New reports with cascading-style counts show the 
interaction between individual elements of the segment 
criteria.

■ Mechanisms such as sampled counts and intelligent 
caching can improve the level of interactivity during the 
segmentation process. 

■ A new segment tree designer allows direct marketers to 
split and sample segments into highly targeted cells.
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What�s New in This Release ■  
Enhanced program design

See, �About Multistage Programs� 
on page 24.

The following new capabilities allow program managers to 
design multistage, recurring marketing programs:

■ Program designers implementing multistep programs can 
create conditional branching between stages of the 
program.

■ Each stage can have its own schedule and recurring 
execution.

■ Any stage can be scheduled and repeated independently 
of other steps in the program.

■ Any step in the program can be executed manually or 
automatically.

Program and campaign templates

See, �Creating and Applying 
Program Templates� on page 33 
and �Creating and Applying 
Campaign Templates� on page 97.

A new feature allows you to reuse any program, campaign, 
and event by saving them as templates.

For example, an organization might create templates that 
contain required activities such as example offers, execution 
options, and activity plans. When creating new tactics, users 
would choose from the list of available templates.

Exact matching for list import

See, �Importing External Lists� on 
page 150.

List Import now supports the ability to designate certain 
columns in the list import file to be used for exact matching. 
This supports detection of existing contacts and prospects 
without requiring the Data Quality Matching server.

Enhanced email marketing

See, �Creating and Editing Offer 
Templates� on page 55 and 
�Working with Email Offers� on 
page 65.

Siebel Email Marketing 7.7 offers enhanced personalization 
merge fields for email campaigns. New features provide 
additional flexibility to add merge fields, including 
information from external data sources and other tables 
within the Siebel application.

Simplified hierarchy

See, �Creating a Program� on 
page 25 and �Creating Campaigns� 
on page 91.

The new hierarchy consists of programs, stages, campaigns, 
and waves. (Before 7.7, program plans and campaign plans 
also were used.)

Wireless marketing

See, �Creating a Wireless Offer� on 
page 74.

Support for delivery of wireless offers using short messaging 
system (SMS).

Table 1. New Product Features in Siebel Marketing User Guide, Version 7.7

Topic Description
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2 Planning and Budgeting for 
Marketing
Siebel Marketing provides support for planning and budgeting across the marketing organization. 
Using marketing plans, marketing executives and managers can create high-level business plans that 
cover a broad set of tactics, including outbound and inbound programs, campaigns, and events. For 
each plan, the marketing executive or team can set goals and objectives, identify available funds, 
assign budgets, associate multichannel marketing tactics, share documents, and generate forecasts.

The Marketing Planning module can be applied to fit any organizational planning approach, including 
plans based on time periods (such as quarterly or annual planning cycles), business units, product 
lines, or any other management structure. Plans can be organized in hierarchies with any number of 
levels to support small marketing organizations as well as more complex planning processes. 

Executives can also set high-level corporate objectives and then assign goals to each business unit 
that is participating in the plan. Each business unit can then create its marketing plan to meet its 
own assigned goals, forecast the organization�s ability to achieve the assigned goals, and submit the 
plan for approval. Based on common goals and performance metrics, marketing organizations can 
develop their own set of key performance metrics and institute the use of those metrics across all 
marketing plans.

This chapter contains the following topics:

■ Creating a Marketing Plan on page 9

■ Creating and Submitting Budget Requests on page 19

Creating a Marketing Plan
You create a marketing plan in the Marketing Plans screen. The Marketing Plans list provides a list 
of all the marketing plans to which you have access.

The visibility filter provides several levels of visibility, including the following views:

■ My Marketing Plans displays marketing plans with which you are associated as a team member.

■ All Marketing Plans displays marketing plans in your assigned organizations. 

■ All Marketing Plans across My Organizations displays marketing plans that exist in your 
organizations and in any suborganizations in your organizations.

■ All Marketing Plans across Organizations displays the marketing plans that exist in all 
organizations in the your Siebel application.

To create a marketing plan

1 Navigate to the Marketing Plans screen.

2 In the Marketing Plans list, create a new record.
Siebel Marketing User Guide Version 7.7 ■ 9



Planning and Budgeting for Marketing ■  Creating a Marketing Plan
3 Complete the fields, using Table 2 on page 10 as a guide.

NOTE: The Forecast Revenue, Forecast Expenses, Actual Revenue, Actual Expenses and Total 
Funds fields contain read-only values that are determined by calculations from other views. For 
more information about these fields, see �To associate a fund request with a marketing plan� on 
page 15.

Setting Goals for the Marketing Plan
Each marketing plan can be associated with a set of goals. Each goal is a metric against which the 
performance of the plan will be measured.

Table 2. Marketing Plans Fields

Field Description

Assigned Budget (Optional) The amount of money approved for use on the marketing plan.

Planning Period (Optional) You associate the planning period with the plan so that you can use 
it during categorization and reporting. For example, you might need to track 
a quarterly or annual planning period.

Plan Code (Required) An identification code determined by the user. Must be a unique 
value.

Comments (Optional) A text field for any special comments for the plan.

Execution Period (Optional) The period in which the plan will actually be executed.

Approval Status (Optional) A status field that indicates that the plan has been submitted, 
approved, or declined.

Name (Required) The name of the marketing plan.

Objective (Optional) A text description of the objective of the marketing plan.

Organization (Optional) A multivalue field displaying all organizations associated with the 
plan. All organizations that appear in this list have visibility to the plan.

Product Lines (Optional) A dialog box containing product lines associated with this plan. 
Might include one or more product lines.

Products (Optional) A dialog box containing products associated with this plan. Might 
include one or more products.

Region (Optional) A listing of regions that you can associate with this plan. Regions 
are organized using a region hierarchy.

Team (Optional) A multivalue field containing members of the team for the plan.

Type (Optional) A list of the category types of marketing plans. Examples of 
possible values include Corporate, Regional, Business Unit, and Department.
Siebel Marketing User Guide Version 7.710 ■



Planning and Budgeting for Marketing ■  Creating a Marketing Plan
To create a goal for a marketing plan

1 Navigate to the Marketing Plans screen.

2 In the Marketing Plans list, drill down on the plan name.

3 Click the Goals view tab.

4 In the Marketing Plans form, from the Type drop-down list, select the appropriate type of plan.

5 In the Goals list, click Apply Goal Template.

The goals from the template automatically populate the Goals list. If a template is not available, 
a message appears.

6 If a goal template is not available, in the Goals list, create a new record.

7 In the new record, complete the fields using Table 3 as a guide.

NOTE: Make sure that you select the appropriate number format for the goal type.

Table 3. Fields for Marketing Plan Goals

Field Description

Average 
Contribution 
Margin

The average revenue margin on each order after deducting the cost of goods 
sold.

Conversion 
Rate %

The percentage of responses that convert to orders.

Forecast 
Amount or 
Forecast 
Quantity

If you know the expected forecast value, type it in the Forecast Amount or 
Forecast Quantity field. If you do not know the expected forecast value, leave 
the Forecast Amount or Forecast Quantity field empty, and add the value after 
you develop a forecast.
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Planning and Budgeting for Marketing ■  Creating a Marketing Plan
Creating Plan Tactics and Associating Plan Tactics with 
Marketing Plans
A plan tactic is a marketing program, event plan, or stand-alone campaign that you have associated 
with a marketing plan. A marketing plan can be associated with any number of marketing programs, 
event plans, or stand-alone campaigns.

■ A marketing program is any program created in the Programs screen.

■ An event plan can be any event plan created in the Events screen.

■ A stand-alone campaign can be any campaign created in the Campaigns screen that is not 
associated with a marketing program.

Metric Type of goal. The following are some of the values for this field:

■ Average Cost per Lead. (Number Format=Currency) The expected cost of all 
marketing activities in the plan divided by the number of sales leads 
generated.

■ Average Cost per Opportunity. (Number Format=Currency) The expected 
cost of all marketing activities in the plan divided by the number of sales 
opportunities generated.

■ Average Cost per Order. (Number Format=Currency) The expected cost of all 
marketing activities in the plan divided by the number of sales orders 
generated.

■ # Leads. (Number Format=Integer) The number of sales leads this plan is 
expected to yield. The definition of lead may vary based on your company�s 
business process.

■ ROI %. (Number Format=Percentage) The Return on Investment percentage 
that this plan is expected to earn.

■ Unit Volume. (Number Format=Integer) The number of product units that 
are expected to be sold as a result of this plan.

Number Format The types of formats are Number (nonfinancial), Percentage (nonfinancial), and 
Currency (financial).

■ If you select the Currency number format (a financial goal), complete the 
Target Amount field.

■ If you select a different number format (a nonfinancial goal), in the Target 
Qty field, type the target number for the goal.

NOTE: If the goal has a Number Format of Percentage be sure to type whole 
number values, not decimal values. For example, an ROI goal of 15% should 
be typed as �15�, not �.15�.

Table 3. Fields for Marketing Plan Goals

Field Description
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Planning and Budgeting for Marketing ■  Creating a Marketing Plan
You can create new tactics while developing your marketing plan or associate existing tactics with 
the marketing plan.

To create a new plan tactic and associate it with a marketing plan

1 Navigate to the Marketing Plans screen.

2 In the Marketing Plans list, query for the appropriate marketing plan.

3 Drill down on the marketing plan name.

4 Click the Plan Tactics view tab.

5 In the Plan Tactics list, create a new tactic.

6 (Required) In the new record, complete the Tactic Name and Type fields.

CAUTION: Be sure to select the correct Tactic Type (Program, Standalone Campaign, or Event 
Plan) before saving the record, because the type cannot be changed after the record is saved.

To associate an existing plan tactic with a marketing plan

1 Navigate to the Marketing Plans screen.

2 In the Marketing Plans list, query for the appropriate marketing plan.

3 Click the Plan Tactics view tab.

4 Drill down on the marketing plan name.

5 In the Plan Tactics list, click Add to associate an existing tactic to a marketing plan.

You can modify all the fields in this record except Type.

6 In the Pick Tactic dialog box, query for the program, event, or stand-alone campaign that you 
want to associate with the plan, and click OK.

NOTE: Each tactic can only be associated with one marketing plan.

Developing and Tracking Budgets for a Marketing Plan
You can use marketing plans to develop budgets. As you implement tactics, you can track the 
financial status of the marketing plan. A marketing plan contains financial details that provide 
visibility across your company's marketing spending. The following list includes some of the financial 
details you might want to use:

■ Authors of the plan can add the expected cost of the plan and owners of the budget can allocate 
money to the plan.

■ An associated group of budget requests allows tactic owners to send requests for funding through 
an approval process.

■ A list of tactics, including their requested and allocated budgets, can be associated with the plan.

■ Financial summary fields can calculate the forecast and actual revenue and expenses for all the 
tactics in the plan.
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Planning and Budgeting for Marketing ■  Creating a Marketing Plan
Use the marketing plan to review and approve budgets, to forecast expenses and revenues, and to 
record actual expenses and revenues for all the programs, campaigns, and events in your 
organization. The marketing plan provides the following categories of values for managing marketing 
budgets:

■ Requested and Assigned Budget. The Plan Tactics view tab contains two fields that show how 
much money the plan owner has requested (Requested Budget) and how much money has been 
approved by the budget owner (Assigned Budget). These fields can be edited.

■ Forecast and Actual Expenses. The total forecast and actual expenses across all tactics in the 
marketing plan.

■ Forecast Expenses. Total forecast expense value for all expense records associated with the 
tactics (programs, campaigns, and events) in the marketing plan.

■ Actual Expenses. Total actual expense value for all expense records associated with the 
tactics in the marketing plan.

Table 4 identifies the location of expense data for each type of tactic.

■ Forecast and Actual Revenue. The total actual expenses and revenues across all tactics in the 
marketing plan. The Plan Details view tab includes a Financial Summary section summarizing 
total revenues for all the tactics in the plan. 

Table 5 identifies the location of revenue data for each type of tactic.

■ Forecast Revenue. A total of forecast values for revenue goals such as forecast amount for 
all tactics in the marketing plan.

Table 4. Expense Source Fields (Forecast and Actual)

Tactic Type Where to find the input data

Programs Programs screen > Plan > Expenses Campaigns screen > Plan > 
Expenses (for campaigns associated to programs)

Standalone Campaigns Campaigns screen > Plan > Expenses

Event Plans Events screen > Event Plans > Plan > Expenses 

Events Events screen > Plan > Expenses

Table 5. Revenue Goals Source Fields (Forecast and Actual)

Tactic Type Where to find the input data

Programs Programs screen > Plan view tab > Goals link

Campaigns Campaigns screen > Plan view tab > Goals link

Event Plans Events screen > Event Plans link > Plans view tab > Revenue link
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■ Actual Revenue. The Total Order Revenue for all orders associated with a tactic using values 
obtained from the Siebel Analytics Server after the Siebel Data Warehouse is populated from 
the Siebel transactional database. If the value from the Analytics Server is not integrated 
into your environment, the value is blank.

To assign requested and assigned budgets to marketing plan tactics

1 Navigate to the Marketing Plans screen.

2 In the Marketing Plans list, query for the appropriate marketing plan.

3 Click the Plan Tactics view tab and verify that you have associated your targeted programs, 
events, and stand-alone campaigns. 

For information on associating plan tactics, see �Creating Plan Tactics and Associating Plan Tactics 
with Marketing Plans� on page 12.

4 From the Plan Tactics Menu, select Columns Displayed.

Review the Available Columns list. Depending on your business needs, you might need to add 
columns to the list. For example, if you developed forecast values, you might want to add 
columns that contain forecast amounts.

5 In the Columns Displayed dialog box, move Requested Budget and Assigned Budget to the 
Selected Columns list and click Save.

6 In the appropriate column, type the requested or assigned amount.

If you developed forecast expenses for the tactic, you can verify the plan is within budget by 
comparing your assigned budget to the forecast expenses. 

Associating Fund Requests with a Marketing Plan
If your company uses the Market Development Funds module (MDF), any fund request can be 
associated with a plan tactic. For information about creating fund requests, see the section about 
fund requests in Siebel Partner Relationship Management Administration Guide.

To associate a fund request with a marketing tactic, each fund request needs a link to the Marketing 
Purpose field in the request. After you associate fund requests with a tactic, the total value of all 
associated fund requests appears in the Total Funds field in the Marketing Plan form.

To associate a fund request with a marketing plan

1 Navigate to the Fund Requests screen.

2 In the Fund Requests list, select the fund request, and then click the Marketing Purpose select 
button.

To see the Marketing Purpose field, you might need to click the menu button, choose Columns 
Displayed, and add the column.

3 In the Pick Source dialog box, select the marketing tactic (program, campaign or event).
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Attaching Documents to a Marketing Plan
You can attach planning documents to a marketing plan using the Documents view. These documents 
are visible to anyone who has access to the plan.

To attach a document to a marketing plan

1 Navigate to the Marketing Plans screen.

2 In the Marketing Plans list, drill down on the Marketing Plan name.

3 Click the Documents view tab and create a new record.

4 Click the Attachment Name select button, locate the document on your local machine or network, 
and click Open.

Tracking Marketing Expenses and Associating Invoices 
with Expenses
Siebel Marketing allows you to track the detailed expenses for your marketing tactics and associate 
invoices and invoice items with expenses. This section contains the following topics:

■ Adding Expenses for Programs, Campaigns and Events on page 16

■ Associating Invoices and Invoice Items with Expenses on page 18

Adding Expenses for Programs, Campaigns and Events
Using the Expense views for programs, campaigns, event plans and events, you can add the type 
and amount for each budget expense along with information such as the purchase order number and 
invoice details. After you add expenses, the total forecast and actual values are calculated and 
displayed in the parent marketing plan for the tactic.

To add expenses for a campaign

1 Use the step in the following list that applies to your product:

■ In Siebel Marketing, navigate to the Campaigns screen.

■ In other Siebel applications, navigate to the Campaign Management screen.

2 In the Campaigns list, drill down on the campaign name.

3 Click the Plan view tab 

4 In the Plan link bar, click Expenses.
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5 Click New and complete the fields. Table 6 on page 17 contains descriptions of some fields you 
might use.

To add program expenses

1 Navigate to the Programs screen.

2 In the Programs list, drill down on the program name.

3 Click the Plan view tab.

4 In the Plan link bar, click Expenses.

5 Click New, and complete the fields. 

Table 6 contains descriptions of some fields you might use.

Table 6. Expense Fields for Campaigns, Programs, and Events

Field Description

Actual # Units and 
Actual Unit Cost

Typically, the Actual amount indicates the cost of the expense after the 
actual quote or invoice is received.

The Actual Expense column is automatically calculated by multiplying 
Actual # Units by Actual Unit Cost. If you selected Fixed as the type 
for the Expense, the # Units will default to 1. If you selected Per Unit 
as the type, you will need to enter the Basis # Units for the expense.

Event (Optional for event expenses). Associates the expense with a specific 
event.

Expense A reference name for the expense.

Expense Date Determines the correct exchange rate, if your application spans 
multiple currencies.

Forecast # Units and 
Forecast Unit Cost

Typically, the Forecast amount indicates the expected cost of the 
expense before the actual quote or invoice is received for the expense. 

The Forecast Expense column is automatically calculated by 
multiplying Forecast # Units by Forecast Unit Cost. If you select Fixed 
as the type for the Expense, the # Units defaults to 1. If you select Per 
Unit as the type, you need to enter the Basis # Units for the expense.

Invoice Id The number under which this expense was billed your company. The 
Invoice will only be available if your company stores invoice 
information in the Siebel application.

Purpose (or Cost Type) The category for the expense.

Session (Optional for event expenses). Associates the expense with a specific 
session.

Unit Indicates if the expense is a fixed or per unit (variable) cost.
Siebel Marketing User Guide Version 7.7 ■ 17



Planning and Budgeting for Marketing ■  Creating a Marketing Plan
6 If appropriate, associate the expense to a specific campaign by selecting the campaign in the 
Campaign Name field.

To add event expenses

1 Navigate to the Events screen.

2 In the Events list, drill down on the event name.

3 Click the Plan view tab.

4 In the Plan link bar, click Expenses.

5 Click New, and complete the fields.

Table 6 on page 17 contains descriptions of some fields you might use.

To add event plan expenses

1 Navigate to the Events screen > Event Plan view.

2 In the Event Plan list, drill down on the event name.

3 Click the Plan view tab.

4 In the Plan link bar, click Expenses.

5 Click New, and complete the fields. 

Table 6 on page 17 contains descriptions of some fields you might use.

Associating Invoices and Invoice Items with Expenses
Invoice values are available only if your company stores invoice information in the Siebel application.

To associate invoices and invoice items with expenses

1 Navigate to the Campaigns, Programs, or Events screen.

2 Drill down on the campaign, program, or event name.

3 Click the Plan view tab.

4 In the Plan link bar, click Expenses.

5 In the Expenses list, locate the expense record with which you want to associate the invoice and 
Invoice item.

6 Click the Invoice Id # select button, query for the invoice number, and click OK.

NOTE: Only Invoices with a type of Payable appear.

7 Scroll down to the Invoice Line Items list, and click Add.

8 In the Pick Line Items dialog box, select one or more line items to associate with the expense.
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9 Click Update Actual Cost to update the Actual Expense field on the expense record.

NOTE: You can associate different line items from the same invoice to different expense records.

Using the Marketing Plan Explorer
You can use the Plan Explorer to review the organization of your marketing plans and its associated 
plan tactics.

To use the Plan Explorer

1 Navigate to the Marketing Plans screen > Plan Explorer view.

2 Expand the Marketing Plans folder.

3 To see plan tactics associated with a marketing plan, expand a plan tactics folder in the parent 
plan folder.

Creating and Submitting Budget 
Requests
Budget Requests allow you to create a request for money to pay for a marketing activity such as a 
campaign, program, or event. You can specify the amount of funding you need, associate the tactics 
related to the request, and submit the request for approval from the budget owner in your 
organization.

Budget requests can be associated with a marketing plan or created and approved without 
establishing a relationship to a marketing plan.

To create a budget request

1 Navigate to the Marketing Plans screen.

2 In the Marketing Plans link bar, select Budget Requests.

3 In the Budget Requests list, click New and complete the fields using Table 7 on page 20 as a 
guide.
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4 To associate programs, campaigns, or event plans with a budget request, select the Plan Tactics 
view tab and click Add.

Table 7. Budget Request Fields

Field Action

Budget Category (G/L 
Account)

Select the budget category for the request. The categories typically 
correspond to the values in the back-office accounting system 
general ledger.

Type The value corresponds to the categories that your organization uses 
to organize and review requests.

MDF Requested This value is automatically calculated by totaling all the MDF 
Requests associated with any tactics in the budget request.

Net Requested This value is automatically calculated by subtracting the MDF 
Requested from the Total Requested.

Line Number You can use this field in any way that meets your business needs. For 
example, some general ledger systems generate a line number for 
each budget item. You can use this field to track the line number 
from your general ledger system.

Approval Status Indicates the current approval status of the request. Choose a value 
from this field to submit, approve, decline, or request a revision of 
the request.

Approved Budget Specify the amount of money approved for the request. This field 
should be used only by employees with budget authority.

Marketing Plan Associates the request with the marketing plan.

Planning Period Indicates the time period during which the request will be credited. 
For example, an annual or quarterly budgeting period.

Region Select the region that will spend the funds.

Organization Associates the request with organizations that should have visibility 
to the request.

Pre-Approved Indicates if approval has already been provided. When you check the 
preapproval flag, the value in the Approval Status field is prefilled 
with Approved.

Delivery Date The date that the funds need to be available.

Team Select the employee positions that should have visibility to the 
request.

Brand The Brand (category) related to the tactics for the request.

Product Lines The product lines related to the request.

Products The products related to the request.

Target Industry The target industry for the tactics in the request.
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To associate a budget request with a marketing plan

1 Navigate to the Marketing Plans screen

2 In the Marketing Plans list, drill down on the Marketing Plan name.

3 Click the Budget Requests view tab.

4 In the Budget Requests list, click Add. 

5 In the Pick Budget Request dialog box, select the budget request, and click OK. 

NOTE: If there are any tactics associated with the budget request that are not already associated 
with a marketing plan, the tactics will automatically be associated with the marketing plan.

To submit a budget request

1 Create a budget request.

Make sure to complete the Total Requested field.

2 To associate a tactic with the request, performing the following steps:

a Scroll down to the Plan Tactics list.

b In the Plan Tactics list, click Add and select the plan tactic.

3 From the Approval Status drop-down list, choose Submitted.

Market Development Funds Select an MDF Fund to indicate the source of any MDF Requests that 
will be associated with tactics for the request. This relationship does 
not limit any associations between MDF Request and the tactics. 

Actual Total Expense The automatically calculated total of all expenses from the tactics 
associated with the budget request.

Actual MDF Received The automatically calculated total of all MDF Requests associated 
with the budget request tactics.

Table 7. Budget Request Fields

Field Action
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3 Designing Marketing Programs
A program is a multistep dialogue in which you can set up a series of communications to your 
customers and prospects. In the Programs screen, you can use the graphical drag-and-drop Program 
Flow view or the Program Explorer view to design and execute multistage, triggered, and recurring 
marketing programs using new or existing segments, lists, and campaigns.

You can establish multiple stages for a marketing program. Each stage can have multiple segments, 
segment trees, lists, and campaigns. Subsequent stages can be based on a customer response or 
any other event. For example, a visit by a sales person to a premium customer might trigger a follow-
up email to that customer for the selected product.

In the workspace, you can use the right-click menu to manually start Marketing Server tasks. To 
schedule server tasks to be started automatically, use the Schedule calendar.

The graphical Program Flow designer is integrated with Siebel�s workflow engine and Marketing 
Server. Therefore, once defined, the entire program can be automated from the initial customer 
segmentation through communication, to response collection and analysis. This capability is 
especially useful when programs are set to automatically recur, such as a monthly welcome package 
campaign to new customers.

Each time you design and implement a marketing program, you perform a number of tasks in the 
sequence shown in the following list:

1 Creating a program. Define the details of the program, such as purpose, team, the start and 
end date, and so on. For details, see �Creating a Program� on page 25.

2 Adding a stage to the program. Using the Program Flow view, add a stage milestone to the 
program and complete the stage details. For details, see �Using the Program Flow� on page 27, 
and �Adding a Stage to the Program� on page 27.

3 Assigning segments to a stage. Using the Program Flow view, select predefined segments that 
define the target customer you are trying to reach, and associate the segments to the stage. For 
details, see �Assigning Segments to a Stage� on page 28.

4 Adding a campaign to a stage. Using the Program Flow view, select one or more predefined 
campaigns with associated offers and link these campaigns to the program stage. For details, 
read �Adding a Campaign to a Stage� on page 29.

5 Defining waved distribution and vendor lists. To pace your distribution and avoid 
overloading your vendors and fulfillment center, you can set up waves. For details, see �Setting 
Up Waves for a Campaign Load� on page 30.

6 Adding lists to the campaign. If you have imported lists of prospects or contacts, you can 
optionally add these lists to the campaign. For details, see �Adding Imported or Internal Lists to a 
Campaign� on page 31.

7 Allocating segment tree cells to campaigns. For details, see �Allocating Segment Tree Cells 
for a Stage� on page 32.
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8 Using program templates. For details, see �Creating and Applying Program Templates� on 
page 33.

9 Executing Programs. For details, see �Executing Programs� on page 34.

10 Previewing the list. You can preview the names in your distribution list to make sure the list is 
formatted correctly and contains the contact information you need. For details, see �Previewing 
a List� on page 130.

11 Loading the campaign. When you are ready to save your target customers in the Siebel 
database, you can perform the Load Campaign task from the Program Flow or Program Explorer 
views, or schedule the task using the Schedule view. Loading the campaign saves contacts in the 
Siebel transaction database. For details, see �Loading Customers in Campaigns� on page 125.

12 Launching the campaign. After loading the campaign and generating the lists, you can launch 
the campaign from the Program Flow or Program Explorer views or schedule each stage, which 
automatically launches the campaigns. The Launch Campaign task distributes lists to vendors 
using FTP or email, and sends email, wireless and fax offers to contacts. For details, see 
Chapter 7, �Launching Programs and Campaigns.�

About Multistage Programs
Siebel Marketing supports both single-stage and multistage marketing programs. In a single-stage 
program, contacts are targeted in a stand-alone campaign, with no follow-up campaigns planned. 
During a multistage program, contacts in the first stage receive follow-up treatment in the program�s 
second and third stages, often based on the contact�s response to the original campaign. Multistage 
programs use stages to mark each phase of the program, campaigns to track separate instances of 
marketing messages, and campaign waves to track each batch of customers that are contacted. The 
following are types of multistage programs:

■ Marketing Program with Recurring Campaign. Scheduled to recur at standard intervals or 
specific times (daily, weekly, monthly, quarterly, yearly). For example, your company sends out 
a welcome kit and free gift to new customers on a monthly basis. Each month, a program stage 
occurs, new customers are identified (based on the segment criteria of account longevity of less 
than a month), and the welcome campaign is launched.

■ Event-triggered marketing program. Provides an automatic follow-up activity based on an 
action. For example, a customer visiting a product catalog might trigger an email offer to that 
customer based on items included in the prospect�s cart. If no response to the email is received, 
a telesales campaign is automatically launched to offer the customer a special offer on the 
product.

■ Response triggered marketing program. Uses response data to drive the next stage of the 
marketing program.

For example, the marketing manager of a bank designs a program implementing the company�s 
goal of increasing the number of bank-affiliated credit card customers. Within the program, he 
creates two campaigns, one offering a card with 10% interest and a $25 annual fee, the other 
offering 14% interest but no annual fee. These offers are sent to 250,000 of the company�s 
customers who do not already have credit card accounts with the bank.

After 30 days, response information is used to:
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■ Send a welcome packet of information to each new credit card customer.

■ Offer an 8%, $25 annual fee card to everyone who did not respond.

When using repeating stages, be sure that your segment criteria excludes customers who were 
targeted in any previous wave of the same campaign or same stage. This prevents the customers 
from receiving redundant messages.

About the Program Execution Workflow
Multistage programs can be launched manually or automatically scheduled using the calendar. When 
you use the calendar, it can trigger key events such as loading a campaign (list generation) and 
launching a campaign (sending lists to vendors and sending offers to targeted contacts). The 
Program Schedule drives the process, with activities triggering the execution of each program. Each 
of these key events can be executed manually, using the Program Flow menu or the Program Explorer 
menus.

The Stage Execution workflow process shows how executing a program, loading a campaign, and 
launching a campaign occur in a multistage process.

When the stage is activated, Siebel Marketing applies a predefined allocation of segment counts to 
campaigns. Campaigns are loaded and launched, and the next stage is scheduled. This process 
continues until the last stage occurs, and the program is completed. Each stage of a program is a 
unique event, and Siebel Marketing tracks campaign and response history at the unique campaign 
wave level (for each run). For more information about workflow processes and the Siebel Business 
Process Designer, see Siebel Business Process Designer Administration Guide.

Creating a Program
When you create a new program, you specify an objective, a type (for example, Cross-sell or Win-
back), a status (Planned, Active or Completed), a revenue goal, and a budget figure.

When you add organizations to a program, any campaign that you add to a program (using the 
program flow or program explorer) inherits the program's organizations. The campaign that you add 
retains any existing organizations and existing lead partner.

The organizations on the campaign represent the union of the program�s and campaign's 
organizations. After you add the campaign to the program, changes made to the organizations at the 
program will not be automatically reflected at the associated campaign level. Segments added to the 
program will not inherit the organizations. For additional information, see �Creating a Campaign� on 
page 92.

NOTE: You can turn off the teams and organizations inheritance features in Siebel Tools. In the 
appropriate business component, change the User Prop value for the Copy Teams and Copy 
Organizations property from Y to N. For more information, see Using Siebel Tools.

You can attach documents and other files and view program stages and status. In addition, you can 
add team members, activity plans, events, and design the actual program flow, using a graphical 
designer workspace.
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To create a program

1 Navigate to the Programs screen.

2 In the Programs list, create a new record.

3 Complete the fields using Table 8 on page 26 as a guide.

4 Drill down on a program to view additional fields.

5 Save the program.

To see available fields, in the Programs form, click the Show more button.

Table 8. Frequently Used Fields in the Programs List

Field Comment

Assigned Budget Click the Budget select button to select the program�s currency code, 
exchange date, and budget amount. The budget value is a top-down figure, 
rather than a calculated bottom-up figure such as the Expected Cost field.

Forecast Expense This read-only field displays the sum of the expense data added in the 
Forecast view for campaigns associated with the program. 

Forecast Revenue This read-only field displays the sum of the revenue predictions (based on 
data added in the Goals view) for campaigns associated with the program. 

Lead Partner Choose a partner organization to associate with the program. The Lead 
Partner is limited to the organizations associated to the program.

Organization Click the Organization select button and select the predefined organization 
that will be responsible for the program. An organization that you assign to 
a program will be inherited by campaigns in that program.

Region Choose the region to which the program is related.

Planned Start/
Planned End

(Required) Defaults to the current date and time. Use the select button to 
change the defaults.

Status The default program status is Planned. Options are Active and Completed. 
The status is changed from Planned, to Active, and Completed during 
automatic program execution. Manual execution of the program does not 
affect this field.

Summary Type a summary that describes the program�s goals.

Type Choose the program type. Options are Acquire, Retain, Win-Back, Cross-
Sell, and Up-Sell.
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Using the Program Flow
The logical flow for both single-stage and multistage programs is designed using the Program Flow 
view. In this view, you graphically define the program�s single-stage or multistage logic by dragging 
and dropping program components such as stages, segments, lists, campaigns, and events into the 
workspace. 

You can manually execute the program from the Program Flow view or automatically execute the 
program by scheduling a stage.

Before setting up the Program Flow, verify that the following tasks have been completed:

■ Define segments and lists and associate them with the campaigns.

■ Define campaigns and associated offers and events.

■ Define segment trees, if required.

The Program Flow view displays the selected program�s details and the interactive workspace with a 
palette of objects representing program elements such as stages, segments, campaigns, and internal 
lists. To set up a program flow, perform the following tasks:

■ Adding a Stage to the Program on page 27

■ Using Repeating Stages Within a Program on page 28

■ Assigning Segments to a Stage on page 28

■ Adding a Campaign to a Stage on page 29

■ Setting Up Waves for a Campaign Load on page 30

■ Adding Imported or Internal Lists to a Campaign on page 31

■ Executing Programs on page 34

Adding a Stage to the Program
Use the following procedure to add a stage to the program, using the Program Flow workspace.

To add a stage to the program

1 Navigate to the Programs screen.

2 In the Programs list, drill down on the program and click the Design view tab.

3 In the Program Flow workspace, select the Stage object from the palette and drag and drop it on 
the workspace.

4 To complete stage details, double-click the stage object in the workspace.
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5 In the Schedule view tab, in the Details list, add or modify stage details, using Table 9 on page 28 
as a guide.

NOTE: To display more fields, click the Details menu button, choose Columns Displayed, and add 
the columns that you want to appear.

Using Repeating Stages Within a Program
In most multistage programs, each stage occurs only once, separated by a specified number of days 
between stages. In some circumstances, you may wish to have a follow-up stage repeat at a different 
frequency than a previous stage. For example, in Stage 1, you send a direct mailing with a Web site 
link to a large audience. In Stage 2, every day you monitor the Web site mentioned in the direct mail 
offer and call any customers who visit the Web site immediately. In this example, Stage 1 only occurs 
once, and Stage 2 repeats daily until the end of the campaign.

NOTE: When using a repeating stage, be sure that your segment criteria exclude customers that 
were targeted in a previous wave of the same campaign or the same stage.

To specify a repeating stage

1 Navigate to the Programs screen.

2 In the Programs list, drill down on your multistage program.

3 Click the Schedules view tab.

4 In the Schedules link bar, click Details.

5 In the Stages list, select the stage that you wish to repeat and complete the fields.

NOTE: You cannot repeat Stage 1.

Assigning Segments to a Stage
You previously defined segments with criteria in the Segment Designer. Now you can assign these 
segments to the program stage.

Table 9. Fields in the Stage Detail Form

Field Comment

Objective Type the program�s objectives.

Stage Code The default is the record identifier for the stage. Change the identifier for 
the stage source code if desired, but make sure the value is unique.

Stage Name Name of the stage. Change the stage name from the default value to 
something more meaningful such as Stage 1: Summer Program.

Summary Type summary text that describes the stage�s implementation.
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To add segments to the program stage

1 Navigate to the Programs screen.

2 In the Programs list, drill down on a program.

3 In the Program Flow workspace, select a Campaign object.

4 In the Objects palette, click and drag the Segment object to the workspace.

5 In the Previously Used Segments dialog box, perform one of the following steps:

a To create a new segment, click Choose a New Segment and select the location of the segment 
you want to use, and then click OK.

b Select a segment from the list and click OK.

The segment object appears in the workspace.

Repeat Step 5 to add more segments to a stage.

NOTE: When you include stand-alone segments (not part of a segment tree) in a stage, the members 
of the stand-alone segments are not deduplicated against other segments, trees, or lists in the stage.

Adding a Campaign to a Stage
If you previously defined and saved campaigns with associated offers using the All Campaigns form, 
you can add them to the program.

To add predefined campaigns with associated offers

1 Navigate to the Programs screen.

2 In the Programs list, drill down on a program.

3 In the Program Flow workspace, select the Stage object.

4 In the Objects palette, select the Campaign object, and drag it from the palette to the workspace.

5 In the Pick Campaign dialog box, select the campaign, and click OK.

NOTE: If you do not see the campaign you want in the Pick Campaign dialog box, it may be 
already associated with another program. Although offers are reusable, campaigns are not. Use 
the My Campaigns or All Campaigns view to determine which program is using the campaign. 
Then, create a new campaign with a different name and the same offers.

To define a new campaign with offer from the Pick Campaign dialog box

1 Navigate to the Programs screen.

2 In the Programs list, drill down on a program.

3 In the Program Flow workspace, select the Stage object.

4 In the Objects palette, select and drag the Campaign object from the palette to the workspace.
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5 In the Pick Campaigns dialog box, click New, type a name and description for the campaign and 
click save.

6 In the Pick Campaign dialog box, select the campaign and click OK.

7 In the workspace, double-click the Campaign object to open the Campaign Offers view. 

8 To add an offer, in the Offers list, click New.

9 In the Add Offer dialog box, select an offer and then click OK.

NOTE: To gauge response to the offer, in some marketing programs, a control segment of customers 
may be targeted by a test campaign with no associated offer. For details, see �Testing Email, Fax, and 
Wireless Campaign Offers� on page 116.

Setting Up Waves for a Campaign Load
If your marketing program consists of a one-time campaign and offer, and you are confident that 
your organization can handle the volume of responses, you probably do not need to define multiple 
waves. Siebel Marketing automatically provides a 100 percent fully allocated wave (with a wave code 
of A and a lag of 0) when a campaign is created.

If you are planning a multistage recurring campaign and anticipate a large distribution list of contacts 
that will receive an offer, you may want to take a measured approach to distribution and split 
fulfillment of the offer among a number of waves.

Waves, or set distribution periods, are commonly used to:

■ Test the campaign concept. An initial sampling to gauge campaign response is followed by a 
larger distribution.

■ Examine the campaign mechanics. A measured distribution of the campaign offer provides 
information to guarantee the campaign mechanism works efficiently from order entry, to 
fulfillment, to response tracking.

■ Balance the load on a fulfillment center. In this case, each wave might consist of 10-15% of 
the list to make sure existing resources can reasonably handle launching a campaign, including 
managing campaign responses.

In addition to setting up waved distribution periods, you can set a lag time for additional waves that 
reference the stage launch date, and then split the generated list by a percentage of contacts for 
each wave period. You can also split by a List Measure. The measure must be included in the list to 
be available for use in splitting the list.

You can use the List Distribution list to specify a percentage of contacts in each wave that will be 
sent to each vendor, as well as the output file layout and the method for distributing the list.

Before creating a second wave, decrease the number in the % field of the first wave, which, by 
default, is 100%. The percent number for all waves cannot exceed 100.

To set up multiple waves for a campaign load

1 Navigate to the Programs screen.
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2 In the Programs list, drill down on a program name.

3 Click the Schedule view tab.

4 In the Schedule link bar, click Details.

5 Scroll down to the Waves list and in the Waves list, create a new record.

6 Complete the necessary fields, using Table 10 as a guide and save the wave record.

Adding Imported or Internal Lists to a Campaign
Imported or internal lists of contacts may be added to the campaign. To check the status of an 
imported list, double-click the list icon in the Program Flow workspace to display the List Contacts 
and Prospects view.

To add a list to the campaign

1 Navigate to the Programs screen.

2 In the Programs list, drill down on the program name.

3 In the Program Flow workspace, select the Campaign object.

4 From the Objects palette, select the List object and drag it to the workspace.

Table 10. Fields in the Campaign Waves Form

Field Comment

% The default percentage is 100 for a single wave. If you are planning multiple 
waves, first reduce the percentage number in the first wave and type the 
percentage of contacts that will be included in the second wave. The total percent 
for all waves cannot exceed 100%.

Count This field shows the corresponding number of contacts to be included in the wave. 
The number in this field is automatically calculated when you save the record.

Description Describe the characteristics of the wave.

Lag (Days) The default is 0. Type the number of days the wave is delayed after loading a 
campaign. The maximum lag for all the waves cannot be greater than number of 
days between the start date and end date of the campaign.

The wave is launched when the server processes the Launch Campaign request. 

This server process can be automatic, using a scheduled program launch or can 
be manually started using the right-click menu in the Program Flow workspace.

Wave Code Type a wave code, up to 10 characters. You cannot save the record without a wave 
code. The wave code appears as part of the source code for the campaign member 
if you set up the source code format to include it. The wave code for the default 
wave is A.
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5 In the Pick Campaign List dialog box, select an imported or internal list, and click OK.

The List object appears in the workspace, linked to the stage and referencing the campaign.

NOTE: To view and edit list details, double-click the List object in the workspace.

Adding a Segment Tree to a Stage
You can use one segment tree in each stage of your program. 

To associate a segment tree to a stage

1 Navigate to the Programs screen.

2 In the Programs list, drill down on the program name.

3 If you are not in the Design view > Program Flow link, click the Design view tab, and then click 
Program Flow.

4 In the Program Flow workspace, select the stage where you want to add the segment tree.

5 Drag the Segment Tree icon on to the workspace.

6 In the Pick Segment Tree dialog box, click Choose a new Segment Tree.

7 In the second Pick Segment Tree dialog box, from the folders, select the Segment Tree.

8 In the Pick Segment Tree dialog boxes, click Save and then OK to save the tree in the program 
flow.

Allocating Segment Tree Cells for a Stage
After you associate campaigns and a segment tree to a stage of the program, you must allocate each 
segment tree cell to the campaigns. If you include stand-alone segments in the stage that are not 
part of the segment tree, the members of the segment will not be deduplicated against members of 
the tree or against other stand-alone segments. Only segment tree cells are deduplicated against 
other cells.

To allocate segment tree cells for a stage

1 Navigate to the Programs screen.

2 In the Programs list, drill down on the program name.

3 If you are not in the Design view > Program Flow link, click the Design view tab, and then click 
Program Flow.

4 In the Program Flow workspace, select the segment tree that you want to allocate, and click 
Allocate Segment Tree.
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5 In the allocation matrix, perform the following steps:

NOTE: In the segment tree structure, each cell appears with the net counts and the priority used 
for deduplication.

a If the tree does not match the latest version of the tree that is in the Segment Tree Designer, 
click Refresh Tree.

This redraws the tree structure (refreshes the stored definition of the tree in the database), 
and clears any allocations. The row across the top right displays the name and campaign code 
for each campaign.

b Select the appropriate check boxes to indicate which cells should be allocated to each campaign. 

You can allocate a single cell to more than one campaign, if desired. If you want each cell to 
receive a single campaign, be sure to check only one box per row. The total allocated count 
appears along the bottom of the matrix as you check the boxes.

6 If you want to enforce a capacity limit for each campaign load, in the Capacity Limit field for the 
column, type a value.

A value of 0 (zero) will be ignored (no limit).

7 Click Save.

CAUTION: The Design view will not automatically save your changes to the matrix.

Creating and Applying Program Templates
You can save any program you create as a reusable program template. The template retains many 
of the planning details from the program such as the program flow, related campaigns, activity plans, 
documents, and other details. After you create a program template, you can apply the template to 
new programs. You can also share the template with other employees in your organization.

Program templates also include child campaign templates for each of the campaigns in the design. 
For more information about campaign templates, see �Creating and Applying Campaign Templates� on 
page 97.

To save a program as a program template

1 Navigate to the Programs screen.

2 In the Programs list, drill down on the program that you want to use as a template.

3 In the Program form, click the menu button and select Save As Template. 

This menu option is active only if your administrator has given you permission to use this action 
(using the Marketing access groups).

4 In the Save As Template dialog box, type a name, and click OK.

5 To make changes to the new template, navigate to the Marketing Templates screen > Program 
Templates view.

6 Query for the template you created in Step 4 on page 33.
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7 In the template list or form, make the necessary changes.

To apply a program template to a program

1 Navigate to the Programs screen.

2 In the Programs list, create a new program or drill down on the program name to which you want 
to apply the template.

3 In the Program form, click the menu button and choose Apply Template.

4 In the Apply Template dialog box, select the template you want to apply and click OK.

5 When asked if you want to continue, click OK.

The Message dialog box, appears, confirming that the template was applied.

NOTE: You cannot apply a program template if your program already has stages in the program 
flow. If your program has existing stages, delete all the stages from the program flow before 
applying the template.

6 In the Message dialog box, click OK.

Executing Programs
You can manually execute a program from the Program Flow link in the Design view by using the 
right-click menu to load and then launch a campaign. Alternatively, you can automatically execute a 
program by scheduling a stage in the calendar. In the Schedule view, you use the calendar link to 
automatically invoke the workflow process and execute the server tasks.
Siebel Marketing User Guide Version 7.734 ■



4 Marketing Segments and 
Segment Trees
You can use Siebel Marketing to develop target segments for marketing campaigns. From the 
segmentation home pages, you can perform the following tasks:

■ Create a segment. A segment defines a target set of customers or prospects. In most cases, 
the members of a segment change over time because the criteria are reevaluated against the 
most current data in your database.

■ Create a segment tree. A segment tree allows you to select one or more segments and split 
the segment members into smaller groups (or target cells).

■ View marketing jobs and cache entries. A Manage Marketing Jobs link on the segmentation 
home pages allows users to see their own jobs and cache entries. The administrator can see job 
and cache entries for all users. For more information about managing marketing jobs, see Siebel 
Marketing Installation and Administration Guide.

This chapter contains the following topics:

■ About Segment Designer on page 35

■ About Segment Tree Designer on page 43

■ Creating and Editing Segment Trees on page 44

About Segment Designer
The Segment Designer allows you to determine how many prospects or customers qualify for a series 
of criteria. Each Segment is created by adding a sequence of successive criteria blocks to refine the 
segment membership. With each additional criteria block that you add, the membership can either 
increase or decrease depending on whether the criteria excluded or added members. You can create 
a new segment, you can click the new icon or open a saved segment, modify it, and save it with a 
new name.

Each segment is based on a target level that indicates the type of customer you plan to count and 
target for your campaigns. For example, target levels may include companies, individuals, or 
households.

For each target level there are a set of relevant subject areas that contain the information about that 
target level. These subject areas organize available facts and attributes into common topics such as 
Orders, Products Owned, Service History, or Campaign History.

Many of the features in the Segment Designer are self-explanatory, and definitions and how-to 
information appear on each screen. When more information is available than will fit on the screen, 
a Help link or small help icon appears near the upper right corner. Click the button to see more 
detailed information.

This section contains the following topics:

■ Frequently Used Terms for Marketing Segmentation on page 36
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■ Creating Segments in Segment Designer on page 38

■ Adding Criteria Blocks to Segments on page 39

■ Saving Result Sets for Marketing Segments on page 42

■ Segment Advanced Options on page 43

Frequently Used Terms for Marketing Segmentation
Table 11 defines frequently used segment and segment tree terms.

Table 11. Frequently Used Terms for Marketing Segmentation

Term Description

Criteria Block Building block of a segment. With each additional criteria block that you 
add, the membership can either increase or decrease. 

Cumulative Count A type of count computed by the Segment Designer. The cumulative 
count represents the total number of segment members that qualify for 
the indicated criteria block as well as all the criteria blocks above it. As 
you add an additional criteria block at the bottom of the stack, the 
cumulative count will either increase or decrease depending on whether 
you add, keep, or exclude segment members from the previous result.

Deduplication Calculation that removes overlapping members of a segment tree 
branch. Overlapping members are members of one branch that also 
qualify for any higher priority branch.

Eligible Audience A set of criteria that constrain all the members of a segment tree. The 
eligible audience appears in the top section of the segment tree. The 
Eligible Audience criteria are defined by selecting a segment with the 
criteria and then adding the segment to the Eligible Audience section of 
the Segment Tree. For example, you might have an eligible audience 
which excludes inactive customers or only selects customers in your 
geographic region.

Global Audience A default eligible audience set by an administrator to apply to all 
segments and segment trees.

Gross Count In a segment, gross count represents the total number of members that 
qualify for a specific criteria block, independent of any other criteria 
block in the segment design. This value tells you how many segment 
members would be selected if the specific criteria block was the only 
criterion in your segment. 

In a segment tree, the gross count represents the total number of 
members that qualify for a tree branch, taking into account the full set 
of criteria in the parent branches.
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Groups A group is a combined set of criteria blocks that you want to evaluate 
together. A group behaves like a set of parentheses, so that the 
qualifying members for the group are determined before adding or 
removing the group members from the cumulative segment 
membership.

List format Allows you to define the layout of files that you can export for a variety 
of purposes such as importing targeted customers into a campaign, 
building a customer email list, or generating a list for execution by a 
third-party vendor.

Nested Segment A segment that is embedded within another segment definition. When a 
nested segment is used, its corresponding counts will apply all the 
criteria for the nested segment and then add, keep, or exclude the 
qualifying customers to the cumulative count for the main segment.

Net Count A type of count computed by the Segment Tree Designer. The net count 
represents the number of members that qualify for a target cell in the 
segment tree. The net count displays how many members qualify based 
on the splitting and sampling criteria. Net count displays the members 
after deduplication.

Not Included Count A type of count computed by the Segment Tree Designer. The Not 
Included Count represents the number of members that were removed 
from a tree branch because they also qualified for any higher priority 
cell. 

Priority Each target cell has an assigned priority number, which is used to apply 
deduplication when some members qualify for more than one target cell. 
Priority must be an integer value of 1 or higher and no two cells can 
share the same priority. The smallest value in the tree (usually 1) is the 
top priority.

Saved Result Set A fixed set of segment members that are recorded at a particular point 
in time. They are saved in the database so that they can be reused in 
the future without reevaluating the criteria again.

Segment A target set of customers or prospects that qualify for a set of criteria. 
In most cases, the exact members of a segment will change over time 
because the criteria are reevaluated against the most current data in 
your database. However, using saved result sets, you can also save a 
segment as a static set of customers that were recorded at a particular 
point in time.

Segment Tree Allows you to select one or more segments and split the segment 
members into smaller groups (or target cells). As you split a segment 
into smaller groups, the groups are displayed in a tree diagram. As in 
segments, segment trees can save a static set of customers derived 
from any target cell.

Table 11. Frequently Used Terms for Marketing Segmentation

Term Description
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Creating Segments in Segment Designer
The Segment Designer applies criteria blocks in a top-down sequence so that each criteria block that 
you add refines the segment membership of the criteria immediately above it. As you add criteria 
vertically down the screen, the Cumulative Count keeps track of how many customers have qualified 
for that criteria and all those above it. At the bottom of the view, the total count of qualifying 
segment members appears with all criteria applied.

NOTE: The Segment Designer computes two types of counts, gross count and cumulative count. For 
descriptions, see �Frequently Used Terms for Marketing Segmentation� on page 36.

For special situations where you need to create a group of criteria blocks (similar to a parentheses), 
you can drag one criteria block on top of another to create a group. This method will allow you to 
apply a combined set of criteria as a single constraint on the main segment membership.

The Segment Designer also allows you to include a reference to another existing segment (referred 
to as a nested segment) within the segment you are building.

Splitting and Sampling The action you take to break a segment or segment tree branch into 
smaller groups. 

Subject Area A set of facts and dimensions that are organized by a common topic, 
such as Orders, Products Owned, Service History, or Campaign History. 
Within each subject area you can choose any fact or dimensional 
attribute to create a criteria for your segment.

Target Cells An end point branch of a segment tree, meaning that the branch does 
not have any child branches. Target Cells are the only branches that can 
be associated with a marketing campaign. Target Cells have an assigned 
priority number and you can use deduplication to deduplicate members 
that qualify for more than one target cell.

Target Level Indicates what type of customer will be counted in the segment 
membership and included in associated campaigns. For example, target 
levels may include target levels, companies, individuals, or households. 
The gross and cumulative counts for a segment are counted based at the 
selected target level. In most situations, target levels will represent 
some type of customer, such as an individual or company. However, 
target levels can also be created by your administrator to allow you to 
create more advanced segment definitions. For example, advanced 
target levels can include Assets or Products that a customer owns.

Web Catalog The Siebel Analytics Web Catalog stores content created with the 
Segment Designer, Segment Tree Designer, and List Format designer. 
Content can be organized into folders that are either shared or private. 
Types of content that can be stored in the Web Catalog include 
segments, segment trees, list formats, as well as reports, filters, and 
dashboards created with Siebel Answers.

Table 11. Frequently Used Terms for Marketing Segmentation

Term Description
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After you create a segment, you can save it in one of the folders in the Web Catalog.

If you want to create a new nested segment based on a different target level, you can click the Select 
Another Target Level button. This action allows you to save the current segment, build a nested 
segment, and then return to the main segment when you are finished.

NOTE: The subject areas that you see are dependent on the security settings specified for you by 
your site's Administrator.

About Using the Marketing Segment Panel to Add Criteria to Segments
Use the segment selection pane to add criteria blocks when creating new or changing existing 
segments. To create a new segment, you can click the new icon or open a saved segment, modify it, 
and save it with a new name. Using either method, you select the subject area and field that you 
want to use for a segment criteria. The panel displays all the subject areas that are relevant for the 
target level for your segment.

You can also add a nested segment to your segment by selecting a folder displayed in the bottom of 
panel and clicking the segment name.

Adding Criteria Blocks to Segments
Each criteria block denotes a set of criteria that are evaluated together. This means that any segment 
member that qualifies for the criteria block must meet all the criteria displayed within the block.

For example, if a segment has the following criteria block:

Product purchased is a blue hat.

And,

Purchase date is December 31, 2003.

This segment finds all customers who purchased a blue hat on December 31, 2003. Because the 
criteria are in the same block, the criteria are applied to the lowest level dimension related to the 
criteria, which, in this case, is Purchases (record-level evaluation).

If your segment places criteria into separate criteria blocks, each criteria block finds segment 
members that satisfy each criteria block. After segment members have been identified, the segment 
designer determines how many segment members qualified for both criteria blocks.

NOTE: If your administrator sets up a dashboard to allow you to see the actual contacts that qualify, 
you can click the final segment count (at the bottom of the screen) and the dashboard appears.

For example, you might have a segment with the two criteria blocks shown in the following list:

 

Start With Criteria block 1: Product purchased is a blue hat.

Keep Criteria block 2: Purchase date is December 31, 2003.
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In this example, the relationship between the criteria are evaluated at the customer level, rather 
than the purchase level (record level). This segment would find all customers who purchased a blue 
hat at any time and customers who purchased any product on December 31, 2003. For example, the 
segment includes customers who purchased a blue hat in February and purchased a black coat on 
December 31, 2003.

To select a field to add as a criteria block

1 Click a subject area near the top of the selection pane and then expand the subfolders to see the 
available facts and dimensions.

2 Click the fact or dimension you want to use.

3 In the Create/Edit Filter dialog box, add the filter criteria.

For details, see the topic about using column filters in Siebel Analytics User Guide.

4 Click OK.

To set properties for a criteria block

1 In a criteria block, click Properties.

2 In the Properties dialog box, make changes to any of the following options:

■ In the Label field, type a custom caption for your criteria.

■ Cache the block for future update counts requests. 

Select this option if you want to temporarily cache the results for that criteria block. This 
option allows you to save time refreshing counts while designing a segment. When a block is 
cached, updating counts refreshes the cache when the cache is expired or does not exist. By 
default, the segment designer will not cache any blocks unless you explicitly check this box.

3 Click OK.

To add filters to a criteria block

1 In a criteria block, click the filter button.

2 In the Create/Edit Filter dialog box, add the filter criteria.

For details, see the topic about using column filters in Siebel Analytics User Guide.

3 When you are finished adding filters for the criteria block, click OK.

To add a filter using an aggregate field

1 Create a new criteria block or click the filter button on an existing block.

2 Select the aggregate field such as Order Revenue from the selection pane.

3 If you want to group by another field, in the Create/Edit filter dialog box, click Add Aggregate By.
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4 While the Add Aggregate By dialog box is open, in the selection pane, click the field you want to 
group by.

To embed a nested segment in your segment design

1 Click the My Segments or Shared Segments folder at the bottom of the selection pane.

2 Click the segment you want to add as a nested segment.

To save a new segment

1 Click the save icon in the upper right corner of the screen.

2 Select the folder location where you want to save the segment.

3 Type a segment name and click OK.

To save changes to a segment

1 Click the save icon in the upper right corner of the screen.

2 Click OK.

3 In the Save dialog box, click Yes to confirm that you want to replace the previous version.

To view the cumulative counts within a criteria block

1 Click the filter button on the criteria block.

2 In the Edit Criteria Block dialog box, click Get Counts.

3 The cumulative counts for each criterion in the criteria block appears.

NOTE: The starting count for the selected block is based on the cumulative count for the criteria 
block above your selected block.

4 When you are finished viewing the counts, click Back to Editing.

5 Click OK.

To update counts in a segment

1 In the upper right of the Edit Segment tab, click Update Counts.

2 In the Update Counts dialog box, select a refresh option.

3 If you are using the Cache option, you can also select Refresh Cache.

Selecting Refresh Cache guarantees that you query against the most current data.

4 Click OK.
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Saving Result Sets for Marketing Segments
A Saved Result Set is a fixed set of segment members that are recorded at a particular point in time. 
They are saved in the database so that they can be reused in the future without evaluating the 
criteria again.

Saved Result Sets can be useful in the following situations:

■ When you want to freeze the members of a segment at a specific point in time, so that the 
membership does not change.

■ When you have a very complex segment and you want to store the members of a recently 
counted segment to save query time.

■ When you want to save a branch of a segment tree as a separate segment.

To save a result set for a Marketing segment

1 In the Segment Designer, open the segment.

2 Go to the Saved Result Sets view.

3 Click the Save Result Set button.

4 In the Please save your current segment dialog box, verify segment name and location.

5 Click OK to submit the job.

6 To cancel the job, click the Cancel/Exit links. 

After the request is complete, the newly created saved result set appears.

To use a segment saved result set as a nested segment

1 In the Segment Designer, open the segment.

2 Find the saved segment in the Segment Folders in the selection pane.

3 Click the segment name to add it to the segment design.

4 Click the properties button on the nested segment block.

5 Select Use Saved Result Set.

6 In the Saved Result Sets dialog box, select one of the following:

■ Always use most recent Saved Result Set

■ Choose a specific result set from the list.

7 Click OK twice to save your changes.

To set a segment to always use a Saved Result Set

1 In the Segment Designer, open the segment.
Siebel Marketing User Guide Version 7.742 ■



Marketing Segments and Segment Trees ■  About Segment Tree Designer
2 Click the Advanced Options tab.

3 Select the following check box:

Always use most recent saved result set

NOTE: When you use this segment, the most recent result set determines the segment 
membership.

4 Click OK.

Segment Advanced Options
The Advanced Options page for a segment provides the following options:

■ Purge List Cache (button). Submits a job to purge all cache entries associated with pulling a 
list requalified by this segment. You would click this button prior to generating a list to make sure 
that the list contains the most recent customers in the segment.

■ Cache final segment result set (check box). When generating multiple lists based on the 
same segment, you can cache the final set of customers during the first list pull so that 
subsequent list pulls can use the precreated cache to run faster.

■ Always use the most recent saved result set (check box). When you use the segment, the 
most recent result set determines the segment membership.

■ The Campaign Load File Format (field). Controls which information about the segment 
members are loaded into the campaign history in the Siebel Marketing transactional database, 
such as name, address, email address, and other fields.

When you first create a segment, the Campaign Load File Format will be set automatically based 
on the default setting for the target level. You can select a different File Format, if required. If 
you are not certain about the effect of changing the File Format, please contact your system 
administrator.

About Segment Tree Designer
Using the Segment Tree Designer, you can create a new segment tree or open a saved segment tree 
by selecting it in the selection pane, making changes, and saving the tree under the same or a new 
name. After you create a segment tree, you can save it in one of the folders in the Web Catalog in 
the selection pane. To obtain descriptions for frequently used terms, see �Frequently Used Terms for 
Marketing Segmentation� on page 36.

The Segment Tree Designer has links to additional Help information on each screen. When you need 
more information, click the Help link in the dialog box or the small help icon next to the item.
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Creating and Editing Segment Trees
The Segment Tree Designer allows you to create and edit segment trees. You can select one or more 
segments and split the members into smaller groups (or target cells). As you split a segment into 
smaller groups, the groups are displayed in a tree diagram and the resulting branch will always be 
the same size or smaller than the parent branch.

Use the Split/Sample option to split any segment or tree branch into smaller groups. You can select 
from a set of splitting and sampling methods, including Random selection, Nth selection, Ranked, 
N-tiles, and Values.

NOTE: For information about adding a filter using an aggregate field, see �Adding Criteria Blocks to 
Segments� on page 39.

Each segment tree is based on a target level, which indicates what type of customer you plan to 
count in the tree. For example, target levels can include target levels, companies, individuals, or 
households. When deduplication is enforced between target cells in the tree, the deduplication is 
applied at the target level. For example, if the target level for the tree is Companies, then 
deduplication makes sure that each company is a member of only one cell.

As you split and sample from the tree branches, some of the branches are end point branches, 
meaning that they do not have any child splits. These end points are referred to as Target Cells, 
because they are the distinct groups that will be targeted in a marketing program. Each Target Cell 
displays a priority number. The priority is used to apply deduplication between cells that may contain 
some of the same members.

The Segment Tree Designer displays several types of counts such as net counts and gross counts. 
For descriptions, see �Frequently Used Terms for Marketing Segmentation� on page 36.

All the members of the Segment Tree are constrained by the eligible audience. The eligible audience 
is a set of criteria that appear in the top section of the screen. The criteria are applied to the Eligible 
Audience by creating a segment with the criteria and then adding the segment to the Eligible 
Audience section of the Segment Tree. For example, you might have an eligible audience which 
excludes inactive customers or only selects customers in your geographic region. Optionally, your 
system administrator can also designate a Global Audience, which is a set of criteria that applies 
automatically for all segment trees and cannot be removed by other users.

After you create a segment tree, you can save it in one of the folders in the Web Catalog.

The Segment Tree Designer has links to additional Help information on each screen. When you need 
more information, click the Help link in the dialog box or the small help icon next to the item.

This section contains the following topics:

■ �Creating a Segment Tree in Segment Tree Designer� on page 45

■ �About Segment Tree Branch Properties� on page 45

■ �Splitting Segments or Branches� on page 46

■ �Constraining List Data for a Segment Tree� on page 48

■ �Adding or Removing Constraints to the Eligible Audience� on page 49
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Creating a Segment Tree in Segment Tree Designer
Use the segment tree selection pane to create a new segment tree, select the segments you want to 
sample in the tree, and select the fields you want to use for the splitting criteria. After you create a 
segment tree, you can save it in one of the folders in the Web Catalog.

When you begin editing a tree, the selection pane displays all the available segments that you can 
use in the tree. To add a segment to the segment tree, just open its folder in the selection pane and 
click the segment name.

As you add splitting and sampling criteria, the selection pane changes to display the available subject 
areas and fields for the target level on which the tree is based.

NOTE: The subject areas that you see depend on the security settings specified for you by your site's 
Administrator.

To create a new segment tree

1 In the Segment Tree Designer, select a Target Level.

2 In the selection pane, click the names of the segments you want to add.

3 If you want to save the segment tree, click the save icon in the upper right corner of the screen. 

4 Select the folder location where you want to save the segment tree.

5 Type a segment tree name.

6 Click OK. 

To add a segment to a segment tree

1 In the Segment Tree Designer, select the Edit Segment tab.

2 Click the folder in the selection pane to display all the segments.

3 Click the segment name in the selection pane.

This adds the segment to the bottom of the segment tree.

4 Click the save icon in the upper right corner of the screen.

5 Click OK.

6 Click Yes in the dialog box to confirm that you want to save over the previous version.

About Segment Tree Branch Properties
The properties dialog box for a segment tree branch provides the following options:

■ Label. Used to add a custom label for the branch.

NOTE: Custom labels cannot be entered for embedded segment nodes.

■ Include Remainder with child cells (check box). When selected, anytime you split or sample 
this branch, a remainder group is automatically added.
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■ Include overlapping members from higher priority cells. When selected, disables 
deduplication for this cell.

■ Cache this block for future Update Counts. Select this option for the following reasons:

■ When selected, this option temporarily caches the members who qualified for that branch, 
allowing you to save time refreshing counts while designing a segment tree.

■ When a split-by-value node is marked for caching and constrains a secondary list attribute, 
this attribute is also cached.

■ The segment tree designer caches all tree nodes by default.

■ Anticipated response rate for statistical significance test. Use this to add the assumed 
response rate for that cell.

■ Save Result Set (button). Saves the list of members that qualify for the branch based on the 
most recent updated counts. When you click this button, you are prompted for a new segment 
name. The customers in the target cell are extracted and saved to the new segment.

NOTE: The saved segment will not include any of the original criteria, it will include only the 
stored list of members.

■ Path. This displays the Web catalog path of the segment to which an embedded segment node 
refers.

■ Use Saved Result Set. When selected for an embedded segment node, you can select the 
following options:

■ Always use most recent Saved Result Set.

■ Choose a specific result set from the list.

Splitting Segments or Branches
Use the Split/Sample option to split any segment or tree branch into smaller groups. As you split or 
sample, the resulting branch will always be the same size or smaller than the parent branch.

You can select from the following sampling methods:

■ Random selection. The Random method selects a purely random subset of members based on 
the percentage or count you add for this method. For random selection, you are not required to 
select a field.

■ Nth selection. The Nth method will split the branch into N number of equally sized groups. The 
selection is based on the sequence with which the records are returned from the database. For 
example, if you select N = 4, the branch would be split into 4 equally sized groups representing 
25% of the original group. For this method, you are not required to select a field.

■ Ranked. The Ranked method will sort the members of the branch by a field you select and let 
you choose the top or bottom portion of the ranked list. For example, if you Rank by Total 
Customer Revenue, you can select the top 10% of the customers with the highest revenue.

■ N-tiles. The N-tile method will sort the members by a field you select and then split the list into 
equal sized groups. For example, you might create quartets or deciles based on Total Customer 
Revenue.
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■ Values. Similar to instructions for creating filters in segment criteria blocks. For information 
about adding a filter using an aggregate field, see �Adding Criteria Blocks to Segments� on 
page 39.

To select a field for splitting or sampling criteria

1 Click the action button for the tree branch that you want to split or sample.

2 In the menu, choose Split/Sample.

3 In the Apply Split/Sample dialog box, select the sampling method you want to use.

NOTE: The contents of the dialog box changes when you select different sampling methods.

The available subject areas and fields appear in the selection pane. The list of subject areas is 
based on the target level for the segment tree.

4 In the revised Apply Split/Sample dialog box, complete the fields.

5 Click the subject area that contains the field you want.

6 Click the folders to expand the subject area.

7 Click the field name.

To create random samples

1 Type the number of groups you want to create (1 to N).

2 Select whether you will define the group sizes by Percentage or Count.

3 Type your percent or count for each group. 

The sum of the percentages cannot exceed 100%.

4 Click OK.

To create Nth samples

1 Type the number of groups you want to create (N).

2 Click OK.

To create ranked samples

1 Select the field to rank by from a subject area in the selection pane.

2 Type the number of groups you want to create (1 to N).

3 Select whether you will define the group sizes by Percentage or Count.

4 Type your percent or count for each group. Note that the sum of the percentages cannot exceed 
100%.

5 Click OK.
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To create N-tile samples

1 Select the field to use for the N-tile from a subject area in the selection pane.

2 Type the number of groups you want to create (1 to N).

3 Select whether the top group has the lowest or highest values for the selected field. 

4 Click OK.

Using the Values Sampling Method
Instructions for creating Values samples uses instructions that are similar to creating filters in 
segment criteria block. For information about adding a filter using an aggregate field, see �Adding 
Criteria Blocks to Segments� on page 39.

Constraining List Data for a Segment Tree
This option allows you to limit the information in list files to members of the branch. For example, if 
you have a segment tree based on accounts, you might qualify specific contacts for the accounts 
based on criteria for that branch. 

Additionally, this option allows you to limit the information in list files to any additional items that 
you constrained on the segment tree branch. The following are scenarios for other types of 
constraints:

■ Nested Segment Node. You might have a business-to-business company targeting business 
accounts. You split by predefined contact segments containing the decision-making contact at 
each account. You can make sure that you select the correct contact for each account by 
constraining the contact attribute for the nested segment node.

■ Split-by-Value Node. You might have a banking company targeting customers split by checking 
and savings account types. You can make sure that you select the correct account type for each 
customer by constraining the bank account attribute for the split-by-value node.

You can constrain list data for a tree branch only when the following criteria are met:

■ The branch is an embedded segment node in which the target level is different from the target 
level of the segment tree.

■ The branch is a split node created using the values sampling method and the split-by field is not 
an aggregated measure.

To constrain list data for a segment tree

1 In the Segment Tree Designer, locate the branch for which you want to constrain data. 

You can only constrain list data on nested segment tree nodes and split by value nodes.

2 Click the actions button.
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3 In the list of qualified items, select the type of constraint.

The list of attributes that appears depends on the qualified list items setup for that branch or 
node.

4 In the Constrain List Data dialog box, click OK.

Adding or Removing Constraints to the Eligible Audience
All the members of the Segment Tree are constrained by the Eligible Audience. The eligible audience 
is a set of criteria that appear in the top section of the screen. The criteria are applied to the Eligible 
Audience by creating a segment with the constraining criteria and then adding the segment to the 
Eligible Audience section of the Segment Tree. For example, you might have an eligible audience that 
excludes inactive customers or only selects customers in your geographic region. 

Optionally, your system administrator can also designate a Global Audience, which is a set of criteria 
that applies automatically for all segment trees and cannot be removed by other users. The Global 
Audience appears as a block that is more lightly shaded than the rest of the tree. For instructions 
about setting the Global Audience, see Siebel Marketing Installation and Administration Guide.

To add or remove constraints to the Eligible Audience

1 Click the actions button on the existing eligible audience block.

2 To add constraints, choose Add Constraint and perform the following steps:

a In the Add additional constraints to the Eligible Audience dialog box, click Browse.

b Select the segment that has the criteria you want to use to constrain the audience.

3 To remove constraints from the eligible audience, click the delete button on the constraint you 
want to remove.

NOTE: If the constraint is the Global Audience, you cannot remove it.

4 Click OK.

Segment Tree Advanced Options
The Advanced Options page for a segment tree provides the following options:

■ Automatically create remainder cells. If you do not want the tree designer to automatically 
create remainders whenever you split a branch, clear this option.

■ Default to include overlapping members from higher priority cells in lower priority 
cells. The standard behavior for new trees will always enforce deduplication between target 
cells. When this option is checked, deduplication will not be enforced for the segment tree. 
However, you can enable deduplication for specific branches using the branch properties.
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■ Campaign Load File format. The campaign load file format that you want to use to load the 
members of the segment tree into each campaign. 

The campaign load file format controls what information about the segment tree members is 
loaded into the campaign history in the Siebel Marketing transactional database. This information 
might include name, address, and email address.

When you first create a segment, the Campaign Load file format will be set automatically based 
on the default setting for the target level. You can select a different file format, if required. If 
you are not certain about the effect of changing the file format, contact your system 
administrator.

■ Purge List Cache (button). Clicking this button submits a job to purge all cache entries 
associated with pulling a list requalified by any of the target cells in this tree. You would click this 
button prior to pulling a list to make sure that the list contains the most recent customers in the 
target cell.

■ Statistical Significance Parameters. The following variables are used as inputs for the 
statistical significance calculation.

■ Confidence interval 

■ Error tolerance +/- 

■ Default Response Rate 

■ Default to cache new tree blocks for future Update Counts (check box). Controls the 
default value of the check box named Cache this block for future Update Counts (in the properties 
of a newly created tree branch).
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Offers are a way to present content on product and services to current and potential customers as 
part of a campaign. Offers are associated with a campaign, and then presented to contacts and 
prospects when the campaign is launched. Offers can be reused in many campaigns, but the 
campaign is a one-time instance of the offer presented to a customer at a certain point in time.

Offers associated with campaigns are created using the Offers screen. Typically each campaign has 
a single offer, but you can associate multiple offers with one campaign. For example, a single 
campaign might have email and Web offer treatments.

Using the Offers views, you can create, edit, and preview reusable multichannel offers, which can be 
associated with your campaigns.

In addition, you can design personalized HTML and text templates for email, wireless, and Web 
Offers. You can create emails containing conditional content that is based on contact and prospect 
attributes. Additionally, emails can contain embedded links to items such as Web offers, and Web 
surveys that allow the marketer to assess and capture campaign responses. Web Offers can contain 
embedded links to Web surveys, events and related URLs, downloads, and response forms.

This chapter contains the following topics:

■ Creating and Modifying Offers - Basic Steps on page 52

■ Creating and Editing Offer Templates on page 55

■ Working with Email Offers on page 65

■ Associating Web Offers, Web Surveys, Events, and URLs with Offers on page 72

■ Creating a Wireless Offer on page 74

■ Working with Fax Offers on page 74

■ Using Delivery Profiles for Fax Offers on page 75

■ Working with Phone Offers on page 77

■ About Direct Mail Offers on page 78

■ About Media Offers on page 79

■ Associating Literature with Offers on page 79

■ Working with Web Offers on page 80
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Creating and Modifying Offers - Basic 
Steps
You can create reusable offers in the Offers screen, adding details such as the channel you want to 
use, activation and expiration dates, templates, literature, and so on. For information about using 
offer templates to create an offer, see �Creating an Offer Template and Adding it to the Template List� 
on page 56.

Use the Offers link bar to navigate directly to an offer type. The types of offers that are available to 
you depend on the features your company is licensed to use.

To create and modify offers, perform the following tasks:

■ Creating an Offer on page 52

■ Modifying an Offer on page 54

■ Applying Globalization Rules to Offers on page 54

■ Associating Products with Offers on page 55

Creating an Offer
You can use the following procedure and table to create offers. After creating an offer you can 
associate an offer template with it.

To create an offer

1 Navigate to the Offers screen.

2 In the All Offers list, create a record.

3 Complete the fields, using Table 12 as a guide.

Table 12. Selected Offer Fields

Fields Comment

Activation Date Identifies the date that the offer becomes active. You can 
associate an inactive offer with a campaign, but when you 
launch the campaign, only active offers will be executed.

Approval Status Indicates if the offer has been submitted, approved, or 
declined.

Channel Identifies the channel used to distribute the offer. 

For example, Email, Fax, or Wireless Message.
Siebel Marketing User Guide Version 7.752 ■



Creating and Using Offers ■  Creating and Modifying Offers - Basic Steps
Create Activity check box Used for email offer templates. Select this option to set 
activity logging. When the email is sent, an activity is 
created for each recipient of the email, stating that the 
email was sent. The activity record is created through the 
System Activity Object for either the Campaign Recipient 
or Campaign Position business components.

Delivery Profile Used when sending fax offers. This field is only available in 
the fax offers view, not in fax offer records in the All Offers 
view. Profiles are created using the Communications 
Administration screen�s Communications Drivers and 
Profiles view. For details, see �Creating a Delivery Profile for 
Fax Offers� on page 76.

Description Type a description of the offer.

Email Marketing Server Used for email offers only. Allows you to select the Email 
Marketing Server to use when sending an Email Offer. This 
server provides the following:

■ From and Reply-To header values.

■ Connection details for the email sending daemon.

■ SMTP envelope Sender address domain (for bounces).

■ Base URL to use in constructing Response Forms and 
Related URLs.

■ Web Server base URL (for product catalog items, Web 
offers, Web surveys, and events).

Expiration Date Use the calendar controls to select the offer�s expiration 
date.

Expired offers should not be associated with campaigns 
because they will not be sent out when the campaign is 
launched.

Language For email offers, do not change the value in this field.

Locale Used to locate the correct, language-specific Web page.

Offer Code Contains a unique system-populated code that identifies 
the offer. You can change this code, but make sure the new 
value is unique.

Table 12. Selected Offer Fields

Fields Comment
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Modifying an Offer
You can use the following procedure to modify offers. To modify an offer

1 Navigate to the Offers screen.

2 In the All Offers list, select the offer that you want to change.

3 Make the necessary changes, using guidelines in Table 12 on page 52.

Applying Globalization Rules to Offers
Each offer record contains a locale value. The locale is used to locate and display the localized landing 
page for response forms. When you create an email offer record, the locale value defaults to the 
value set in your profile. You can change the value to match your business needs. When you launch 
the campaign, the locale assigned to the email offer will be used for all recipients.

Price List Used to associate a previously defined price list with this 
offer.

A marketer can create promotional prices for specific 
products. When an offer recipient clicks a product item 
hyperlink in an email or Web offer and goes to the product 
detail Web page, the recipient sees the promotional price 
that was defined using Siebel Pricer.

The set of products associated with the selected price list 
can be different from the set of products defined in the 
offer�s product list. When a contact responds to an offer, 
clicks a product link, and goes to the product detail page, 
the contact sees the promotional price that is defined for 
that product only if that product is a part of the price list 
that was selected for this offer. Otherwise, the contact will 
see the default price for the product.

Subject Text Used for email offers. The text that you want to appear in 
the subject line of the email.

You can include merge fields in the subject line if desired. 
For example: Exciting offer for [Field: M/M] [Field: First 
Name] [Field: Last Name].

Subscription List Allows you to select a marketing list of type Subscription 
List and associate this list with this offer. The subscription 
list may already have contacts or prospects or be empty.

Type Designates the purpose of the offer. For example, Up-Sell 
or Cross-Sell.

Table 12. Selected Offer Fields

Fields Comment
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The default character set for emails is UTF-8. This is the value set in the Charset attribute for the 
email's Content-Type header. If you wish to change the Charset attribute, you need to select an Email 
Marketing Server profile with the correct Charset attribute or request a System Administrator to 
make the changes necessary to the Email Marketing Server profile that you use.

NOTE: Internally, templates are maintained using the UTF-8 character set. Therefore, the character 
set should be able to represent characters for any written language.

The character set for the template you upload should be the default character set configured for the 
operating system you are using (the current code page on Windows or UTF-8 on UNIX). On UNIX 
platforms, an environment variable (SIEBEL_FILE_ENCODING) can be assigned to a character set to 
use in place of UTF-8 when reading templates. If the original template file contains a BOM (Byte 
Order Mark), the character set of the template file will be automatically detected. This automatic 
detection is useful when the character set differs from the platform default character set.

CAUTION: Be careful when using a character set for outgoing email that differs from the platform 
default character set or UTF-8. If the Email Marketing Server character set is not compatible with the 
character set of the original template file that is read from disk), the resulting email text might be 
unreadable.

For instructions about how to assign the correct character set to an email campaign, see �Assigning 
Character Sets for the Email Marketing Server� on page 185.

Associating Products with Offers
You can associate predefined products with the offer. Ideally, you should only select a subset of 
products from the price list associated with an offer, because there is a many-to-one relationship 
between the products and the price list. The products that you associate with the offer determine 
which product catalog page links can be embedded in Email and Web offers.

To associate a product with an offer

1 Navigate to the Offers screen.

2 In the All Offers list, select the offer and click the Products select button.

3 In the Products dialog box, in the Available list, select one or more products, and then click Add 
to copy them to the Selected list.

4 Click OK.

Creating and Editing Offer Templates
Offer templates are available in Siebel Marketing, Siebel Web Marketing, and Siebel Campaigns. You 
can create a template using HTML tools or text editors such as Microsoft Front Page and Windows 
Notepad. After creating a template, you add the file to the template list and associate the template 
with an offer. After you associate a template with an offer you can edit (for example, adding 
personalization elements), verify, and preview text and HTML templates by drilling down on the 
template name hyperlink.
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Offer templates can be associated with the following offer types:

■ Fax offers. For more information on Fax offers, see �About Fax Offers� on page 74.

■ Email offers. When creating an email offer, you can use the Email Templates view tab to 
associate a template with the offer.

■ Web offers. When creating a Web Offer, you can use the Edit Web Offer view tab to associate a 
template with the offer.

You can modify template files using your preferred HTML editor or Siebel HTML Editor. When you 
upload the changed template to the server, you overwrite the original template and all the offers 
associated with that template inherit the edited template. 

Before a template has been added to (associated with) an offer, you can modify the template using 
your preferred HTML editor. After an offer template has been added to an offer, you can edit the 
template and add personalization elements in the Offers screen (Edit views).

CAUTION: You should establish a version-control policy for template changes. Any changes made 
to a template through the Edit views will appear in all of the offers that use that template. Templates 
can be found in the Marketing file system.

To create and edit offer templates, perform the following tasks:

■ Creating an Offer Template and Adding it to the Template List on page 56

■ Using Hyperlinks (HREF) in an Offer Template on page 57

■ Editing a Template That Is Not Associated with an Offer on page 58

■ Editing a Template That Is Associated with an Offer on page 59

■ About Personalization Categories on page 62

Creating an Offer Template and Adding it to the 
Template List
Offer templates are usually created with a file type of text (TXT) or HTML (HTM or HTML). You create 
the template using third-party HTML tools and text editors such as Microsoft Front Page and Windows 
Notepad. 

NOTE: You can create offer templates with other types of files such as PDF and DOC. Because you 
use offer templates primarily for email and Web offers, HTML and text files are the most common file 
types used.

After creating the template using a third-party tool, you must add the new template to the Offer 
Templates list so that you can associate it with an offer.

To create an HTML or text offer template

1 Create an HTML template, using third-party HTML or text editor of your choice.

a Using Microsoft Word, Front Page, Notepad, or another editor, create a new file.
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b For HTML templates, save the file using an HTM file extension.

CAUTION: Take care when using quotation marks in personalization elements. Some 
applications replace straight quotation marks (") with curly (also called smart) quotation 
marks (��). Curly quotation marks cause errors when used in personalization elements.

2 If it does not already exist, create a subdirectory of your HTML templates directory and call it 
Images.

In this directory, you store the graphics that will be used in the offer. Make sure that you refer 
to each image as follows, replacing image.gif with the name of the embedded image:

<IMG BORDER=0 SRC="http://<server name>/Web Marketing/images/image.gif">

NOTE: You cannot use HTML or embedded images in text email. However, some email readers 
display images that the sender attached to a text email at the end of the text email.

3 Add the template you created to the Offer Templates list using the following procedure, �To add 
a template to the Offer Templates list.�

4 Copy the images you embedded in your offer to the subdirectory you created or the image folder 
you referenced in Step 2.

To add a template to the Offer Templates list

1 Navigate to the Offers screen.

2 In the Offers link bar, click Offer Templates.

3 In the Offer Template list, create a record. 

4 Complete the fields to add the offer template to the list.

a In the Name field, type a name for the template.

b Click the File Name select button and select the template file.

Using Hyperlinks (HREF) in an Offer Template
Siebel Marketing can perform a special processing task for HTML-based emails and Web offers. A URL 
address typed directly into the body of an HTML template, such as http://www.siebel.com, is not 
recognized as a hyperlink by the HTML parser. The generic HTML syntax for a hyperlink is:

<a href="target url">highlighted text or picture</a>

The link includes both the URL and the anchor, which is the text or image that appears in the template 
and links to the URL. Thus, if you want to create a link to the URL http://www.siebel.com and display 
Siebel Web site as the text in the message, you must type the following:

<a href="http://www.siebel.com">Siebel Web Site</a>

Using this method, Web offers, response forms, and product items are replaced differently in HTML 
templates from the way they are replaced in text templates. The following list describes the default 
method for processing hyperlinks.
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■ For Web offers, Web surveys, and product links, Siebel Marketing creates the hyperlink so that 
the hyperlinked text is the Web offer name, Web survey name, or product name such as in the 
following reference:

<a href="[Web Offer: 10% discount offer]">10% discount offer</a>

For more information, see �About Personalization Categories� on page 62.

■ For Response forms, Siebel Marketing creates the hyperlink so that the hyperlinked text is the 
same as the Response form�s description in the Response Types view. The hyperlinked text for a 
response form can be modified in the Response Types view, where, for each response form, a 
description field represents the value used for highlighted text.

These default methods for processing hyperlinks in Siebel Marketing can be modified. You can put 
an asterisk (*) before the Siebel tag to tell the Siebel application that you will manually define the 
hyperlink format in the HTML body. The asterisk tells the Siebel application not to create the 
hyperlink.

For example, instead of pasting [Web Offer: Great Discount], the marketing manager can type 
the following:

<a href=�[*Web Offer: Great Discount]�>Whatever I want to highlight be it text or 
picture</a>

In this case, Siebel Marketing replaces the Web Offer with the proper URL but does not create the 
HREF syntax. You can then create a Web offer link, product item link, and response form link with 
any text or picture you desire.

NOTE: Do not use the Siebel HTML Editor when inserting an HTML tag. The editor does not allow you 
to directly alter the HTML source.

Editing a Template That Is Not Associated with an Offer
If you have not added a template to an offer, you can change it using the third-party application that 
you used to create the file, for example, Microsoft FrontPage or Notepad.

To modify and upload an offer template file

1 Make the necessary modifications to the template file saved on your local drive, using the same 
text editor used to create the file.

2 Save and close the file.

3 Navigate to the Offers screen > Offer Templates view.

4 In the Offer Template list, select the template you just changed.

5 Upload the changed template file using the following steps:

a In the File Name field, click the select button.

b In the Add Attachment dialog box, click Browse.

c Select the file and click Open.
Siebel Marketing User Guide Version 7.758 ■



Creating and Using Offers ■  Creating and Editing Offer Templates
Editing a Template That Is Associated with an Offer
After you add a template to an offer, you can edit it in the following ways: 

■ Edit a template in the Offers screen. Make basic changes to your template using Siebel HTML 
Editor or a text editor. In the Edit views of the Offers screen, you click Edit Template in the Edit 
Email, Edit Web Offer, or Edit Fax view tabs.

If you created your template as an HTML file, Siebel HTML Editor renders the HTML source (tags 
and text) and allows you to modify the rendered HTML. It does not allow you to modify the HTML 
source directly, so this is not the tool to use to add HTML tags explicitly into your template.

If you created your template as a text file, a text editor displays the offer contents for editing. 
Previewing allows you to verify the offer�s syntax, including merge fields and embeddable 
objects.

■ Modify a template using your default HTML editor. Use to export the template file, make 
changes, and import the template file back into the Siebel file system. Examples of content 
editors are Microsoft Front Page and Notepad. For more information, see �Editing a Template Using 
Your Default HTML Editor� on page 60.

To edit an offer template in the edit views of the Offers screen

1 Navigate to the Offers screen.

2 From the Offers link bar, select an email, fax, Web, or Wireless offer or in the Offers list, select 
an email, fax, Web, or wireless offer and click the appropriate templates view tab.

3 Select the template you want to change and click the appropriate edit view tab.

4 Click Edit Template to open the template for editing and start the appropriate editor. 

One of the following editors starts:

■ Text editor. You use this tool to make simple changes to the text. The text editor starts by 
default, if the selected template is a text (.txt) file.

■ Siebel HTML editor. You can use this tool to make more complex changes than you can 
make in a text editor. The Siebel HTML editor starts by default, if the selected template is an 
HTML file (HTM or HTML file extension). For more detail, see �Using the Siebel HTML Editor� 
on page 60.

5 To edit the contents of the template, click in the Template Contents workspace to display the 
editor�s toolbar.

The editor�s toolbar does not display until you click in the workspace.

6 From the Personalization Categories list, select a category type (for example, Merge Fields), and 
then copy (CTRL+C) and paste (CTRL+V) personalization elements from that category into the 
email offer template.

For details, see �About Personalization Categories� on page 62.

7 When you finish making changes, click Save Template.

8 Click Verify & Preview to preview your changes and verify that the template still performs 
correctly.
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Repeat Step 4 through Step 8 to continue editing the template.

Using the Siebel HTML Editor
You can use Siebel HTML Editor to make changes to your HTML template. To make more complex 
changes than allowed in the Siebel HTML Editor, see �Editing a Template Using Your Default HTML 
Editor� on page 60.

To make changes using the Siebel HTML Editor, you type your changes directly in the workspace. In 
addition, you can use the editing toolbar at the bottom of the Template Contents workspace for 
formatting text. Most of the buttons on the toolbar are the same buttons that appear in standard 
text editing software. For more information about the export and import buttons, see �Editing a 
Template Using Your Default HTML Editor� on page 60.

CAUTION: In the HTML editor, you must explicitly save your changes using one of the save functions 
in the application. You can click the Save Template button when it is available, or you can select Save 
Record after clicking a list or form menu button. The CTRL+S keyboard shortcut does not work in the 
HTML Editor workspace. If you want to use this keyboard shortcut, you must step off the editor into 
another field before clicking CTRL+S.

Editing a Template Using Your Default HTML Editor
If you want to make more complex changes or if you are more comfortable making changes in your 
HTML editor, you can export the template file, use your preferred (default) HTML editor, and import 
the file back into the Siebel file system. To use this method, perform the following tasks:

■ Set your default HTML editor.

■ Map the User Environment variable called TEMP to your local Temp folder.

■ Edit a template file using your default HTML editor.

To set your default HTML editor

1 Open your Web browser.

2 Set your default HTML editor in the browser�s user preferences.

For example, in Microsoft Internet Explorer, you find the HTML editor setting in the Tools 
application menu, using the following path:

Tools > Internet Options > Programs

3 Save your changes.

To map the User Environment variable to your local temporary folder

1 From the Windows task bar, choose Start > Settings > Control Panel.

2 Double-click System and perform Step 3 for Windows NT or Step 4 for Windows 2000. 

3 If you use Windows NT, perform the following steps.

a Click Environment.
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b Select the User Variables window.

c In the User variables for [username] workspace, in the Variables column, select TEMP.

d Click Set.

4 If you use Windows 2000, perform the following steps.

a Click the Advanced tab and click Environment Variables.

b In the User variables for [username] workspace, in the Variables column, select TEMP and click 
Edit.

c In the Edit Variables dialog box, in the Variables Value field, type c:\temp.

d Click OK in each dialog box until you return to your desktop.

To edit a template file using your default HTML editor

1 Navigate to the Offers screen.

2 From the Offers link bar, select the type of offer.

3 In the selected offers list, select an offer, and click the appropriate templates view tab.

4 Select the template you want to change, and click the appropriate edit view tab.

5 Click Edit Template to open the template for editing, and start the appropriate editor.

a To display the editor�s toolbar, click in the Template Contents workspace.

The editor�s toolbar does not display until you click in the workspace.

b Edit the contents of the template.

6 In the HTML Editor toolbar, click the export button.

The default editor starts and the template file opens for editing.

7 In the Editor menu, choose save to save the template file on your local machine.

This saves the template file in your desktop/temp directory with the file name of template.htm.

8 Make changes to the template and save the file.

CAUTION: Do not change the file name. If you change the file name, the application will not be 
able to automatically locate the file and you will have to manually locate the file and location 
while importing. 

9 In the HTML Editor toolbar, click the import button.

10 In the Import dialog box, select the template you want to import, and click Open.

By default, template.htm is automatically selected. If you need to import a different file, locate 
and select the appropriate file.

11 In the Edit Email list, click Save Template.
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About Personalization Categories
Personalization categories are categories of supported embeddable object types. Depending on 
which category type you select, the Personalization Elements list contains the available elements for 
that category.

The available personalization categories are:

■ Events

■ Merge Fields

■ Product Catalog Items

■ Related URLs

■ Response Forms

■ Web Offers

■ Web Surveys

About the Merge Fields Personalization Category
Merge fields allow you to customize offers by contact or prospect. All contacts or prospects can have 
multiple fields associated with them, each field defining some attribute of a contact or prospect (for 
example, the person's last name, their first name, or their account number). For each unique contact 
or prospect, the value of these fields may differ. You insert the merge field personalization element 
in the text and then the value of the Contact or Prospect field is populated into the text where you 
inserted the merge field personalization element.

For example, you might have two prospects with the first names of Sally and Fred. The following 
simple example shows how the personalization element appears in the offer before and then after 
the contact or prospect field is populated:

Before population in the Offer Text
Hello [Field: First Name]!

After Values are Populated in the Offer
When Sally receives the offer, she sees the following:

Hello Sally!

When Fred receives the offer, he sees the following:

Hello Fred!

In some contact or prospect records, a value might not exist for a non-numeric merge field. For 
example, the database record from which the value comes is a NULL entry. When the contact or 
prospect field is populated, the merge field might default to one of the following values:

■ Empty string. The value is an empty string (a string containing no characters.

■ Unspecified. The value is the word Unspecified.
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For Web offers, surveys, events, and URLs to be available as personalization elements Web Offers, 
Web Surveys, Events, and Related URLs categories, you must add the records to the Web Offers, 
Web Surveys Related Events, or Related URLs lists. For details, see �Associating Web Offers, Web 
Surveys, Events, and URLs with Offers� on page 72.

You can copy any field from the Personalization Elements list and paste it into the body of the email 
message. For related information, see �Using Hyperlinks (HREF) in an Offer Template� on page 57.

For example you might want to personalize the offer with the contact�s name. For example, Exciting 
Offer for [Field: First Name] [Field: Last Name].

Using the Merge Fields category, you would select the personalization element [Field: First Name] 
and press CTRL+C to copy it. Then, you would paste (CTRL+V) the field or fields into the offer 
template text, or the subject line of the email. You would repeat this procedure to add a last name.

Typically, the tags for personalization elements are enclosed in brackets ([ and ]).

During run time, the target values are substituted for these personalization elements. The response 
forms, product links, Web offer links, and Web survey links are encoded so that they become URL 
links containing the destination address, with campaign, offer, and recipient codes included. Thus, 
the URL in any text-based email can become long. The following list contains guidelines for setting 
up personalization elements:

■ The Merge Fields list is driven by your system configuration. If you are using the advanced 
approach, merge fields can be extended using fields from the segmentation module. For more 
information, see �Using Merge Fields in an Email Offer� on page 63.

■ The list of Merge Fields includes a calculated field called Current Date. This merge field is 
replaced by the Campaign Send Date when the campaign is launched.

■ The Product Catalog Items are limited to those defined for the Product catalog page for the 
products associated with the offer.

■ The list of Web offers is limited to those defined for this offer in the Related Web Offers list (view 
tab).

■ The list of Web surveys is limited to those defined for this offer in the Related Web Surveys view 
tab.

■ The list of related events is limited to those events defined for this offer in the Related Events 
link bar. When you add a related event, you will only see events with active dates and that have 
a status code of Executing or In Progress.

■ Related URLs allow you to embed hyperlinks to offer and generic Internet Web pages in an offer. 
When this hyperlink is clicked on by a Contact or Prospect a Campaign Response is recorded.

■ Typically, response forms are Web forms that a contact or prospect can use to respond to an offer 
through the Web. The response forms for an email offer are Unsubscribe from List, Subscribe to 
List, Read Receipt, One Click Unsub, Forward to Friend, Request Unsubscribe, Request More Info, 
and Request Call Back.

Using Merge Fields in an Email Offer
Your application can be configured to use email merge fields in the following ways:
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■ Basic. Provides a static set of merge fields based on the campaign recipient business component. 
These merge fields are available when your organization has not licensed or deployed the 
marketing segmentation module.

■ Advanced. Provides a flexible set of merge fields based on data from any data source or table 
within the Siebel application. The merge fields in this case are controlled by the Personalization 
Format (Email Server list format) that you select for the email offer.

In the Basic configuration, each category has a number of personalization elements. For example, 
the Merge Fields category has the following personalization elements (depending on the 
personalization format used):

■ [Field: M/M]

■ [Field: First Name]

■ [Field: Middle Name]

■ [Field: Last Name]

■ [Field: Account]

■ [Field: Account Location]

■ [Field: Job Title]

■ [Field: Work Phone #]

■ [Field: Home Phone #]

■ [Field: Cellular Phone #]

■ [Field: Fax Phone #]

■ [Field: Email Address]

■ [Field: Current Date]

■ [Field: Source Code]

In the Offers screen, in the Advanced view tab, you need to select the appropriate personalization 
format for the email offer in the email offer form. When you create an email offer, the values for the 
Email Marketing Server and Personalization Format automatically are set based on settings 
established by your administrator.

If CHANGEME is the value in the Personalization Format field, then you have not selected a set of 
merge fields. If a path name appears in the Personalization Format field, you should see merge fields 
in the Edit Email view tab, after selecting Merge Fields in the Personalization Categories field.

To select a Personalization Format (merge fields) for an email offer

1 Navigate to the Offers screen.

2 In the Offers list, drill down on the name of the email offer.

3 Click the Edit Email view tab.

4 Click the Personalization Format select button.
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5 In the dialog box, select the appropriate format from the folders that appear. 

For more information about creating Email Server formats, see Siebel Marketing Installation and 
Administration Guide.

6 In the Edit Email form, from the Personalization Categories drop-down list, choose Merge Fields.

The merge fields should appear in the Personalization Elements list.

Working with Email Offers
Email offers are available in Siebel Marketing. For instructions about how to create an email offer, 
see �Creating an Offer� on page 52. For instructions about how to modify an email offer, see �Modifying 
an Offer� on page 54.

For information about working with email offers, see the following topics:

■ About Email Offers on page 65

■ Associating a Template with an Email Offer on page 66

■ Adding Attachments to Email Offers on page 67

■ About Merge Fields in Email Offers on page 67

■ About Email Offer Response Forms on page 67

■ About Creating Conditional Content on page 69

■ If-Then-Else Personalization Element on page 70

■ Named Blocks Personalization Element on page 71

About Email Offers
Using the Email Offers view, a marketer can design and distribute a personalized email offer to target 
recipients of a campaign. An email offer can be associated with a price list for various products. If 
the recipient clicks on a product link in an email offer, the product detail page will show the 
promotional price for that product rather than the list price.

The Email Offers view includes the Offer Details, Email Templates, Edit Email, Delivery Profile, 
Attachments and Advanced tabs. 

■ Offer Details. This form contains additional fields that you can use if the email offer requires 
approvals from your company�s marketing and legal departments. It also provides a unique 
identifier for the offer in the Offer Code field and allows you to specify the email offer�s Subject 
Text, the Email Marketing Server (Reply-To and From headers, Email Marketing Daemon 
configurations, and Web Server URLs) that will be used to distribute the offer, and Personalization 
Format to use with this offer.

■ Email Templates. This form allows you to attach templates containing the content of your email 
offer. To be selected in this view, templates must first be added to the Offer Templates list. For 
details, see �Creating and Editing Offer Templates� on page 55. 
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■ Edit Email. This form allows you to edit the template content as well as select Personalization 
Categories such as Product Catalog Item. Category elements can be copied and pasted into the 
template.

■ Delivery Profile. This read-only list provides a list of the Email Marketing Server parameters for 
the Email Marketing Server that is associated with the offer. 

■ Attachments. This list allows you to include literature items with your email offer. These items 
are delivered as attachments to the email when the campaign is launched.

■ Advanced. Contains the Related Web Offers, Related Web Surveys, Related Events, and Related 
URLs lists. These lists allow you to specify the Web offers, Web surveys, events, and URLs that 
you plan to include as hyperlinks in the email offer. Adding these elements allows you to embed 
them as a Personalization Element. Web Surveys are created using Siebel SmartScript. For more 
information, see Siebel SmartScript Administration Guide.

Whenever an offer recipient clicks a Web offer, Product Catalog Item, or Related URL link in an 
email offer, the click is captured as a response. The available response types are Clicked On Web 
Offer, Clicked On Web Survey, Clicked On Product URL, and Clicked on URL.

NOTE: Siebel Events views are not currently included in the Siebel Web Marketing application. 
Therefore, if you embed a related event in an email offer, related events must be directed to the 
Web Server on which Siebel Events is installed. To accomplish this, the Web Server field must 
contain the location of the Web Marketing Web Server and the location of the Events server. For 
more information see the Web Server field in Table 12 on page 52.

Associating a Template with an Email Offer
This section describes how to associate a template with an email offer. To edit the offer template, 
see �Creating and Editing Offer Templates� on page 55.

To associate an offer template with an email offer 

1 Navigate to the Offers screen > Email Offers view.

2 In the Email Offers list, select the offer and click the Email Templates view tab.

3 In the Email Templates list, create a new record.

4 In the Email Templates form, complete the necessary fields.

a The sequence field is automatically populated. Change the sequence if you are adding multiple 
templates with rich and plain format. The sequence field includes email attachments. Therefore, 
when you add your first template, you might see a sequence number other than 1.

For example, if you have two templates (one HTML and one text) associated with the email 
offer, adjust the sequence so that you associate the plain format (text) first and the rich 
format (HTML) last. This change satisfies the MIME Alternate standard. The MIME Alternate 
standard defines a way to send both the text and HTML content together within the body of 
a single email message. The email program displays only the part that it has been configured 
to display.
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b In the Template Name field, click the select button.

You can associate one text template and one HTML template with the offer.

c In the Pick Offer Template dialog box, select the template record and click OK.

5 Save the record to associate the template with the offer.

Adding Attachments to Email Offers
Use the following procedure to add literature items as email offer attachments. 

To add an attachment

1 Navigate to the Offers screen > Email Offers view.

2 In the Email Offers list, drill down on the offer name.

3 Click the Attachments view tab.

4 In the Attachments list, create a new record.

5 Click the Name select button, select the literature file you want to attach, and click OK.

6 In the Attachments Label field, type an attachments label for each file.

About Merge Fields in Email Offers
You can use merge fields in the body of a text or HTML email offer, in the same way that they are 
used within the text or HTML of other offer types. Additionally, merge fields may be used in the 
following areas related to email offers:

■ Subject Text field of the email offer. The text that you want to appear in the subject line of 
the email.

■ From Address parameter value. A parameter of the Email Marketing Server in User Delivery 
Profiles.

■ Reply To Address parameter value. A parameter of the Email Marketing Server in User 
Delivery Profiles.

About Email Offer Response Forms
Response forms are links to Web pages to which the email recipient is directed. Response types are 
fields in a response record. A response record might be generated by the email recipient clicking the 
response form link or by completing a form on the Web page to which they have been directed.

Table 13 on page 68 contains a list of response forms that are unique to email offers and a brief 
description of each.
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Adding Response Forms to Email Offers
You can include a variety of response forms in an email offer. Whenever a customer receives the 
email offer and clicks on the hyperlink for a response form, responses are automatically created for 
the campaign.

To add a response form to an email offer

1 Navigate to the Offers screen > Email Offers view.

2 In the Email Offers list, drill down on the email offer name.

3 Click the Edit Email view tab.

4 Click Edit Template.

5 From the Personalization Categories drop-down list, select Response Forms using Table 13 on 
page 68 as a guide. 

The available response forms will appear in the Personalization Elements box. 

6 Copy the Response Form tag from the left hand side using CTRL+C and paste into the desired 
location in the template using CTRL+V.

7 When you are finished editing, click Save Template.

Table 13. Response Forms and Descriptions

Response Form  Description

Requested 
Unsubscribe

Navigates customers to a Web page where they can enter communication 
preferences by channel. For more information, see �Setting Up and Using 
Web Marketing� on page 173.

Requested More Info Navigates customers to a Web page where they can provide contact 
information and from where your company can send more information 
such as brochures or other collateral.

Requested call back Navigates customers to a Web page where they can provide contact 
information and from where your company can arrange a follow-up phone 
call.

Forward to friend Navigates customer to a page where they can add the email address of 
friends and from where your company can forward the message.

One Click Unsub Automatically selects the Do Not Email check box on the contact profile 
and displays a confirmation message to the customer that states that they 
have been unsubscribed from all lists.
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About Creating Conditional Content
There are two personalization elements that can be used to generate conditional content within an 
email offer. Each of these is made up of the following personalization elements:

■ If-Then-Else. Determines if a block of text or HTML should be removed from an outgoing email 
by verifying if a Merge field value is defined. The merge field is defined if it is NOT an empty 
string or, for numeric merge fields, if it is not a value of 0 (zero).

■ If the merge field is defined, the block of text or HTML remains in the outgoing email.

■ If the merge field is not defined, the block of text or HTML is removed from the outgoing 
email.

■ Named Blocks. Used to decide whether or not to insert a block of text or HTML into an outgoing 
email by comparing one string to another. One string is compared to another to determine if the 
block of text or HTML will be inserted.

■ If the two strings are identical, the block is inserted.

■ If the two strings are not identical, the block is not inserted.

Read Receipt Detects that the email message has been opened by the customer. The 
customer is not aware of this hidden event.

This link is used only in HTML to embed a 1 x 1 pixel image in the email 
offer at the location where a response form is placed. If the recipient of 
the email offer opens the email, this image is retrieved from the Email 
Marketing Server and a Read Receipt response type record is created. The 
following is a list of some ways a read receipt can be blocked: 

■ Newer email clients might prevent the display of embedded images 
until the user allows them to be displayed. 

■ Ports used to make the request for the image might be blocked at the 
recipient's firewall. 

■ If you place the read receipt image in the HTML part of a multipart 
MIME email message and the recipient sets up their email program to 
read text emails only, the Read Receipt image request will not occur.

Subscribe to List Navigates customers to a Web page where a confirmation message 
displays stating that they have been subscribed to the list. This response 
automatically associates the contact or prospect ID of the respondent with 
a subscription list associated with the offer.

Unsubscribe from List Navigates customers to a Web page where a confirmation message 
displays stating that they have been unsubscribed. An Unsubscribe from 
List response type record is generated, and their contact or prospect 
record is removed from the subscription list associated with the offer. 

Table 13. Response Forms and Descriptions

Response Form  Description
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The components of these personalization elements must be placed in the correct locations in the text 
or HTML email offer or an error will occur. Additionally, in HTML, they should be placed in the HTML 
source, not the rendered HTML. This restriction means that you cannot use the Siebel HTML editor 
for placing these element components.

If-Then-Else Personalization Element
The following is a list of If-Then-Else personalization element components:

■ $(if [Field: FieldName]). The If component is required to start an If-Then-Else personalization 
element. It determines if the merge field named [FieldName] has a value. If there is a value for 
[FieldName], the text between this If-Then-Else component and the next If-Then-Else component 
is not removed from the email.

■ $(elseif [Field: FieldName]). The Else-If component is the same as the If component, except 
that it is used after the start of the If-Then-Else personalization element.

■ $(else). The Else component is used after a $(if) or $(elseif) component. When an analysis of 
a preceding $(if) or $(elseif) component results in the preceding block of text or HTML being 
removed from the outgoing email, the $(else) component's block of text or HTML is not removed 
from the outgoing email. If the preceding $(if) or $(elseif) component does not remove its block 
of text or HTML, the $(else) component removes its block of text or HTML.

■ $(endif). The End-If component closes the current If-Then-Else personalization element.

The following is a simple example of the use of an If-Then-Else personalization element. If the first 
name is defined, the contact's or prospect's first and last name appears. If the first name is not 
defined, only the last name appears:

$(if [Field: First Name])

Dear [Field: First Name] [Field: Last Name],

$(else)

Dear Mr. or Mrs. [Field: Last Name],

$(endif)

Nesting If-Then-Else personalization elements (placing one within another) is an acceptable practice. 
The following is an example of nesting these elements:

$(if [Field: First Name])

    $(if [Field: Last Name])

Dear [Field: First Name] [Field: Last Name],

    $(else)

Dear [Field: First Name],

    $(endif)

$(elseif [Field: Last Name])
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Dear Mr. or Mrs. [Field: Last Name],

$(else)

To Whom It May Concern:

$(endif)

Using of indentation indicates the nesting of one If-Then-Else personalization element within another. 
This is not necessary, but makes it easier to read. Also, notice that each component is on its own 
line. This use of separate lines is also not necessary, but makes reading the offer easier.

After the Email Marketing Server makes the decision about what text or HTML to remove, the If-
Then-Else personalization element components are also removed (including their trailing line 
breaks).

Named Blocks Personalization Element
The following list contains the Named Blocks personalization element components:

■ $(InsertBlock "MatchString"). Insert Block component. A block of text or HTML will be 
inserted at the location this component is placed when MatchString is identical to the MatchString 
of a Define Block component. This comparison is case sensitive.

■ $(DefineBlock "MatchString"). Define Block component. Starts a block of text or HTML that 
will be inserted in place of an Insert Block component when MatchString is identical to the 
MatchString of the Insert Block component.

■ $(EndBlock). End Block component. Ends a block of text or HTML started with the Define Block 
component.

NOTE: The string comparison is case sensitive.

Example of Using the Named Blocks Personalization Element
The following is a simple example of the use of a Named Blocks personalization element:

<P>The temperature of your favorite color is $(InsertBlock "[Field: Favorite 
Color]").</P>

$(DefineBlock "Red")

<B>hot</B>

$(EndBlock)

$(DefineBlock "White")

<B>cold</B>

$(EndBlock)

$(DefineBlock "Blue")
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<B>cool</B>

$(EndBlock)

In this example, the merge field named Favorite Color is the value Red. After population, the 
following sentence appears:

The temperature of your favorite color is hot.

The HTML source will read:

<P>The temperature of your favorite color is <B>hot</B>.</P>

If there is no match for an Insert Block component match string, then the Insert Block component 
is not replaced by any text or HTML. After the Email Marketing Server resolves all matches, the 
remaining Named Block personalization element components are removed (including their trailing 
line breaks and any text or HTML between Define Blocks and End Blocks).

NOTE: The Define Block and End Block components may be placed within the HTML HEADER tags. 
This placement can make the email offer more readable.

Associating Web Offers, Web Surveys, 
Events, and URLs with Offers
The ability to associate Web offers, Web surveys, Events, and Related URLs with offers is available 
in Siebel Marketing and Siebel Web Marketing.

Each offer element (Related Events, Web surveys, Web offers, and Related URLs) can be associated 
with any offer type with one exception. Web offers cannot include links to other Web offers. However, 
you can relate the same Web offer to more than one email offer. For example you might have an 
eService Web Offer and want to associate that Web offer with multiple email offers. In this case, each 
of these email offers will have a link to that same Web offer.

In the Advanced tab link bar, use the Related Web Offers, Related Web Surveys, Related Events, and 
Related URLs links to add each offer element to the appropriate offer. After you add an element to 
the list, it is available as a personalization element in the appropriate Offer. For example, after you 
add a Web offer on the Related Web Offers link bar, you can navigate to an Edit view and select Web 
Offers in the Personalization Category field. Your newly added Web offer appears in the list of 
elements.

When the Web site visitor clicks a Web survey link on the Offers or Information views, a survey wizard 
appears that steps the user through a series of questions about the product. You can use Web 
Surveys to capture customer feedback or qualify leads. Using the Web Survey designer, you can 
design a survey once, reuse questions and answers across multiple surveys, and deploy the survey 
on the Web and in the Call Center. The hyperlink takes the customer to a predefined Web survey 
page.

NOTE: Web Surveys are created using Siebel SmartScript. For more information, see Siebel 
SmartScript Administration Guide.
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The Related Web Surveys list contains a list of Web surveys related to this campaign that can be 
included in Web Offer page as URL hyperlinks. Drill down on the survey name in the Related Web 
Surveys list to display the SmartScript Administration screen's Scripts list where you can select and 
modify the survey.

The following list contains descriptions of how links to offer elements appear in an offer:

■ Web offer link. The following is an example of how a link to a Web offer appears in an offer. The 
hyperlink is the image (banner_midsize.gif). When you click the link, the Web offer (Introducing 
Siebel eService, MidMarket Edition) appears.

<a href="[*Web Offer: Introducing Siebel eService MidMarket Edition]"><img 
src="banner_midsize.gif" border=0 width="149" height="43"></a>

■ Event link. The following is an example of how a link to an Event appears in an offer. The 
hyperlink is Click Here. When you click Click Here, the specific Event appears.

<a href="[*Web Offer: Introducing Siebel eService MidMarket Edition]">Click here</a>

■ Web survey link. The following is an example of how a link to a Survey appears in an offer. The 
hyperlink is the image (customer_survey.gif). When you click the image, the specific survey 
appears.

<a href="[*Web Survey: Web Marketing-eService Survey]"><img src="images/
customer_survey.gif" border=0 width="156" height="23"></a>

■ Related URLs link. The following is an example of how a link to a related URL appears in an 
offer. The hyperlink is Click Here. When you click the words Click Here, the specific URL appears, 
showing any specified data elements.

<a href="[*Related URL: Siebel URL]">Click here</a>

■ Products link. The following is an example of how a link to a Product URL appears in an offer. 
The hyperlink is the image (order_now.gif). When you click the image, the specific product page 
appears.

<a href="[*Product: Siebel eService, MME]"><img src="images/order_now.gif" border=0 
width="81" height="23"></a>

To associate Web offers, Web surveys, Events, and Related URLs with offers

1 Navigate to the Offers screen.

2 In the Offers link bar, choose the offer type with which you want to associate an offer element.

3 In the selected offers list, drill down on the offer name.

4 Click the Advanced view tab for the Web offer or offer element that you want to associate with 
the selected offer.

5 In the selected list, create a new record.

NOTE: Related URLs must start with http:// or the Web server address will be inserted. If you 
have more than one URL, separate each one with a semicolon and no spaces.

6 In the add dialog box, select the Web offer or offer element and click OK.
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Creating a Wireless Offer
Using the Wireless Offers view allows you to create text messages that can be delivered through SMS 
as part of a campaign. Wireless offers can be sent to any contacts who are associated with the 
campaign and who also are associated with mobile device addresses.

To create a wireless offer

1 Navigate to the Offers screen.

2 In the Offers list, create a new offer.

3 From the Channel drop-down list, choose Wireless Message.

4 In the Offers list, complete the remaining fields.

For more information about creating offers, see �Creating an Offer� on page 52.

5 Drill down on the wireless offer name.

6 In the Edit Wireless Message view tab, in the Personalization Elements list, verify that the merge 
fields appear.

7 Click Edit Message to add the text of the message.

8 You can insert the merge field tag where you want the merge field to be located in the body of 
the message by performing the following steps:

a In the Personalization list, copy (CTRL+C) a merge field tag that you want to insert in the 
message.

b In the Message Contents workspace, paste (CTRL+V) the tag in the message contents box. 

9 Click Save Message to save the message text.

Working with Fax Offers
Fax offers are available in Siebel Marketing and Siebel Web Marketing. For instructions about how to 
create a fax offer, see �Creating an Offer� on page 52. For instructions about how to modify a fax offer, 
see �Modifying an Offer� on page 54.

For information about working with fax offers, see the following topics:

■ About Fax Offers on page 74

■ Associating a Template with a Fax Offer on page 75

About Fax Offers
Using the Fax Offer view, a marketer can create personalized faxes for targeted distribution during 
a campaign.

The Fax Offer view contains four view tabs.
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■ Offer Details. This form contains additional fields that you can use to specify a predefined 
communications Delivery Profile for fax distribution, an Activity check box that may be used to 
track the offer as an activity and approval check boxes and fields if the fax offer requires approval 
from your company�s marketing and legal departments. The Offer Details form also displays a 
unique identifier for the offer in the Offer Code field.

■ Edit Fax. This form allows you to choose an offer template and specify the personalization 
elements that are included in your fax design. 

■ Delivery Profile. This read-only list displays parameters of the Siebel Communications profile 
chosen for the fax offer. For more information on setting up a delivery profile for a fax offer, see 
Siebel Communications Server Administration Guide. For information on testing and distributing 
fax campaigns, see �Testing Email, Fax, and Wireless Campaign Offers� on page 116.

■ Literature. This list shows the company and product information associated with the media 
offer. You can add additional items to this list if desired. For more information, see �Associating 
Literature with Offers� on page 79.

Associating a Template with a Fax Offer
This section describes how to associate a template with a fax offer. To edit the template, see �Creating 
and Editing Offer Templates� on page 55.

To associate an offer template with a fax offer

1 Navigate to the Offers screen > Fax Offers view.

2 In the Fax Offers list, select the fax offer, and click the Edit Fax view tab.

3 In the Edit Fax form, create a new record.

4 Click the Template Name select button. 

5 In the Pick Offer Template dialog box, select the predefined template for the fax offer and click 
OK.

Only offer templates that you add to the Offer Templates list will be available for selection. For 
details, see �Creating and Editing Offer Templates� on page 55.

6 Save the record.

The template contents appear on the right side of the view, and Edit Template and Verify & 
Preview buttons are available.

Using Delivery Profiles for Fax Offers
Delivery Profiles are available in Siebel Marketing. They are required for fax offers. Delivery Profiles 
are created using the Communication Administration screen�s Communications Drivers and Profiles 
view. Fax offers are distributed using the fax communications driver provided with your fax 
application.
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Siebel Communications Server does not interface directly with fax servers. Most popular fax servers 
provide email system gateways that connect themselves to an email system such as Microsoft 
Exchange Server or an SMTP server. The host email system recognizes messages with specially 
formatted email addresses and directs those messages to the fax server.

Siebel Communications Server interfaces indirectly with this type of fax server through the host 
email system. Except for the email address format, it makes no difference to Siebel Communications 
Server whether it is sending an email or a fax. Before fax offers can be sent out, you must select 
one of the defined profiles.

Default parameter values are set for each communications driver within the Communication 
Administration screen�s Communications Drivers and Profiles view. You can create customized 
communications profiles for each of these driver types that override the default values for that driver. 
For example, a profile might specify customized From and Reply-To email addresses.

For more information about communications drivers and profiles, see Siebel Communications Server 
Administration Guide.

For information about using delivery profiles, see the following topics: 

■ Creating a Delivery Profile for Fax Offers on page 76

■ Associating a Delivery Profile with Fax Offers on page 77

Creating a Delivery Profile for Fax Offers
Use this section to select a communications driver and create a profile for fax offers.

To create a delivery profile for fax offers

1 Navigate to the Communications Administration - Communications Drivers and Profiles view.

2 In the Communications Drivers list, select a driver, and click the Profiles view tab.

3 In the Profiles list, create a new record.

a In the Name field, type a name for the new profile.

b In the Organization field, accept the default organization, or click the select button and select 
another organization.

c In the Responsibilities field, click the select button, and in the Responsibilities list, select the 
responsibility associated with profile access.

The Responsibilities field is used in conjunction with Siebel eMail Response. It does not apply 
to outbound email campaigns.

4 Save the profile, and click the Driver Parameters view tab.

5 Edit the parameters for the profile, and save the record.
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Associating a Delivery Profile with Fax Offers
Use the following procedure to associate a delivery profile with fax offers.

To associate a delivery profile with a fax offer

1 Navigate to the Offers screen.

2 From the Offers link bar, select Fax Offer.

3 In the Offer Details form, select the offer record.

4 In the Delivery Profile field, select the delivery profile for the offer.

Working with Phone Offers
Phone offers are available in Siebel Marketing and Siebel Campaigns. For instructions about how to 
create a phone offer, see �Creating an Offer� on page 52. For instructions about how to modify a phone 
offer, see �Modifying an Offer� on page 54.

For information about working with phone offers, see the following topics:

■ About Phone Offers on page 77

■ Creating Call Guides for Phone Offers on page 78

About Phone Offers
The Phone Offers view allows you to define telemarketing offers that will be executed using Siebel 
Call Center or another application.

The Phone Offers view consists of four view tabs.

■ Offer Details. This form contains more fields that you can use if the phone offer requires 
approvals from your company�s marketing and legal departments. It also provides a unique 
identifier for the offer in the Offer Code field.

■ Literature. This list shows the company and product information associated with the phone 
offer. You can add additional items to this list if desired. For more information, see �Associating 
Literature with Offers� on page 79.

■ Call Guide. This text form allows you to add information about your offer. The Call Guide note 
field is visible to call center agents as they launch campaigns.

■ Advanced. This form associates an Offer Group with the phone offer.
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Creating Call Guides for Phone Offers
A call guide is a read-only note field visible to call center agents as they launch campaigns. The 
information in the Call Guide field is useful to agents as they prepare for inbound and outbound 
telephone calls and when they talk to clients. You create the call guide in the Offers screen. 

The Call Guide field is intended to display more detailed information about the campaign, answer 
common questions, and provide offer options. The following example shows what a Call Guide field 
might contain:

Call Guide example. Through the end of December, we are offering a special bonus to our current 
customers upgrading a Basic service agreement to Premium. For $149, we will upgrade your service 
package as well as provide a coupon book worth $1,000 toward the purchase of our Signature brand 
of products.

If the customer agrees, the call center agent can click the Script button and start the call script.

NOTE: A call script is written using Siebel SmartScript. You associate a script with a campaign. For 
more information, see �Using SmartScripts with a Campaign� on page 97. For information about 
creating SmartScripts, see Siebel SmartScript Administration Guide.

To create a call guide

1 Navigate to the Campaigns screen.

2 In the Campaigns list, select a campaign.

3 Drill down on the campaign name.

4 Click the Design view tab.

5 In the Call Guide text field, type the information you wish to use for the offer.

About Direct Mail Offers
Direct mail offers are available in the Siebel Marketing application. For instructions about how to 
create a direct mail offer, see �Creating an Offer� on page 52. For instructions about how to modify a 
direct mail offer, see �Modifying an Offer� on page 54.

Using the Direct Mail Offer view, you can associate Literature documents with an Offer. Siebel 
Marketing does not provide a mechanism to print direct mail offers, but can pass output lists to 
vendors for execution.

You can generate output or distribution list of contacts during the campaign launch. The customer 
information is arranged according to a predefined list format, and the list can be delivered to the 
appropriate vendors through a predefined method (for example, FTP or email). For more information 
about list output and vendors, see �About Previewing and Generating Lists� on page 129.

The Direct Mail Offer contains the Offer Details and Literature view tabs.

■ Offer Details. This form contains additional fields that you can use if the Direct Mail Offer 
requires approvals from your company�s marketing and legal departments. It also provides a 
unique identifier for the offer in the Offer Code field.
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■ Literature. This list shows the company and product information associated with the offer. To 
add literature to the list, see �Associating Literature with Offers� on page 79.

About Media Offers
Media offers are available in Siebel Marketing and Siebel Campaigns. For instructions about how to 
create a media offer, see �Creating an Offer� on page 52. For instructions about how to modify a media 
offer, see �Modifying an Offer� on page 54.

The Media Offers view allows you to define indirect offers. Types of media offers available in the 
standard product are Billboard, Print Ad, Press Release, Radio, TV, Seminar, and Trade Show. When 
you define indirect offers, you know the general characteristics of your audience but not its exact 
composition.

The Media Offers view contains the Offer Details, Literature and Related Events view tabs. 

■ Offer Details. This form contains additional fields that you can use if the media offer requires 
approvals from your company�s marketing and legal departments. It also provides a unique 
identifier for the offer in the Offer Code field. You can specify the type of media you will use to 
distribute the offer using the Type field.

■ Literature. This shows the company and product information associated with the media offer. 
You can add additional items to this list if desired. For example, if the media offer type is press 
release, you can associate the press release content with the offer for later referral. For more 
information, see �Associating Literature with Offers� on page 79.

■ Related Events. This indicates if the media offer is being used to promote a specific event or 
set of events.

Associating Literature with Offers
Literature about the products or services offered during a campaign can be associated with an offer 
using the Literature view tab in the Direct Mail, Media, Phone, and Fax Offer views. To add 
attachments to email offers, see �Adding Attachments to Email Offers� on page 67.

You can associate literature items, such as white papers, presentations, brochures, advertising 
material, and product specifications with your offer to create a specialized library of information. You 
can use this library when reviewing details of offers that are being reused in current campaigns.

In addition, a call center agent can view the literature while launching the campaign. The agent can 
also include literature items with faxes, email messages, or correspondence sent to a contact. 
Literature items are automatically included when you create a new correspondence record for a 
contact.

Before you can select literature to associate with an offer, you must add the literature items to the 
Literature screen�s All Literature Across Organizations list. For more information about adding 
literature that you can associate with your offers, see the chapter about literature in Applications 
Administration Guide.

Use the following procedure to associate specific literature items with your offers.
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To associate a literature item with an offer

1 Navigate to the Offers screen.

2 From the Offers link bar, select the appropriate offer type.

3 Drill down on the offer name.

4 In the Literature list, create a new record.

5 In the Literature form, click the Name select button. 

6 In the Pick Literature Item dialog box, select the literature, and click OK.

Working with Web Offers
Web offers are available in Siebel Marketing and Siebel Web Marketing. The Web Offers view allows 
you to create offers that can be used on your company�s Web pages. For instructions about how to 
create a Web offer, see �Creating an Offer� on page 52. To modify a Web offer, see �Modifying an Offer� 
on page 54.

About Web Offers
Using the Web Offers view tabs, you can specify a template containing content for the Web Offer, 
edit the template and add personalization elements, identify links to related Web offers, surveys, 
related events and related URLs and attach relevant product information that can be downloaded by 
the Web site visitor. 

The Web Offers view includes the following view tabs:

■ Offer Details. This form contains additional fields that you can use if the Web Offer requires 
approvals from your company�s marketing and legal departments. It also provides a unique 
identifier for the offer in the Offer Code field. 

NOTE: If you select the Inbound Active Flag check box, the Web Offer appears to eligible users 
in the Web Marketing home page. The Featured Offers applet checks this flag before displaying 
a Web offer to an eligible contact or prospect.

■ Edit Web Offer. This form allows you to attach templates containing the content of the Web 
offer. To be selected here, templates must first be added to the Offer Templates list. For details, 
see �Creating and Editing Offer Templates� on page 55.

■ The Edit Templates button allows you to edit the template content, as well select 
personalization categories, and copy and paste category elements into the template.

■ The Verify & Preview button verifies the template edits and displays the finished Web offer 
as it will appear on the Web page.

■ Downloads. This list allows you to provide a list of literature related to the offer that is available 
for download by the Web site visitor.
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■ Advanced. Contains the Related Web Surveys, Related Events, and Related URLs link bars. 
These lists allow you to specify Web surveys, related events, and related URLs that you can 
embed in your Web offer, using the Edit Web Offer personalization elements controls. For 
information, see �Associating Web Offers, Web Surveys, Events, and URLs with Offers� on page 72.

The following sections detail how to create a basic Web offer:

■ Associating a Template with a Web Offer on page 81

■ Adding Attachments to Web Offers Downloads List on page 81

Associating a Template with a Web Offer
This section describes how to associate a template with a Web offer. To edit the offer template, see 
�Creating and Editing Offer Templates� on page 55. Templates must first be added to the Offer 
Templates list to be available for selection in the Edit Web Offer view tab. For details, see �Creating 
and Editing Offer Templates� on page 55.

To associate an offer template with an email offer

1 Navigate to the Offers screen > Web Offers view.

2 In the Web Offers list, select the offer and click the Edit Web Offer view tab.

3 Create a new record.

4 Click the Template Name select button.

5 In the Pick Offer Template dialog box, select the template and click OK.

To be available for selection, templates must first be added to the Offer Templates list. For 
details, see �Creating an Offer Template and Adding it to the Template List� on page 56.

6 Save the record to associate the template with the offer.

Adding Attachments to Web Offers Downloads List
The Web Offer Downloads list displays literature and other files that can be downloaded in 
conjunction with the offer. Literature items must be included in the literature list to be available for 
selection in this view.

The Downloads list shows files that can be included in the selected Web offer for download. Any 
literature other than offer templates can be included in an offer as a download. 
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The fields in this view are shown in Table 14.

Files added here are not automatically available for downloading. In this view, you select a set of 
files that you want to be able to include as downloads from your Web offer. These files then appear 
in the Personalization Elements list of embeddable objects in the Edit Web Offer form when you select 
the Downloads category from the Personalization Categories list.

You can select any file from that list and copy it into the template file and that file will be available 
for downloading. These files are displayed in the Embedded Object list as [Download:Literature 
Item Name].

When the Siebel Marketing software encodes this tag, it uses the Literature Item Name as the 
hyperlink text. The marketer can override this default behavior by using the wildcard (*) functionality 
and manually defining the HREF link, as described in �Using Hyperlinks (HREF) in an Offer Template� 
on page 57.

To attach literature in the Downloads view

1 Navigate to the Offers screen > Web Offers view.

2 In the Web Offers list, select the offer, and click the Downloads view tab.

3 In the Downloads list, select the literature you want to make available for downloading from the 
Web offer.

a Click the menu button and create a new record.

b In the Downloads form, click the Name select button.

c In the Pick Literature Item list, select the item, and click OK.

Table 14. Fields in the Web Offer Downloads View

Field Comment

Comments Automatically populated from the literature table.

Description Automatically populated from the literature table.

File Name Automatically populated from the literature table.

File Type Automatically populated with the file extension.

Modified Automatically populated with the file modification date.

Name Click the Name select button to select a literature item.

Release Date Automatically populated with the date that the 
literature item was released.

Size (In Bytes) Automatically populated with the file size in kilobytes. 
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Previewing Offers
You can preview what an offer will look like when received by a contact or prospect in the following 
ways:

■ Click Verify & Preview in the appropriate Edit Template view. Clicking this button tests the 
behavior of conditional content to various merge field values. For more information, see the 
section in this chapter that applies to the template you are using.

■ Use the Test Offer feature. This feature is one way to confirming configurations for email, fax, 
and wireless offers. For example, when you use this feature to test email offers you confirm 
configurations such as Email Marketing Server configuration and proper template setup for use 
in multipart MIME. For more information, see �Testing Email, Fax, and Wireless Campaign Offers� 
on page 116.
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6 Planning and Designing 
Marketing Campaigns
This chapter contains the following topics:

■ About Siebel Marketing Campaigns on page 85

■ Program and Campaign Planning Tools on page 86

■ Creating Campaigns on page 91

■ Working with Campaign Teams and Groups on page 98

■ Setting Up Campaign Execution Options on page 100

■ Setting Up Campaign Quotas on page 107

■ Setting Up Campaign Assignment Skills on page 111

■ Using Siebel Marketing with Siebel Events Management on page 114

■ About Testing Campaign Offers on page 115

■ Using Response Management on page 116

■ Using Campaign Explorer on page 124

■ Loading Customers in Campaigns on page 125

About Siebel Marketing Campaigns
The Siebel Campaigns module is available to users with a license for Siebel Marketing or Siebel 
Campaigns. 

A campaign is the initiative in which you convey a marketing message to one or more groups of 
people. Typically, campaigns deliver a promotional offer to retain current customers or to acquire 
new customers across channels of communication. For example, you might launch a phone campaign 
that invites contacts to sign up for a special promotion or deliver a direct mail campaign that provides 
a sample of a new product and a coupon offer to existing customers.

The goal of a marketing campaign is to create an opportunity that ultimately results in a sale, brand 
recognition, or some other type of response. Marketers use both direct and indirect campaigns to 
achieve these objectives. 

■ Direct campaigns target individuals using multichannel approaches such as email and telephone. 
Contacts for the campaign are derived by applying segmentation criteria against a database of 
customer information and generating a list or by purchasing or renting a list of prospects. 
Multiple campaigns can use the same segment criteria.
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■ Indirect campaigns target indeterminate groups of people whose general characteristics you may 
know, but whose exact composition you do not know. Examples of indirect campaigns are those 
that use television, radio, print ads, or other forms of media for delivery of the message. An 
indirect campaign is associated with a marketing program�s stage rather than with a specific 
segment or list.

About the Siebel Campaigns Module
The Siebel Campaigns module is used by Siebel eBusiness Applications such as Call Center and Sales. 
The campaigns are the same as the campaigns that result from a campaign in the marketing 
application. Campaigns contain contacts and prospects, offers, activities, and other campaign 
execution elements.

Using Siebel Campaigns you can distribute your company�s offer using television, radio, billboards, 
direct mail, fax, email, the Web, wireless, and phone.

The campaign creation process begins with an administrator, who creates the offers and associates 
the offers with a campaign. The administrator then adds the literature, contacts and prospects, call 
summary, and call guide. The administrator also determines which script, if any, is associated with 
the campaign and who is on the campaign team. A campaign manager might associate quotas and 
incentive awards with the campaign to track progress and reward performance.

The administrator can monitor the status of campaigns using the Campaign Explorer view to see the 
Contacts, Activities, Offers, and Literature for each campaign, and by using Campaign and Response 
Charts.

Program and Campaign Planning Tools
Siebel Marketing�s program and campaign organizational tools allow management of activities, 
milestones, documentation and schedules for your marketing campaigns.

This chapter contains the following topics:

■ Creating and Using Activity Plans on page 87. Siebel Marketing�s activity plans can help you plan 
and execute the marketing program�s activities and milestones.

■ Using Timelines on page 89. Program, campaign, and campaign charts provide an at-a-glance 
weekly and monthly overview of planned, active, and completed programs and campaigns.

■ Associating Documents with Programs and Campaigns on page 90. The Documents view in the 
Programs screen allows you to create a library of proposals, white papers, artwork, and other 
files associated with the marketing program.
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Creating and Using Activity Plans
Siebel Marketing�s Activity Plans views allow you to associate predefined planning and milestone 
activities and tasks with a template (activity plan). Then, you can assign the templates to your 
marketing programs and campaigns. This assignment creates one or more activities that are 
associated with a campaign or a program.

NOTE: Activities are not created for contacts loaded into a campaign.

Activity Plans may be designed to help you plan the marketing program or campaign, or launch it. 
Before you link an activity plan to your campaign, you need to create activity templates or customize 
existing templates to reflect your business process and needs. Templates allow you to define a 
generic set of activities that may be reused. 

For example, a marketing department production manager might design an activity plan template 
called Direct Mail that contains regularly scheduled campaign activities such as meetings with 
creative or budgetary staff and start tasks. Using the Campaign Activity Plans view the manager can 
associate the activity plan template to the current campaign and then assign resources, define 
priorities and status and so on to each predefined task, adding comments where necessary. 

The activity plan record is flagged to indicate how the activity plan will be used. If the activity is 
designated as a planning task, none of its activities are copied to the campaign record when it is 
created. If the activity plan is designed for the execution of the program or campaign, select the 
Recurring check box, and the set of activities will be automatically recreated and associated with 
each occurrence.

If your marketing program or campaign has a mixture of planning and start activities, create two 
plans, one for planning and one for execution tasks, and assign them both to the program or 
campaign.

Creating Activity Templates
Activity Plan Templates allow you to create and manage activities for programs and campaigns. You 
define templates using the Application Administration screen�s Activity Templates and Activity 
Template Details views.

A campaign�s activity plan template might include information on the type of activity, duration and 
status, a list of activities associated with the program or campaign (preparation, telephone calls, 
milestones, tasks), and so on.

To create an activity plan template

1 Navigate to the Administration - Data screen > Activity Templates view.

2 In the Activity Plan Templates list, create a new record. 

3 In the Template form, complete the fields and save the record.

a Type a name for the template.

b In the Type drop-down list, choose Program Container for a marketing program template, and 
Campaign as an activity template for campaigns.

c Type a template description.
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d In the Auto Trigger field, select the check box if the activity should be associated with the 
occurrence level.

e Select the Public check box if the activity plan may be used by others not on your team.

To create activities for the template

1 Navigate to the Administration - Data screen > Activity Templates view.

2 In the Activity Plan Templates list, select a template.

3 Click the Activity Template Details view tab. 

4 In the Activity Template Details list, create a new record.

5 Complete the necessary fields for each activity assigned to the template.

6 From the Type drop-down list, choose an activity type.

NOTE: Repeat Step 2 through Step 6 to add activities to the template.

7 Save the activity.

Associating Activity Plans with Programs and Campaigns
Use the Campaigns or Programs screen�s Activity Plans view to associate a template containing 
predefined activities with a program or campaign. An Activity Plan Template�s type must be set to 
Program Container for marketing programs and Campaign for marketing campaigns to be available 
for selection. 

The Activity Plans view consists of the following elements:

■ The Campaign or Program form, which provides details of the selected campaign or program.

■ The Templates list, which can contain one or many activity plan templates.

■ The Activities list, which displays activities associated with the selected template.

To associate an activity plan and activities with a campaign or program

1 Navigate to the Campaigns or Programs screen.

2 In the Campaigns or Programs list, drill down on the campaign name or program name.

3 Click the Plan view tab.

4 In the Plan link bar, click Activity Plans.

5 In the Activity Plans list, create a new record.

In the new row, the Recurring field contains a check mark.

6 Complete the necessary fields.

a From the Template drop-down list, select a predefined template.

b Edit the existing description if desired, or type a description of the plan.
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c Select Suppress Calendar to populate the check box if you do not want these activities added to 
your calendar view.

d Clear Recurring if the activity should be not be written to the campaign record for every 
occurrence of the campaign or program.

When you clear the Recurring check box, you indicate that this set of planning tasks is only 
performed once across all occurrences. By default, each new activity plan is set to Recurring 
when you assign it to a campaign or activity.

A list of all activities appear in the Activities list. Note that the dates are populated by using the 
Lead Time column relative to the time that the activity template was associated. 

7 To change the times or dates of any of the activities, click the Schedule view tab for the campaign

8 In the Schedule link bar, click Activity List.

Using Timelines
Timelines are available for programs, campaigns, event plans, and events. Timelines provide 
calendar views of scheduled, active, and completed marketing tactics in a Gantt chart format. The 
chart is divided into weeks and months. Start field and End field values determine the placement of 
the timeline bars.

Types of Timelines
Timeline types appear in the link bar of the Marketing Calendar screen.

■ Tactics timeline. This timeline shows all planned, active, and completed marketing tactics 
including programs, campaigns, event plans, and events. You can drill on the name of any tactic 
displayed in one of the timelines to be navigated to the details for that tactic. The drill down will 
take you to the appropriate screen (program, campaign, event plan, or event) according to the 
tactic type.

■ The Programs timeline. This timeline chart shows planned, active, and completed programs. 
You can double-click on the folder icon next to a program in the chart to see the child campaigns 
and related events.

■ The Campaigns timeline. This timeline shows planned, active, and completed campaigns.

■ Events timeline. This timeline chart shows all planned, active, and completed event plans and 
events.

Viewing Timelines
Timelines help you determine that scheduling is appropriate and on track for planned marketing 
efforts. 

To view timelines

1 Navigate to the Marketing Calendar screen.
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2 In the Marketing Calendar link bar, click a timelines type.

For a description of types of timelines, see �Types of Timelines� on page 89.

Understanding Color-Coded Status Bars
Timeline bars are color-coded to help you identify the status of programs and campaigns. You can 
place the cursor over a timeline bar to display more details. 

Programs and campaigns timelines use the following status colors:

■ Active: Green

■ Planned: Yellow

■ Scheduled: Orange

■ Completed: Blue

■ Cancelled: Red

NOTE: Sometimes status (programs and campaigns) timelines use this status color.

Associating Documents with Programs and Campaigns
Most marketing teams generate documents such as proposals, white papers, press releases, and 
artwork used in advertising. These documents can be attached to programs and campaigns for future 
reference.

To attach documents to programs and campaigns

1 Navigate to the Campaigns or Programs screen.

2 In the Programs or Campaigns list, drill down on a program or campaign.

3 In the Plan link bar, click Documents.

4 Click the Attachments view tab.

5 To add a URL, in the Attachments list, perform the following steps:

a Click New URL.

b In the URL field, type the URL, and click Add.

6 To attach a file, in the Attachments list, perform the following steps:

a Click New File. 

b In the Choose File dialog box, select the file, and click Open.

7 In the Comments field, add information that identifies the file�s contents.

8 Select the Update File check box to set this preference, if you want changes to the original file 
to be included in the attached file.
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To access the attached document
■ In the Documents list, drill down on the Attachment Name to view document details.

Creating Campaigns
This section contains the following topics:

■ Requirements for Creating and Modifying Campaigns on page 91

■ Creating a Campaign on page 92

■ Associating Campaign Elements with a Campaign on page 95

■ Associating Offers with a Campaign on page 96

■ Using SmartScripts with a Campaign on page 97

Requirements for Creating and Modifying Campaigns
You use campaigns in Siebel Marketing and Siebel Campaigns. Prior to launching a campaign, you 
need to perform some or all of the following tasks:

■ Create segments or lists. Create segments using the marketing segmentation module. For 
details, see �Importing and Managing External Lists� on page 147 and �Creating and Managing 
Internal Lists� on page 159.

■ Associate segments and lists with a campaign. �Associating a List of Prospects or Contacts 
with a Campaign� on page 125.

■ Select the contacts and prospects. Add the names of contacts and prospects you will be 
targeting with the campaign. Add contacts and prospects manually if desired. If you use 
segments or lists, you must load the campaign. Manually adding names occurs when a sales 
organization is collecting very specific customers to target with an offer. For details, see �Adding 
Contacts and Prospects to a Campaign Individually� on page 126. 

■ Determine campaign activities and milestones. Create activity plans with associated 
activities for your campaigns. For details, see the chapter about activities in Applications 
Administration Guide.

■ Set up campaign groups and teams. Specify group or team members to launch the campaign. 
For details, see �Working with Campaign Teams and Groups� on page 98.

■ Establish employee skills. Determine what employee skills are needed to launch the 
campaign. �Setting Up Campaign Assignment Skills� on page 111.

■ Develop quotas. Set up quota plans for campaign team members to meet and determine 
incentives or rewards for those who meet their quotas. For details, see �Setting Up Campaign 
Quotas� on page 107.

■ Define the Segments. For more information, see �Marketing Segments and Segment Trees� on 
page 35.
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■ Associate vendors and export list formats. For more information, see �About Previewing and 
Generating Lists� on page 129.

■ Set up campaign execution options. For more information, see �Using Assignment Manager 
with Campaign Contacts� on page 106.

■ Define the offers. Create the offer that your customers will receive, and associate the offers 
with campaigns. For details, see Chapter 5, �Creating and Using Offers.�

■ Create a SmartScript. This SmartScript will guide agents through a campaign call. For details, 
see �Using SmartScripts with a Campaign� on page 97.

■ Prepare literature items. Prepare any literature items associated with the campaign. For 
details, see the chapter about literature in Applications Administration Guide.

Creating a Campaign
Use this procedure to create a campaign in the Campaigns screen.

To create a new campaign

1 Use the step in the following list that applies to your product:

■ In Siebel Marketing, navigate to the Campaigns screen.

■ In other Siebel applications, navigate to the Campaign Management screen.

2 In the Campaigns list, add a new record.

3 In the Campaigns form, complete the fields.

Some fields are described in Table 15 on page 92. To view all fields in the Campaigns form, click 
the Show more button.

4 Complete the necessary fields for the campaign record, using Table 15 as a guide.

Table 15. Frequently Used Fields for a Campaign Record

Field Comments

Approval Status If the value is Revised, the campaign is still being revised.

Assigned Budget The amount of money approved to spend for the campaign.

Budget Request If the campaign has been submitted as part of a Budget Request, the 
Budget Request ID appears.

Campaign Code Automatically added. You can type a source code for the campaign, or 
use the default record ID for the code.

The source code for this campaign is available for use as part of the 
source code format for the program. The value must be unique.

Division The internal division responsible for the campaign.
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DNIS The telephone number associated with the campaign. This number 
must be set up separately in Siebel CTI (Computer Telephony 
Integration). The DNIS field for a campaign is used in CTI to query for 
this campaign and drive a screen pop to this campaign. See Siebel 
Communications Server Administration Guide for more information.

Type only numerals in this field. Do not use hyphens, spaces, 
parentheses, periods, or any characters other than numbers.

Execution Period The predefined time period during which the campaign will be active.

Language The language in which the call script and offer was created. If no 
language is specified, the selected SmartScript runs in the default 
language for the application. If the script does not have a translation 
for the language selected, you will get an error when trying to run the 
script.

Lead Partner If a lead partner was assigned at the program level and the campaign 
associated with that program does not have a lead partner, the 
campaign inherits the lead partner from the program. The choice of 
Lead Partner is limited to the organizations associated with the 
campaign.

You can change the value, selecting from any of the partners associated 
with a campaign or campaign. This lead partner will be copied to any 
campaigns created from this campaign and to responses or 
opportunities that result from this campaign.

Name The name of the campaign. 

You can have two campaigns with the same name but the campaign 
code for each campaign must be unique.

Organization The predefined organization that is responsible for the campaign. You 
can choose more than one organization.

You can also associate Partner Organizations with the campaign. 
Partner organizations are created and administered through Partner 
Administration. For more information, see Siebel Partner Relationship 
Management Administration Guide.

Planned Start/
Planned End

The planned start date defaults to the date you created the campaign. 
The planned end date defaults to 30 days later.

These dates do not affect launching campaigns. A campaign will launch 
even if the planned end date has passed.

Priority The priority level for the campaign. This value can be used to refine 
contact frequency rules in segmentation criteria. For example, to 
exclude customers that have been targeted by a Priority 1 campaign in 
the last 30 days.

Table 15. Frequently Used Fields for a Campaign Record

Field Comments
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Product Lines You can associate product lines to the campaign to help categorize the 
campaigns in the system.

Products You can associate products to the campaign to help categorize the 
campaigns in the system.

Program This field is automatically completed when the campaign is associated 
with a specific marketing program.

Purpose In the Plan view tab. The purpose of a campaign�for example, �To cross 
sell products to existing customers.�

Region Choose from the list the region in which the campaign will be active.

SmartScript Select a call script, if needed, to guide the agent�s interaction with the 
customer. To appear in the list, scripts must be set up in advance using 
Siebel SmartScript. For instructions, see Siebel SmartScript 
Administration Guide.

The call script starts when an agent clicks the Script button in the 
Campaign Contacts or Prospects view.

You can use the Call Guide as an alternative to a SmartScript call script.

If more than one script is associated with a campaign, the script flagged 
as primary runs when the agent clicks the Script button.

Stage This field is automatically populated with stage information when the 
campaign is associated with a specific program�s stage.

Status By default, campaign status is Planned (start and end dates in the 
future). Status values may be changed at any time. During automatic 
program execution, the status automatically changes to active when a 
campaign is loaded. At the conclusion of the program, the campaign�s 
status automatically changes to completed. If the program is executed 
manually, status does not automatically change.

To change the status, use the status drop-down list to choose Active 
(start date in the past and end date in future) or Completed (start and 
end date in the past).

Type Choose from the list the type of campaign you are creating. Options 
include Acquire, Retain, Win-Back, Cross-Sell, and Up-Sell.

Table 15. Frequently Used Fields for a Campaign Record

Field Comments
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Associating Campaign Elements with a Campaign
Table 16 contains descriptions of many elements in the Campaign view tabs that can be associated 
with a campaign.

Table 16. Campaign Elements That Can Be Associated with a Campaign

Plan and Design 
Element Location and Description

Activity List In the Schedule link bar. Team members can create and assign activities 
related to the campaign.

Activity Plans In the Plan link bar. Templates of activities can be associated with a 
campaign.   For more information, see �Creating and Using Activity Plans� on 
page 87.

Documents In the Plan link bar. Any team member can associate documents as 
attachments to the campaign.

Execution Options In the Design link bar. The campaign execution options specify the default 
values for these settings each time the campaign is loaded.

Expenses In the Plan link bar. Each campaign can have a forecast that predicts the 
financial performance of the plan. The actual results versus the forecast can 
be tracked for each campaign.

Lead Partner Field in the Campaign Details form view. Anytime a Campaign Plan is loaded, 
the Lead Partner is automatically added to the associated campaign. The 
lead partner must be one of the organizations associated with the campaign.

Offers In the Design link bar. Each time the campaign is loaded or launched the 
associated offers will be copied to the campaign. For details, see �Associating 
Offers with a Campaign� on page 96.

Organizations Field in the Campaign Details form view. These are the organizations that 
will have visibility to the Campaign under All Campaigns. When the 
campaign is loaded, each organization is automatically included on the 
associated Campaign.

Related Events In the Design link bar. After you launch a campaign that has an associated 
related event, all campaign contacts are added to the campaign as invited 
attendees. For details, see �Associating Related Events with a Campaign� on 
page 96.

Team Members Field in the Campaign Details form view. These are the employee positions 
that have visibility to the campaign under the My Campaigns option. When 
the campaign is loaded, each team member is automatically included on the 
associated campaign.
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Associating Offers with a Campaign
Before you implement a marketing program, you should associate one or more offers with the 
campaign, depending on your marketing strategy. The Offers list provides information about each 
offer, including the name and description, the offer type, and the source code assigned to this 
particular offer, and any associated product and price list.

When the campaign is loaded, a campaign record is created, and valid offers are copied to the 
campaign. Any views showing the offers for each campaign have built-in visibility to prevent invalid 
offers from appearing to end users. A valid offer is defined as an offer with a current date that falls 
between its defined activation and expiration dates. If activation and expiration dates are not defined 
for the offer, the offer is valid by default. Each time the campaign is loaded and when it is launched 
campaign offers are copied to the wave history.

NOTE: If you plan to change offers during the campaign (after launching one or more waves), you 
should not disassociate the previous offer. Instead you should mark the previous offer as expired 
(using the expiration date), and associate the new active offer. This method allows you to continue 
to capture and report on responses from the previous version of the offer.

To associate offers with a campaign

1 Use the step in the following list that applies to your product:

■ In Siebel Marketing, navigate to the Campaigns screen.

■ In other Siebel applications, navigate to the Campaign Management screen.

2 In the Campaigns list, drill down on the campaign name.

3 Click the Design view tab.

4 In the Offers list, create a new record.

5 In the Add Offer dialog box, select a predefined offer, and click OK.

Associating Related Events with a Campaign
Events can be associated with a campaign so that you can invite contacts and prospects to an event. 
For more information about related events, see �Using Siebel Marketing with Siebel Events 
Management� on page 114.

To associate events with a campaign

1 Use the step in the following list that applies to your product:

■ In Siebel Marketing, navigate to the Campaigns screen.

■ In other applications, navigate to the Campaign Management screen.

2 In the Campaign list, drill down on the campaign name.

3 Click the Design view tab.

4 In the Offers link bar, click Related Events.
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5 Create a new record, and click the Name select button.

6 In the Pick Event dialog box, select a predefined event, and click OK.

Using SmartScripts with a Campaign
A SmartScript is a script that the salesperson or call center agent uses to interact with the customer. 
It can be associated with any campaign. 

If a SmartScript is associated with a business component and will be run for a campaign, then that 
business component�s name must be the same as the value in the Response Type field for the 
campaign. For example, if the Response Type field is set to Response, then the script�s business 
component must be Response. If the Response Type field is set to Opportunity, then the script's 
business component must be Opportunity.

To set up a SmartScript

1 Use the step in the following list that applies to your product:

■ In Siebel Marketing, navigate to the Campaigns screen.

■ In other Siebel applications, navigate to the Campaign Management screen.

2 Select a campaign.

3 In the SmartScript field, click the select button.

The Smart Scripts dialog box appears.

4 Select the script from the list of available scripts, and click Add.

NOTE: Repeat Step 3 through Step 4 to add all the scripts that will be used in this campaign. 

5 In the SmartScript dialog box, select the check box of the primary script, and click OK.

Creating and Applying Campaign Templates
You can save any campaign as a reusable campaign template. The template retains many of the 
planning details from the campaign such as the goals, expenses, offers, documents, segments/lists, 
and activity plans. After you create a campaign template, you can reapply the template to any new 
campaigns. You can also share the template with other employees in your organization.

To save a campaign as a campaign template

1 Navigate to the Campaigns screen.

2 In the Campaigns list, drill down on the campaign that you want to use as a template.

3 In the Campaign form, click the menu button, and select Save as Template. 

This menu option is active only if your administrator has given you permission to use this action 
(using the Marketing access groups).
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4 In the Save As Template dialog box, type a name, and click OK.

5 To make changes to the new template, navigate to the Marketing Templates screen > Campaign 
Templates view.

6 Query for the template you created in Step 4.

7 In the template list or form, make the necessary changes.

To apply a campaign template to a campaign

1 Navigate to the Campaigns screen.

2 In the Campaigns list, create a new campaign, or drill down on the campaign name to which you 
want to apply the template. 

3 In the Campaign form, click the menu button, and choose Apply Template.

4 In the Apply Template dialog box, select the template you want to apply, and click OK.

5 When asked if you want to continue, click OK.

The Message dialog box, appears, confirming that the template was applied.

6 In the Message dialog box, click OK.

Working with Campaign Teams and 
Groups
Many organizations assign groups of agents to particular campaigns based on skill or territory.

The most straightforward way to provide access to the campaign is by assigning positions to a team. 
However, if you have a large call center where agents are organized by predefined groups of agents, 
you can set up assignments once and then assign the group to each campaign. Setting up campaign 
groups lets you add the key positions to a campaign group, without having to remember individual 
employees. 

Some call centers do not have predefined groups, or the groups change often. In this case you can 
assign positions directly to the campaign team. Every employee position in the team has access to 
the campaign. To work with campaign teams and groups, perform the following tasks:

■ Assigning a Team to a Campaign on page 98. Used by Siebel Marketing and Siebel Campaigns.

■ Setting Up Campaign Groups on page 99. Used by Siebel Campaigns.

■ Associating Groups with Campaigns on page 100. Used by Siebel Campaigns.

Assigning a Team to a Campaign
Campaign teams are used by Siebel Marketing and Siebel Campaigns. Campaign teams are set up 
by assigning individual employees to a team that is associated with the campaign. Each employee 
position on the campaign team has access to the campaign in the Campaigns screen.
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If you are working with partners in developing the Campaign, you can also include a partner as a 
team member by adding that partner�s position. The partner might then view the campaign in the 
Partner Portal, in the Campaign Management screen.

To assign a team to a campaign

1 Use the step in the following list that applies to your product:

■ In Siebel Marketing, navigate to the Campaigns screen.

■ In other Siebel applications, navigate to the Campaign Management screen.

2 In the Campaigns list, drill down on the campaign name.

3 In the Team field, click the select button.

The creator of the campaign is automatically assigned as the primary member of the Campaign 
Team. This position may be removed from the team only after you select a different member of 
the team to be the Primary.

4 In the Team Members dialog box, select employees from the Available list and click Add.

To select multiple consecutive employees, hold down SHIFT as you select each name. To select 
multiple nonconsecutive employees, hold down CTRL as you select names.

5 Click the Primary field to select the primary team member, and click OK. 

The default primary team member is the position that created the campaign.

Setting Up Campaign Groups
Campaign groups are positions within your company, not individual employees. After you add a group 
to a campaign, anyone occupying a position listed in the group has access to the campaign. 
Campaign groups are used by Siebel Campaigns and can be associated with a campaign in Siebel 
Marketing.

To create a campaign group and add group members

1 Use the step in the following list that applies to your product:

■ In Siebel Marketing, navigate to the Campaigns screen.

■ In other Siebel applications, navigate to the Campaign Management screen.

2 In the Campaigns link bar, click Campaigns Groups.

3 In the Campaign Groups list, add a new record.

4 Type a name and description for the group.

5 In the Campaign Groups list, select the group.

6 In the Positions list, add a new record.

7 In the Add Positions dialog box, select the positions for the group and click OK.
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Associating Groups with Campaigns
After you have created the campaign group, you can associate the group with your campaign. 
Campaign groups are used by Siebel Campaigns. 

To add a group to a campaign

1 Use the step in the following list that applies to your product:

■ In Siebel Marketing, navigate to the Campaigns screen.

■ In other Siebel applications, navigate to the Campaign Management screen.

2 In the Campaigns link bar, click Campaigns Groups.

3 In the Groups list, create a new record.

4 Type a name and description for the group.

5 In the Campaigns link bar, click Campaigns List.

6 Select the campaign.

7 In the Group field, click the select view button.

8 In the Add Groups dialog box, select the group from the available list, and click Add.

9 Click OK.

Setting Up Campaign Execution Options
Campaign execution options are available in Siebel Marketing and Siebel Campaigns. Campaign 
execution options allow you to specify campaign contact ownership and control the user�s ability to 
edit campaign contacts and prospects. You specify the ownership type and complete the default 
owners (organization and position). In addition, you can apply assignment rule groups (optional) that 
will allow automatic owner assignment.

Campaign contact ownership is a feature that allows you to control team members visibility into the 
campaign contacts. Team members accessing the campaign contacts view will only be able to see 
those campaign contacts and prospects that they own.

You create these assignment rules in the Assignment Rules view in the Assignment Administration 
screen. For more information, see Siebel Assignment Manager Administration Guide. You select a rule 
group for a campaign in the Campaigns screen.

To establish execution options and apply Assignment Manager rules to campaign contacts, perform 
the following tasks:

■ Setting Up Execution Options for a Campaign on page 101

■ Using Assignment Manager with Campaign Contacts on page 106.
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Setting Up Execution Options for a Campaign
You can select the default execution options for each campaign when you set up the campaign. After 
the campaign is loaded, you can modify the execution options for the associated campaign at any 
time. 

If you want to assign contact ownership, make sure that you select the appropriate Campaign 
Contact Ownership value, your default owners, the Contact editing flags, and an Assignment 
Manager rule group.

To set execution options for the campaign

1 Navigate to the Campaigns screen.

2 In the Campaigns list, drill down on the campaign name.

3 Click the Design view tab.

4 In the Design link bar, click Execution Options or Execution Options - Advanced and complete the 
fields. 

NOTE: Some fields exist only in the Execution Options - Advanced link.

Execution options fields are described in the following tables:

■ Assignment Options. Table 17 on page 102 contains details about assignment options.

■ Collaboration Options. Table 18 on page 103 contains details about collaboration options.

■ Delivery Options. Table 19 on page 105 contains details about delivery options.
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■ Load Options. Table 20 on page 105 contains details about load options.

Table 17. Execution Options - Assignment Option Fields

Field Action

Assignment Rule 
Group

Required if you select Yes - Assignment Manager in the Campaign Member 
Ownership field. Use if you want Assignment Manager to assign the 
organization owner and position owner to contacts and prospects in the 
campaign. Select a rule group to apply to contacts in the campaign.

Campaign Member 
Ownership

Controls assignment of position owner and organization owner during the 
load process. Values are:

■ No. You do not want to assign ownership. When you select this option, 
the Organization Owner and Position Owner fields are left empty on the 
campaign contacts and prospect records.

■ Yes - Manually. When you select this option, the load process populates 
the Default Position Owner and Default Organization Owner to the 
Campaign History table (S_CAMP_CON) for all the contacts and 
prospects in the load. After the load process, you can manually assign 
organization and position owners on the campaign contacts and 
prospect records.

■ Yes - Assignment Manager. You want Assignment Manager to assign 
ownership based on Assignment Manager rule groups. The load process 
invokes the Assignment Manager engine at the end of the process to 
assign the campaign members based on the rules in the selected 
Assignment Rule Group.

Default Organization 
Owner

(Optional) Default value that is automatically populated into the Default 
Organization Owner field during the load process when assignment is 
enabled (Yes - Assignment Manager or Yes - Manually). 

The list of organizations is restricted to the organizations associated with 
the campaign. After the value is populated, it might be updated if the 
assignment engine reassigns names. For more information, see Siebel 
Assignment Manager Administration Guide.

Default Position 
Owner

(Optional) Default value that is automatically populated into the Default 
Position Owner fields during the load process when assignment is enabled 
(Yes - Assignment Manager or Yes - Manually). 

The list of positions is restricted to the Default Organization Owner 
organizations associated with the campaign. After the value is populated, it 
might be updated if the assignment engine reassigns names. For more 
information, see Siebel Assignment Manager Administration Guide.

Lock Campaign 
Team Assignment

Campaign managers sometimes create assignment rules that assign 
additional positions to the campaign team. This lock flag excludes this 
campaign from the rules, so that new team members would not be assigned.
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Table 18. Execution Options - Collaboration Options

Field Action

Enable Contact 
Editing

Default is on (True). When this option is checked, users on the campaign 
team or group will have the ability to add an delete contacts from the 
campaign list.

Enable Contact 
Editing

Default is on (True). Clear the check box if you want to prevent any one from 
changing the owner fields and adding and deleting contacts. This flag 
controls the ability to edit the following fields on the campaign contact or 
prospect record:

■ Done Flag

■ Contact Last Name

■ Prospect Last Name

■ Organization Owner

■ Position Owner

In addition, when this value is True, the New and Delete buttons are 
available.

Enable Partner 
Editing of Contacts 

Default is on (True). Clear the check box if you want to prevent partners 
from editing the fields and using the buttons controlled by the Enable 
Contact Editing check box.

Enable Partner 
Editing of Contacts

When this option is checked, partners associated to the campaign (as 
organizations) will have the ability to add an delete contacts from the 
campaign list.

Enable Followup 
Actions

This value controls which buttons (Create Oppty, Create Order, Create 
Response, Script) are active in the Campaign agent views (Campaign 
Members). The following list describes the values:

■ Create Opportunities. The Create Response and Create Oppty buttons 
are active.

■ Create Orders. The Create Response and Create Order buttons are 
active.

■ Create Responses. The Create Responses button is active.

■ All. All buttons are active.

Enforce Approvals When this option is active, the campaign cannot be launched unless the 
Approval Status for the campaign and all its associated offers is Approved. 
You will receive an error if you try to launch a campaign and the conditions 
are not met.
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Control Campaign This flag denotes that this campaign is meant to be used as a control group 
for a test and control program. Control campaigns are hidden from the 
outbound call center agent views (Campaign Members - Outbound), 
because control groups should not receive offer messages. Control 
Campaigns do appear in the Inbound version the Campaign Members view, 
because you want to be able to capture unsolicited responses.

Enable Contact 
Editing

 When this option is checked, users on the campaign team or group will be 
able to add an delete contacts from the campaign list.

Table 18. Execution Options - Collaboration Options

Field Action
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Table 19. Execution Options - Delivery Options

Field Action

Apply Wave Lags to 
Export Files

By default all the exported list files for a wave are sent to the vendor on the 
launch date. If this option is enforced and you use Wave % splitting and 
wave lag option in the program schedule view, then the lag days are applied 
to the file. The files for delayed waves will not be sent until the launch date 
plus the number of lag days is reached.

Route Contacts This flag controls whether campaign contacts should be routed to mobile 
clients. By default all routing rules for campaign contacts are disabled. To 
reactivate these rules, customers must consult Siebel Expert Services 
because there will be a performance impact for client synchronization 
(campaigns have a lot of potential data).

Route Prospects This flag controls whether campaign prospects should be routed to mobile 
clients. By default all routing rules for campaign prospects are disabled. To 
reactivate these rules, customers must consult Siebel Expert Services 
because there will be a performance impact for client synchronization 
(campaigns have a lot of potential data).

Table 20. Execution Options - Load Options

Field Action

Load Behavior Controls what happens to the previous wave or load when the user opts to 
load the campaign again. The following is a list of choices:

■ Overwrite Campaign History. Purges entire existing campaign history 
and creates a new load.

■ Create New Wave. Creates an additional load or wave for the latest load.

■ Add to Existing Wave. Finds the most recent good wave (not purged or 
suspended) and adds the campaign load members to the existing wave.

Allow Repeated 
Contacts with Load

Controls whether a specific contact or prospect ID can appear more than 
once in the same load in the campaign.

The unique index in S_CAMP_CON (campaign members or contacts table) is 
based on Campaign ID, Load Number, Contact/Prospect ID, and Token 
Number. By default the application always populates a value of 1 in the 
column, so that uniqueness is driven by the contact and campaign. However, 
if you turn off this option, the token number becomes a running number so 
there is no uniqueness enforced at the table level. This scenario is typical in 
certain industries such as Life Sciences where there is a many-to-many 
relationship between contacts and accounts. For example, in the 
pharmaceutical industry, doctors are affiliated with multiple hospitals and 
the pharma companies send offers to all of their active addresses in the 
same campaign.
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Using Assignment Manager with Campaign Contacts
After setting execution options, you can load and launch the campaign. If you chose to automatically 
assign an owner and associate an assignment rule group with the campaign, Assignment Manager 
runs against the contacts in S_CAMP_CON at the end of the campaign loading process.

Before launching a campaign, you can add or delete campaign contacts and prospects or change the 
organization and position owners associated with a contact or prospect.

When this editing process is complete, you can run assignment manager against the campaign 
contacts and prospects to make sure ownership and visibility are correct. To run Assignment 
Manager, click the Run Assignment Manager button in the Execution Options view tab. You will be 
prompted to select a campaign, and then Assignment Manager will run against the campaign history 
table (S_CAMP_CON) for that campaign�s contacts and prospects. For example, partners or 
employees might add new contacts to the campaign during the review process. Because these new 
leads might not have the correct owner, you can rerun Assignment Manager to assign these new 
records.

NOTE: You cannot run Assignment Manager until the campaign has successfully loaded.

To automatically assign owners to campaign contacts

1 Navigate to the Campaigns screen.

2 Drill down on the campaign name.

3 Click the Design view tab.

4 In the Design link bar, click Execution Options.

Source Code Format The source code format that will be used to generate source codes for the 
campaign. If the format is associated to the program level too, the value 
should be carried over when a campaign is created on the program flow.

Generate Source 
Codes during Load

This option automatically generates source codes for all waves that have not 
been launched at the completion of the campaign load. If the option is 
disabled, you need to manually generate the source codes using the 
Generate Source Codes menu option in the campaign screen.

Capacity Limit per 
Load

If this value is set to a value greater than 0 (zero), the campaign load will 
stop inserting campaign members as soon as the capacity is reached. For 
example, you could limit the campaign size to no more than 1000 people per 
load.

Max Errors This setting controls when the campaign load (EAI) process should abort.   
The load process tabulates the number of rejected records that were not 
inserted due to errors (bad data and so on). After the Max Errors value is 
passed, the campaign load process aborts. When this value is 0 (zero), all 
inserts and updates for the batch are backed out.

Table 20. Execution Options - Load Options

Field Action
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5 Verify that the values in the following fields are correct:

■ Default Organization Owner

■ Default Position Owner

■ Assignment Rule Group

6 Load and Launch the campaign.

When the Campaign is loaded, Assignment Manager automatically assigns owners to the 
campaign contacts.

7 If you wish to run Assignment Manager again, you can click the Run Assignment Manager button 
and select the campaign that you want to load and launch.

8 Click Run Assignment Manager.

The Run Assignment Manager button is only available if you choose Yes - Assignment Manager 
in the Campaign Contact Ownership field.

9 In the Pick Campaign dialog box, select a campaign and click OK.

Setting Up Campaign Quotas
Quotas are used by Siebel Marketing and Siebel Campaigns and may be set up for a campaign as an 
incentive for agents to meet target goals. The quota may be a monetary goal such as generating a 
certain amount of revenue for a campaign or it may be a nonmonetary goal such as making a certain 
number of calls within a time period.

To develop a quota plan with measurable objectives and rewards for success, use the following 
process and the quota view tabs to define details. For more information, see Siebel Incentive 
Compensation Administration Guide. This section contains the following topics:

1 Creating Campaign Quota Plans on page 107. Create the quota plan, and specify the period it will 
be in effect.

2 Defining Quotas for the Plan on page 108. Specify the objectives for each quota and how 
performance is measured.

3 Assigning Awards to the Campaign Quota Objective on page 109. Define the incentives that 
participants receive for meeting quota objectives.

4 Assigning Campaign Quota Plan Participants on page 111. Select team members eligible to 
participate in the quota plan.

Creating Campaign Quota Plans
Use the following procedure to set up quota plan for your campaign. Then, using the procedures that 
follow, define the details of the quota plan.
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To create a quota plan

1 Use the step in the following list that applies to your product:

■ In Siebel Marketing, navigate to the Campaigns screen.

■ In other Siebel applications, navigate to the Campaign Management screen.

2 Drill down on the campaign name.

3 Click the Design view tab.

4 In the Design link bar, click Quotas.

5 In the Quotas list, create a new record.

6 Complete the fields for the quota plan.

Some fields are described in Table 21.

Defining Quotas for the Plan
After you define the quota plan, add quota objectives that participants must meet to receive 
incentives. Prior to adding new quotas, add the appropriate Quotas, Awards, and Plan Participants.

To add quota objectives to the quota plan

1 Use the step in the following list that applies to your product:

■ In Siebel Marketing, navigate to the Campaigns screen.

■ In other Siebel applications, navigate to the Campaign Management screen.

2 Drill down on the campaign name.

3 Click the Design tab.

4 In the Design link bar, click Quotas.

Table 21. Quota Plan Fields

Field Comment

Active Flag Automatically set to True when you create the quota.

Description Description of the quota plan.

End Automatically populated when the Period field is completed. 

Internal Division 
Name

The name of the internal division associated with this quota.

Period (Required) The time period for which the quota is active.

Plan Name (Required) Type a relevant name for the Quota Plan.

Start Automatically populated when the Period field is completed. 
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5 In the Quotas list, drill down on the plan name.

The quota plan details appear in the Plan form, and quota objectives appear in the Quotas list.

6 In the Quotas list, create a new record.

7 In the Add Quota Objectives dialog box, select an objective and click OK.

Repeat Step 6 and Step 7 to add additional quota objectives to the quota plan.

To edit quota objective values 

1 Use the step in the following list that applies to your product:

■ In Siebel Marketing, navigate to the Campaigns screen.

■ In other Siebel applications, navigate to the Campaign Management screen.

2 In the Campaign list, drill down on the campaign name.

3 Click the Design tab.

4 In the Design link bar, click Quotas.

5 In the Quotas list, drill down on the plan name.

The quota plan details appear in the form, and quota objectives appear in the Quotas list.

6 Select the quota objective record and change values in the appropriate fields.

Information about some fields in the quota objective record are described in the following table.

The next time you select the quota record, your modifications appear.

Assigning Awards to the Campaign Quota Objective
Quota plan participants may receive awards for meeting campaign objective goals. A number of 
awards for different performance achievements may be set up using the Awards view tab list. These 
awards can then be assigned to quota objectives.

To assign predefined awards to a quota objective

1 Use the step in the following list that applies to your product:

Field Comment

Description Contains a detailed summary of the quota objective. You can edit this 
field.

Measure (Read only) Values are Revenue and Units. You typically add a Target 
Amount quota for a revenue measure and a Target Quantity quota for a 
units measure.

Quota Type (Read only) Values are Amount and Quantity.
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■ In Siebel Marketing, navigate to the Campaigns screen.

■ In other Siebel applications, navigate to the Campaign Management screen.

2 In the Campaigns list, select the campaign.

3 Drill down on the campaign name.

4 Click the Design tab.

5 In the Design link bar, click Quotas.

6 In the Quotas list, drill down on the plan name.

The quota plan details are displayed in the form, and quota objectives appear in the Quotas list.

7 Click the Award select button and, in the Pick Quota Incentive dialog box, select the award for 
meeting the quota.

After you click OK, the selection appears in the Award field.

8 In the Target Quantity field, click the calculator button, and use the calculator to type the number 
of units that represents the quota target.

To create new awards

1 Use the step in the following list that applies to your product:

■ In Siebel Marketing, navigate to the Campaigns screen.

■ In other Siebel applications, navigate to the Campaign Management screen.

2 Drill down on the campaign name.

3 Click the Design tab.

4 In the Design link bar, click Quotas.

5 In the Quotas list, drill down on the plan name.

The quota plan details are displayed in the form, and quota objectives appear in the Quotas list.

6 In the Administration - Sales Quota link bar, click Awards.

7 In the Awards list, create a new record.

8 Complete the necessary fields for the award.

Some fields are described in the following table.

Field Comment

Amount In the field, click the arrow, and use the calculator controls to type the 
dollar amount for the award. If the type is cash, then this value is the 
amount of cash given with the award.

Award Date In the field, click the arrow, and use the calendar controls to specify the 
date the reward will be given.

Description Type a description of the award.
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Assigning Campaign Quota Plan Participants
Assign eligible participants to your quota plan using the Participants view tab.

To add participants to the campaign quota plan

1 Use the step in the following list that applies to your product:

■ In Siebel Marketing, navigate to the Campaigns screen.

■ In other Siebel applications, navigate to the Campaign Management screen.

2 Drill down on the campaign name.

3 Click the Design tab.

4 In the Design link bar, click Quotas.

5 In the Quotas list, drill down on the plan name.

Quota objectives appear in the Quotas list.

6 Click the Quota Plan Participants view tab.

7 In the Participants list, create a new record. 

8 In the Pick Position dialog box, select the people targeted for quota plan participation, and click 
OK.

Repeat this procedure to add other participants.

Setting Up Campaign Assignment Skills
Campaign assignment skills are set up only in Siebel Campaigns. Setting up campaign assignment 
skills is a way to identify which employees have certain skills and define the attributes of each skill.

Assignment Manager uses assignment skill rules to assign telesales agents to a campaign. 
Assignment skills are categories, such as Product or Language. Campaign Skill Items are subsets of 
campaign skills. For example, a skill item for the product campaign skill might be 486 Laptop or 
Pentium Desktop. A skill item for the language campaign skill might be French or English.

When associating skills with a campaign, first define the assignment skill, and then assign properties 
to the skill using the Campaign Skill Item list. Fields in the Campaign Skill Item list vary according 
to the skill. Repeat these procedures to add as many skills as needed to the campaign. 

To set up assignment skills for a campaign, perform the following tasks:

Name Type a reference name for the award.

Type Select the award type from the drop-down list. Options are Dinner, 
Cash, Trip, and Other. Your administrator may change these values to 
reflect your company�s requirements.

Field Comment
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■ Associating Assignment Skills with a Campaign on page 112

■ Defining Campaign Skill Items on page 112

■ Deleting Assignment Skills and Campaign Skill Items on page 113

Associating Assignment Skills with a Campaign
Use the following procedure to define and associate assignment skills required for your campaign.

To associate multiple assignment skills with a campaign

1 Use the step in the following list that applies to your product:

■ In Siebel Marketing, navigate to the Campaigns screen.

■ In other Siebel applications, navigate to the Campaign Management screen.

2 In the Campaigns list, drill down on the campaign name.

3 Click the Design tab.

4 In the Design link bar, click Assignment Skills.

5 In the Assignment Skills list, create a new record.

6 Complete the fields, typing comments that describe the skill and how it will be used in the 
campaign.

Defining Campaign Skill Items
Use the following procedure to define items for each campaign skill associated with your campaign. 

To associate skill items with a skill

1 Use the step in the following list that applies to your product:

■ In Siebel Marketing, navigate to the Campaigns screen.

■ In other Siebel applications, navigate to the Campaign Management screen.

2 In the Campaigns list, drill down on the campaign name.

3 Click the Design tab.

4 In the Design link bar, click Assignment Skills.

5 In the Assignment Skills list, select a skill.

6 Scroll down to the Campaign Skill Item list, and create a new record.

7 In the Campaign Skill Item list, complete the fields defining the properties for each skill item.
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Table 22 defines the skill items in the standard product that may be associated with a skill. Some 
items are associated with more than one skill.

Deleting Assignment Skills and Campaign Skill Items
You can delete assignment skills and campaign skill items. When you delete an assignment skill, all 
its campaign skill items are deleted.

To delete an assignment skill and all its campaign skill items

1 Use the step in the following list that applies to your product:

■ In Siebel Marketing, navigate to the Campaigns screen.

■ In other Siebel applications, navigate to the Campaign Management screen.

2 Drill down on the campaign name.

3 Click the Design tab.

4 In the Design link bar, click Assignment Skills.

5 In the Assignment Skills list, select the skill and delete the record.

You have deleted the assignment skill and the campaign skill items that were associated with it.

To delete a campaign skill item

1 Use the step in the following list that applies to your product:

■ In Siebel Marketing, navigate to the Campaigns screen.

■ In other Siebel applications, navigate to the Campaign Management screen.

2 Drill down on the campaign name.

3 Click the Design tab.

4 In the Design link bar, click Assignment Skills.

5 In the Assignment Skills list, select the skill.

6 Scroll down to the Campaign Skill Item list and select the item you want to delete from the 
assignment skill.

7 Delete the record.

Table 22. Skill Item Fields

Skill Item Field Action

Expertise The expertise required for this skill. Options in the standard product are 
Novice, Intermediate, and Expert.

Product The product associated with the skill.
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Using Siebel Marketing with Siebel 
Events Management
The Siebel Events Management module allows sales and marketing professionals to create, 
coordinate, and manage events across the enterprise, resulting in improved client interaction and 
expansion of the marketing message.

Siebel Events Manager 7.7 is integrated with Siebel Marketing 7.7, allowing users to create complex, 
multistage event marketing programs. Marketing administrators can use the Program Flow view to 
associate events with marketing campaigns. Upon execution of the campaign, attendees are invited 
to the event and automatically populated in the event attendee list. Responses are tracked when the 
attendees decide to accept the invitation and begin the registration process. As a result, event 
managers can track each attendee through the life of the event, from invitation, confirmation, and 
attendance.

Customers who have purchased the required license options for both Siebel Marketing and Siebel 
Events Management, can invite contacts or prospects to an event through an email marketing 
campaign. Sending this kind of invitation involves creating a target segment or list of invites, 
associating a related event to a campaign and email offer, and launching the campaign to send out 
email invitations with an embedded Event Web site URL. During execution, campaigns that have a 
related event automatically add the campaign contacts or prospects to the event as attendees, with 
a Registration Status of Invited.

Unlike contacts, prospects are not required to log in to the events Web site in order to register for 
an event. Therefore, this method for inviting prospects may be particularly useful in the case where 
third-party prospect lists are imported and not promoted to contacts. Invited prospects are shown 
in the Events screen, Attendees subview.

Promoting an Event Using a Campaign
This task assumes that the user has already created an Event and Offer. In most cases, users would 
invite contacts or prospects using an Email Offer. Siebel Marketing also supports other types of 
offers, such as Direct Mail, Fax, or SMS. However, the automatic embedding of the Siebel Events Web 
site URL only works with an Email Offer. To promote an event using a campaign, use the following 
guidelines:

■ Create a campaign adding a Related Event. For additional information, see �Creating a Campaign� 
on page 92 and �Associating Related Events with a Campaign� on page 96.

■ Launch the campaign. For additional information, see �Launching Programs and Campaigns� on 
page 129.

■ After campaign launch, Navigate to the Event screen > Attendees view to see the invited contacts 
or prospects.
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Promoting an Event Using a Program
This task assumes that the user has already created the Events, Campaigns and Offers and that all 
three entities are associated (such as associating an offer to a campaign and an event to a 
campaign). In most cases, users invite contacts or prospects using an Email Offer. Siebel Marketing 
also supports other types of offers, such as Direct Mail, Fax, or SMS. However, the automatic 
embedding of the Siebel Events Web site URL only works with an Email Offer. To promote an event 
using a program, use the following guidelines:

■ Create a program. For additional information, see �Creating a Program� on page 25.

■ Navigate to the Programs screen and drill down on the program name. 

■ In the Program Flow workspace, select the campaign used to promote the event.

■ In the Objects palette, click and drag the event icon onto the program flow workspace.

■ Select the event from the Pick Event dialog box.

■ Launch or schedule the program as you normally would. For more information, see �Executing 
Programs� on page 34.

■ After each campaign launch, navigate to the Event screen > Attendees view to see the invited 
contacts/prospects.

About Testing Campaign Offers
You can test outbound email, wireless, and fax campaigns in Siebel Marketing and Siebel Campaigns 
before actually sending them to target recipients. You can preview the offer delivery distribution and 
then launch the email campaign using the Send functionality.

When you use the test offer feature, a sample of the offer is sent to a designated team member, 
based on his or her position. Because the test functionality references a position rather than a 
person, if the individual holding the position changes, the test offer automatically is sent to the 
person actually holding the position.

To test campaigns and offers, see the following topics:

■ Testing Campaigns Business Scenario on page 115

■ Testing Email, Fax, and Wireless Campaign Offers on page 116

Testing Campaigns Business Scenario
The marketing manager of a telecommunications company plans to roll out a campaign that targets 
mobile communications customers whose service agreements will expire in the next quarter. The 
campaign features an email containing information on the latest wireless communications offers. The 
business goal is to retain the accounts of those customers by offering incentives for signing a new 
service agreement.

The marketing manager uses Test Offer to view the content and format of the email before it is sent 
to targeted customers.
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Testing Email, Fax, and Wireless Campaign Offers
Test Offer sends samples of email, fax, or wireless offers associated with a particular campaign to 
designated team members, based on positions. Before testing email offers, make sure you complete 
the following tasks:

■ Make sure the offer is active. The date in the Activation Date field for the email offer must 
have arrived, and the date in the Expiration Date field must be current or in the future for the 
Test Offer command to be enabled. 

■ Associate the offer with a campaign. Associate the offer with an active campaign. For details, 
see �Associating Offers with a Campaign� on page 96. 

To test email, fax, and wireless campaign offers

1 Use the step in the following list that applies to your product:

■ In Siebel Marketing, navigate to the Campaigns screen.

■ In other Siebel applications, navigate to the Campaign Management screen.

2 In the Campaigns list, drill down on the campaign name.

3 In the Campaign form, perform the following steps:

a Click the Team select button.

b In the Team Members dialog box, select an employee from the Available list, click Add, and then 
click OK.

4 Click the Design view tab.

5 In the Design link bar, click Offers.

6 In the Offers list, select an email offer.

7 Click the menu button and choose Test Offer. 

8 In the Campaign Team dialog box, choose from the list of available team members, and then click 
OK. 

9 Verify the email offer has been sent to the specified email address.

Using Response Management
Siebel Marketing and Siebel Campaigns use Response Management. Whenever prospects or contacts 
respond to an offer through any channel (by inbound email, the Web, a call center, or sales 
representative), their responses may be captured in detail using the Responses screen. Using 
Response views, you can determine which contacts to pursue as opportunities.
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Campaign media can be different from response media. Recipients of an Internet campaign can 
respond through a call center, and recipients of a direct mail offer may respond by going to a Web 
offer URL. A Web site can automatically capture response details, while phone calls or direct mail 
responses must be recorded manually. 

NOTE: In Siebel Marketing, inbound emails are not automatically captured as responses. You must 
configure your email response product to support inbound email processing. For Siebel eMail 
Response set-up instructions, see Siebel Email Response Administration Guide.

There are several response types and each response type has several parameters that store details 
about a given response. You can modify an automatically captured response if you have permission. 
Responses are tracked for an offer and for a campaign. 

This section contains the following topics:

■ Adding Response Information to Prospect or Contact Records on page 117

■ Using Automatic Source Code and Offer Code Lookups on page 118

■ Adding a Product to a Response on page 119

■ Adding an Order to a Response on page 119

■ Adding an Opportunity to a Response on page 120

■ Adding an Attachment to a Response on page 120

■ Response Type Definitions on page 121

■ Promoting a Response to an Opportunity on page 123

■ Creating Automatic Responses from Opportunities and Orders on page 123

Adding Response Information to Prospect or Contact 
Records
The All Responses list allows you to view responses to selected campaigns and offers and to add 
response information to existing prospect or contact records. You can use this view to promote a 
contact to an opportunity, specify the response type and channel, and score the response. An 
optional Details form allows you to type additional information about the response.

To add response information to prospect or contact records

1 Navigate to the Responses screen.

2 In the Responses list, create a new record.
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3 In the Responses list or form, complete the fields using the following table as a guide.

Using Automatic Source Code and Offer Code Lookups
Behind each Responses view is an automatic business service that will look up and decode 
information based on any source codes or offer codes added in a response.

Source Code Lookups
To perform a source code lookup, type the campaign contact�s source code into the Source Code field 
on the response form and leave the field. You do not have to save the record to perform the lookup. 
As soon as you click or step off the field, the lookup service will determine whether the campaign is 
recognized and whether the contact name can be uniquely determined. If the source code is 
recognized, the correct campaign name will be defaulted. If the contact name can be uniquely 
determined within a campaign, the contact name will also be defaulted. The source code value is 
stored in the campaign history table (S_CAMP_CON) for each contact record.

Fields Comment

Last Name Select the Last Name for a prospect or contact.

A number of fields are automatically populated based on this selection. 
These include:

■ The first name of the respondent.

■ The account associated with the respondent. If no account is 
associated, use the Account select button to choose one.

■ The account address (city, state, country, telephone number, and so 
on), that are associated with the respondent are automatically filled 
in the form.

Lead Partner Choose a partner organization to associate with the response. If a lead 
partner was assigned at the program level or campaign level, it will 
automatically appear in this field. If you do choose to change the Lead 
Partner value, the drop-down list shows only those partners associated 
with the campaign source.

Response Method (Optional) The method used to capture the response.

Offer Name (Required) Only offers associated with the selected campaign appear in 
the list.

Score Type a numeric value that represents a score for the response.

Source Code In Siebel Marketing and Siebel Campaigns, source codes are assigned 
to each campaign contact according to the source code format 
associated with the program stage. If this information is included in 
offer materials, the code can be added by the user on the response.

Offer Code Each offer has a unique offer code. If the offer code is included in the 
offer materials, the code can be added by the user on the response.
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Offer Code Lookups
To perform an offer code lookup, type the offer code in the response form. When you save the record, 
if the lookup service recognizes the offer code, it defaults the correct offer name.

NOTE: If the source code or the offer code is not recognized by the application or if the two codes 
conflict, both values will be saved with the response to preserve the user data.

If your deployment does not require source code lookups, you can disable the Response Lookup 
business service in Siebel Tools.

Adding a Product to a Response
This view tab displays a list of products associated with the response, for example, products for which 
a respondent requested information using a product link in an email or Web offer.

To add products to a response

1 Navigate to the Responses screen > Responses view.

2 In the Responses list, drill down on the description.

3 Click the Products view tab.

4 In the Products list, create a new record.

5 In the Add Products dialog box, select the product from the list and click Add.

The list contains products that have been associated with the offer.

Adding an Order to a Response
This view tab displays a list of the respondent�s product orders. An order record contains information 
on the order status, the order number, type, account associated with the order, the date, priority, 
and description of the order.

To add orders to a response

1 Navigate to the Responses screen > Responses view.

2 In the Responses list, drill down on the description.

3 Click the Orders view tab.

4 In the Orders list, create a new record.

5 In the Add Orders dialog box, select the order from the list, and click Add.
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Adding an Opportunity to a Response
This view tab displays a list of opportunities associated with the response.

To add opportunities to a response

1 Navigate to the Responses screen > Responses view.

2 In the Responses list, drill down on the description.

3 Click the Opportunities view tab.

4 In the Opportunities list, create a new record.

5 In the Add Opportunities dialog box, select the opportunity from the list, and click Add.

Adding an Attachment to a Response
This view tab displays a list of documents and other items that are associated with the response 
record.

To add attachments to a response

1 Navigate to the Responses screen.

2 In the Responses list, drill down on the description.

3 Click the Attachments view tab.

4 To add a URL, in the Attachments list, perform the following steps:

a Click New URL.

b In the URL field, type the URL, and click Add.

5 To attach a file, in the Attachments list, perform the following steps:

a Click New File. 

b In the Choose File dialog box, select the file, and click Open.
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Response Type Definitions
The information captured and stored in the Response Details view depends on the response type that 
you select in the Response Type field of the response record. For each response type value, Table 23 
identifies some of the field names in which information is captured and describes the captured 
information.

NOTE: A Response is not automatically created when you click a Related Events link in an email or 
Web offer. Siebel Marketing and Siebel Campaigns do not provide responses for Clicked on Related 
Event.

.

Table 23. Response Type Field Values in the Response Details Form

Response Type Field Name Captured Information and Description

Clicked on 
Product URL

Summary Name of the product. The list of product URLs the 
respondent clicked appears in the Responses screen, 
Products view.

Clicked on Web 
Offer

Summary Name of the Web offer that was clicked by the offer 
recipient.

Clicked on Web 
Survey

Summary Name of the Web survey that was clicked by the offer 
recipient.

Completed Web 
Survey

Summary Name of the Web survey that was clicked by the offer 
recipient.

Downloaded Info 
Files

Downloaded File Name of the downloaded file.

Subject Subject of the file.

Summary Optional comment.

Email Reply Subject Subject of the file.

Summary Optional comment.

Read Receipt Not applicable An optional response type that requires additional 
configuration to support automatic creation.

Marketers can embed an HTML tag in HTML emails that 
allows Siebel Marketing to count each time the email is 
opened (read). The read receipt tag contains an image 
request. When that image is requested it is interpreted as 
an opened email. 
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Requested Call 
Back 

Phone # Respondent�s phone number.

Time of day Allows the respondent to specify a preference for the time 
of callback. Choices are Morning, Afternoon, and Evening.

Priority Priority level of the callback request. Choices are Urgent, 
High, Medium, and Low.

Summary Automatically stores the comments for a Web-generated 
response or can be edited manually.

Topic Can store the subject line of an inbound email or be edited 
manually. The list of products for which the respondent 
requested a callback appears in the Responses screen, 
Products list.

Requested More 
Info

Ship Method The preferred method of delivery�direct mail, email, fax, 
or phone�that the customer has specified be used for 
delivery of information.

Fax Fax number, if the delivery method is fax.

Email Email address, if the delivery method is email.

Phone Phone number, if the delivery method is phone.

Comments Automatically stores the comments for a Web-generated 
response. Other comments may be entered manually.

Topic Can store the subject line of an inbound email or be edited 
manually.

Street Address, 
City, State, ZIP, 
Country

The address to which the information will be mailed if the 
preferred delivery method is direct mail.

The list of products for which the respondent requested 
information appears in the Responses screen, Products 
list.

Requested 
Unsubscribe 
Response

Email, Fax, 
Phone, Direct Mail

The choices are subscribe and unsubscribe.

Time of Day 
(Subscribe by 
phone)

Allows the respondent to specify a preference for a time if 
the respondent wishes to subscribe by telephone. Choices 
are Morning, Afternoon, and Evening.

Subject Can store the subject line of an inbound email or be edited 
manually.

Summary Contents of the email. Applies only to campaign 
responses.

Table 23. Response Type Field Values in the Response Details Form

Response Type Field Name Captured Information and Description
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Promoting a Response to an Opportunity
If the customer is interested in the product offered by the campaign, you can promote the response 
to an opportunity. If the customer is an existing contact, the account is automatically associated with 
the opportunity. If the customer is a prospect, the customer is automatically promoted to a contact, 
and then associated with an account.

To promote a response to an opportunity

1 Navigate to the Responses screen.

2 In the Responses list, drill down on the Description name.

3 In the Response form, click Create Opportunity button.

The Opportunity form appears, with the response information in the form, and the contact 
information in the Campaign Leads Contacts list.

Creating Automatic Responses from Opportunities and 
Orders
When you create an opportunity in the All Contacts/Prospects view using the Create Opty button, 
Siebel Marketing and Siebel Campaigns create a response record using the Create Auto Response 
business service.

Respondent 
Purchased

Not applicable This response is not created automatically. You must use 
Siebel Business Process Designer to capture responses of 
this type.

The orders for this purchase are displayed in the 
Responses screen�s Orders view.

Respondent 
Unreachable

Summary Optional comment.

Response Created 
Opportunity 

Summary The list of opportunities can be accessed by selecting the 
Responses Opportunities view.

Unclassified 
Response 

Not applicable The response does not fall into one of the main response 
type categories or is a campaign response that requires 
manual processing.

Subject Subject of the email. Applies only to campaign responses.

Summary Contents of the email. Applies only to campaign 
responses.

Table 23. Response Type Field Values in the Response Details Form

Response Type Field Name Captured Information and Description
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For opportunities, the response is created for each contact added to an opportunity after a campaign 
is associated as an opportunity source. To create the response, associate a campaign with the 
opportunity using the Source field MVG (multi-value group) and then add a contact to the 
opportunity. All responses default to a type of Created Opportunity.

For orders, the response is created whenever a campaign is associated with a sales order. To create 
the response, you associate a campaign with the Sales Order using the Campaign field. All responses 
default to a Type of Respondent Purchased.

Associating an Opportunity with a Campaign 
To associate an opportunity to a campaign, you use the Source field on the Opportunity form to select 
the campaign name. Each opportunity can be associated with multiple sources, if appropriate, but 
only one can be designated as the primary source.

When this association is made, the opportunity appears under the Campaign Track Results tab in the 
Opportunities view with the Sourced from Marketing flag checked.

Associating an Order with a Campaign
To associate an order with a campaign, you use the Campaign field on the order form to select the 
campaign name.

Using Campaign Explorer
You can use the Campaign Explorer view in Siebel Marketing and Siebel Campaigns to monitor 
subcampaigns, contacts, activities, and offers for each campaign. The left pane of this view contains 
an explorer and the right pane shows the details of the selected campaign.

You can use the detail list to add folder items. For example, to add an activity, you select the Activity 
folder in the left pane, and the Activities list appears on the right. Then, from the list, you add a new 
activity record.

To review campaign elements

1 Use the step in the following list that applies to your product:

■ In Siebel Marketing, navigate to the Campaigns screen > Explorer view.

■ In other Siebel applications, navigate to the Campaign Management screen > Explorer view.

2 In the Campaign Explorer, expand the folders for each campaign to display subfolders of 
campaign elements.

3 Click a folder to display detail of the subcampaign, contacts, activities, and offers in the list on 
the right.

To add items to folders

1 Use the step in the following list that applies to your product:
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■ In Siebel Marketing, navigate to the Campaigns screen > Explorer view.

■ In other Siebel applications, navigate to the Campaign Management screen > Explorer view.

2 In the Campaign Explorer, expand the campaign item to show its subfolders.

3 Click a subfolder.

4 In the details list, add a new record and complete the fields.

Loading Customers in Campaigns
When you load a campaign, the campaign members are added to the campaign history by loading 
segments and lists (as well as any names added manually using the user interface). For information 
about segments, see �Marketing Segments and Segment Trees� on page 35.

The following types of lists are used by Siebel Marketing and Siebel Campaigns:

■ External lists. You can import purchased or rented lists into your Siebel system using List 
Management. When you use List Management with Siebel Data Quality you can scrub lists for 
duplicates during the import process. For details, see �Importing and Managing External Lists� on 
page 147.

■ Internal lists. You can also use List Management to maintain lists created from records that 
already exist in your contacts or prospects databases. For details, see �Creating and Managing 
Internal Lists� on page 159.

■ D&B lists. D&B lists are generated from D&B libraries of companies based on criteria you define. 
The D&B module provides a library of incorporated businesses that you can market to. Using the 
D&B screen you can create a list of D&B contacts to use in your campaign. For details, see the 
chapter about D&B in Applications Administration Guide.

To load customers in a campaign, you perform the following tasks:

■ Associating a List of Prospects or Contacts with a Campaign on page 125

■ Adding Contacts and Prospects to a Campaign Individually on page 126

■ Viewing Campaign Contacts and Prospects on page 127

■ Loading Campaigns on page 127

Associating a List of Prospects or Contacts with a 
Campaign
This topic discusses associating an imported (or purchased) list and an internal list of prospects or 
contacts with a campaign.
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When you associate a purchased list with a campaign, you import the list, and then associate the list 
with a campaign. Prospects will only be visible in the Campaign Contacts list if you successfully 
import the purchased list before associating it with a campaign. If contacts or prospects are added 
to a list after you associate that list with a campaign, you need to suspend the wave that did not 
include the new customers and load the campaign again.

CAUTION: If you associate an empty list (a list prepared for import but not yet imported) with a 
campaign and then import the list, the prospects are not associated with the campaign and are not 
visible in the Campaign Prospects list.

After you associate a list with a campaign, you will not immediately see data in the Contact/Prospect 
List. You must load the campaign before the members are added to the campaign history. The list is 
populated after the Marketing Campaign Load workflow process runs, and you may need to refresh 
the browser view to see the newly associated names. For more information, see Siebel Marketing 
Installation and Administration Guide. 

Use the following procedure to associate available imported or internal lists of contacts and prospects 
with your campaigns. Before you associate a list with a campaign, make sure that the Siebel Server, 
the Object Manager component, and Workflow Process Manager component are running.

NOTE: Only active campaign lists can be associated with a campaign.

To associate a list of prospects or contacts with a campaign

1 Use the step in the following list that applies to your product:

■ In Siebel Marketing, navigate to the Campaigns screen.

■ In other Siebel applications, navigate to the Campaign Management screen.

2 In the Campaign list, drill down on the campaign name.

3 Select the Design view tab. 

4 In the Design link bar, click Segments\Lists.

5 Click the Add List button.

6 In the Add Lists dialog box, select the list you want and click OK.

NOTE: When you associate a campaign list with a campaign, contacts in that list are associated 
with the campaign. If you change the campaign list to be inactive or if you delete it, the contacts 
still appear in the Contacts/Prospects list for that campaign.

Adding Contacts and Prospects to a Campaign 
Individually
In addition to loading a campaign from segments, lists, or both , you can add individual contacts and 
prospects to a campaign. The ability to add or delete contacts and prospects can be controlled in the 
Execution Options view by using two flags (Enable Contact Editing and Enable Partner Editing of 
Contacts). If these flags are checked, the New and Delete buttons will be available. The buttons are 
available in Siebel Campaigns in the Campaign Administration views, but not the other Campaign 
views. For more information, see �Setting Up Campaign Execution Options� on page 100. 
Siebel Marketing User Guide Version 7.7126 ■



Planning and Designing Marketing Campaigns ■  Loading Customers in Campaigns
After you add a list of contacts and prospects, all contacts and prospects in the list appear in the 
Campaign Contacts or Prospects view. From this view, you can also add contacts and prospects one 
at a time. For more information, see Chapter 8, �List Management.�

To add a contact or prospect to a campaign

1 Use the step in the following list that applies to your product:

■ In Siebel Marketing, navigate to the Campaigns screen.

■ In other Siebel applications, navigate to the Campaign Management screen.

2 In the Campaigns list, drill down on the campaign name.

3 Click the Execute view tab. 

4 In the Execute link bar, click All Contacts/Prospects.

The list of available contacts or prospects appears, with information on the selected contact or 
prospect record displayed in the Contact or Prospect Details form.

5 In the Contacts or Prospects list, add a new record. 

6 In the Contact Last Name or Prospect Last Name field, click the select button and, in the Pick 
dialog box, perform one of the following actions:

a Select an existing record, and click OK.

b Click New to create a new contact or prospect, then type the information, and click OK.

7 In the All Contacts/Prospects Detail form, complete the fields.

Viewing Campaign Contacts and Prospects
If you have access to the campaign, you can view the assigned contacts and prospects using one of 
the following procedures.

To view marketing contacts and prospects

1 Navigate to the Campaigns screen > Campaigns List view.

2 In the Campaigns list, drill down on the campaign name.

3 In the Execute link bar, click All Contacts/Prospects.

The Contacts/Prospects list appears, showing only the assigned contacts and prospects for that 
campaign.

Loading Campaigns
After you associate your lists, segments, and segment tree cells with your campaign, you can load 
the campaign. Campaigns can be loaded from the Campaign form in any of the Campaign 
Management views or from the Campaigns list.
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To load a campaign from the Campaigns screen

1 Navigate to the Campaigns screen.

2 From the Campaigns list, drill down on the campaign name.

3 In the Campaign or Campaign Details form, click the menu button, and choose Load Campaign.

NOTE: The Load Campaign option is active only if your system administrator has given you this 
privilege using the Marketing access groups.

4 In the Load Campaign dialog box, assign the date and time for the load to start, and then click 
OK.

5 Click the Execute view tab to review the load status.

6 In the Execute link bar, perform the following steps:

a To see the history of each wave that has been loaded, click Execution Status.

b To see details of the load process, click System Tasks.

7 Click Refresh to update the load status.

Reviewing Contacts and Prospects in Active Campaigns
Sales people and contact center employees can use the Campaign Members dashboard to review the 
contacts and prospects in active campaigns. The Campaign Member views display a queue of active 
campaign contacts/prospects and a campaign summary, contact and prospect summary.

The Campaign Members screen allows each employee to view the active campaign members 
according to several levels of visibility, including the following levels:

■ My Campaign Members. Displays all campaign contacts/prospects that are specifically 
assigned to the employee's position.

■ My Group's Campaign Members. Displays all campaign contacts/prospects in campaigns 
where the employee's position is on the campaign team or campaign group

■ All Campaign Members - Outbound. Displays all campaign contacts/prospects in active, 
launched campaign waves and the campaign members that are assigned to the employee's 
organization. This view does not display any members of control campaigns.

■ All Campaign Members - Inbound. Displays all campaign contacts/prospects in active, 
launched campaign waves and the campaign members that are assigned to the employee's 
organization. This view includes members of control campaigns.

The Campaign agent views only display campaign members (contacts and prospects) that are in 
active campaigns and for which campaign waves have been launched to the contact center. Any 
waves that have not been launched by a member of the campaign team or administrator will not 
appear.
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7 Launching Programs and 
Campaigns
This section contains the following topics:

■ About Previewing and Generating Lists on page 129

■ About Launching Programs and Campaigns on page 131

■ Requirements for Launching Campaigns Manually on page 132

■ Launching Campaigns Manually on page 132

■ Launching Email and Fax Campaigns on page 133

■ Checking Campaign Launch Status on page 133

■ Suspending and Relaunching Email Campaigns on page 134

■ Using the Schedule Calendar View on page 135

■ Viewing Campaign Charts in Siebel Campaigns on page 138

■ Viewing Response Charts in Siebel Campaigns on page 142

About Previewing and Generating Lists
You can create output lists of contacts for export to a fulfillment partner or another application. Direct 
mail vendors often require specific formatting of campaign lists. When a campaign is ready for 
launching, the target list may be exported according to a flexible list format and distributed using 
FTP or email. You can define, manage, and preview the list format without the intervention of a 
system or marketing administrator. Default formats can be assigned for each vendor.

You can preview a sample of the list to determine if the output file layout is what you want and then 
generate the actual distribution list that will be sent to vendors.

After a list has been generated, the records in it will not change even when the contacts and 
prospects who meet the segmentation criteria change. If you modify the members of the campaign, 
you should regenerate the list files using the latest data.

Lists can be generated manually using the List Distribution view in the Campaign screen or 
automatically scheduled as part of a scheduled launch of a program stage or stand-alone campaign.

This section contains the following topics:

■ Previewing a List on page 130

■ Manually Generating a Campaign List on page 130
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Previewing a List
Prior to launching a campaign, you can use a preview list format to verify the data for the members 
of the associated segments. To generate this preview file, your Export List Format should be built so 
that it exports data from same data source where the campaign load data will also be extracted. 
Typically, this will be the Siebel Data Warehouse or another data mart or data warehouse where the 
segment members are extracted during campaign load.

To generate a preview list

1 Verify that an export list format exists and meets the requirements stated in this section.

2 Navigate to the Campaigns screen.

3 In the Campaign list, drill down on the campaign name.

4 Click the Execute view tab.

5 In the Execute link bar, click List Distribution.

6 In the Vendor list, click New. 

7 Using the vendor select button, select a vendor.

8 Using the Export List Format select button, select one or more export list formats. 

NOTE: Select the list format that you created in Step 1 from the folders. 

9 Click Generate Output Lists to generate the preview file.

10 In the dialog box, select one or more waves, and then click OK.

Give the system a few minutes to process the job, and then click the Refresh button in the 
Generated Lists applet. If you want to monitor the job, in the Execute link bar, click System Tasks.

When the file is created, it appears in the Generated Lists list. If the list format has splits set up in 
the formatting, multiple files appear in the list. Refer the Content Description column to view details 
about the file contents. Drill on the list name to open it, or save it to your computer.

Manually Generating a Campaign List
The following procedure explains how to manually generate a list for a campaign.

To generate a list for a campaign

1 Navigate to the Campaigns screen.

2 In the Campaign list, drill down on the campaign name.

3 Click the Execute view tab.

4 In the Execute link bar, click List Distribution.

5 Click New to create a new list distribution entry.
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6 Select a vendor.

If the vendor has a default list format, that format name appears in the Export List Format field.

7 Click the Export List Format select button.

8 In the dialog box, select your list format from the folders. 

9 Click Generate Output Lists to generate the file.

10 Give the system a few seconds or minutes to process, and then click the Refresh button in the 
Generated Lists applet. If desired, the System Tasks view under Execute tab to monitor the job.

11 When the file is created, it will appear in the Generated Lists list. If the list format has splits set 
up in the formatting, multiple files will appear in the list. Refer the Content Description column 
to view details about the file contents. Drill on the list name to open it, or save it to your 
computer.

About Launching Programs and 
Campaigns
When you launch a campaign, the Server Request Broker starts the Marketing Campaign Launch 
workflow process. This process automatically sends contact list files to specified vendors, most 
commonly using FTP (file transfer protocol), and email offers are sent to targeted recipients.

You can launch a marketing program in the following ways:

■ Launch a campaign manually. You can launch a campaign using the campaign form menu in 
any of the campaign views or by right-clicking on the campaign object in the program flow. For 
more information about manual execution, see �Launching Campaigns Manually� on page 132.

■ Launch a program stage automatically. You can schedule a stage of a program to launch 
automatically (including all the campaigns in the stage) from the Program screen. In the 
Schedule view tab, click the Calendar link. For more information about automatic execution, see 
�Using the Schedule Calendar View� on page 135.

■ Launch a campaign automatically. You can schedule a campaign to launch automatically from 
the Campaign screen. In the Schedule view tab, click the Calendar link. 

Email campaigns are launched through the Siebel Email Marketing Server. Export list files, wireless 
offers, and faxes are distributed through the Siebel Communication Server. Make sure that your 
Email Marketing Server and Communication Server are online so that the launch completes 
successfully.

When you launch a campaign, you must know which campaign wave or waves you want to launch, 
especially if your campaign is a recurring campaign. In most cases, the wave you want is the most 
recent wave. However, when you launch the campaign, make sure that you select the correct wave 
from the Launch Waves dialog box.

NOTE: On the Marketing Server component, a parameter called Wave Batch Size determines the 
number of subwaves created. Each subwave creates a new request or thread to the email sending 
daemon.
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For email campaigns, the Email marketing server can process parallel tasks for improved scalability.   
To enable the generation of email files for each thread, be sure to split the Email Server list format 
correctly. 

Requirements for Launching Campaigns 
Manually
Before launching a campaign manually, make sure you have performed the following tasks:

■ Add a position to the marketing Administrators Access Group. The position of the person who 
launches the campaign must be a member of the Marketing Administrators access group. If the 
position is not part of this access group, the launch buttons will be unavailable. For instructions, 
see Siebel Marketing Installation and Administration Guide.

NOTE: This also applies to a partner using the Siebel Partner Portal.

■ In the Campaign List Distribution view, set up vendors and export list formats.

■ Load any segments, segment tree cells, and lists that you plan to use into the campaign history.

■ If you plan to send offers that use a distribution profile, test the campaign to make sure that the 
profile is set up correctly and that offer is sent with expected results. For more information on 
testing campaigns, see �About Testing Campaign Offers� on page 115.

Launching Campaigns Manually
You may choose to manually launch one or more waves of a campaign. You can launch a campaign 
using the applet menu on the campaign form in any of the campaign views or by right-clicking on 
the campaign in the program flow.

After performing tasks in �Requirements for Launching Campaigns Manually,� you are ready to launch 
the campaign. Launching a campaign calls the Marketing Campaign Launch workflow process. After 
launching a campaign, you can check the results by looking at history records for programs, stages, 
and campaigns.

To manually launch campaigns 

1 Navigate to the Campaigns screen.

2 In the Campaigns list, drill down on the campaign name.

3 From the campaign form menu, choose Launch Campaign.

The Launch Campaign Dialog Box contains the valid waves that are available for launching. 
Waves with a status of Loading, Load Failed, Scheduled, Launched, Purged, or Purge Failed are 
not shown.

4 In the Launch Campaign dialog box, select the wave or waves you want to launch, and click OK.
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Launching Email and Fax Campaigns
If you have tested your email or fax campaign, and the results are satisfactory, you are ready to send 
the email offers to campaign recipients. 

To send email and fax offers

1 Use the step in the following list that applies to your product:

■ In Siebel Marketing, navigate to the Campaigns screen.

■ In other Siebel applications, navigate to the Campaign Management screen.

2 In the Campaigns list, select the campaign.

3 Drill down on the campaign name.

4 Click the Design view tab.

5 In the Campaigns form, click the menu button, and select Launch Campaign.

6 In the Launch Waves dialog box, select the wave that you want to send, and click OK.

Checking Campaign Launch Status
Navigate to the System Tasks view to check the status of the campaign launch. If campaign launch 
fails, you can view an error log using the Administration - Server Management screen�s Tasks view.

To monitor campaign launch status

1 Navigate to the Campaigns screen.

2 In the Campaigns list, drill down on the campaign name that you launched.

3 Click the Execute view tab.

4 In the Execute view link bar, click System Task.

5 In the System Tasks list, search for the Campaign Launch and Wave Launch jobs. 

Use the Wave # field to find the wave that you launched. 

6 In the System Tasks list, click Refresh to update the values in the record.

When the launch process completes, the status indicator turns green. If the launch encounters an 
error, the status indicator turns red and the error message appears in the System Tasks and Task 
Log lists.

NOTE: Scroll down to see the Task Log list.
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Suspending and Relaunching Email 
Campaigns
A wave of a campaign can be suspended and relaunched in the event of an error or need to roll back 
a wave. For example, if email offers fail to be delivered due to a setup problem in the Email Marketing 
Server, you can relaunch the wave to resend the offers.   Also, if you launch a wave into the call 
center, you can recall the wave so that it no longer appears to sales agents until the wave is 
relaunched.

To suspend a campaign wave

1 Navigate to the Campaigns screen.

2 In the Campaigns list, drill down on a campaign name.

3 Click the Execute view tab. 

4 In the Execute link bar, click Execution Status.

5 Locate the Wave with a Launched or Launch Failed status.

Use the Wave # field to confirm that you are viewing the correct wave.

6 To suspend the wave, select the wave record and click Suspend Wave.

7 After the wave is suspended, Suspended appears in the Status field. 

Make the necessary corrections to the system and then relaunch the campaign wave.

To relaunch a suspended campaign wave

1 Navigate to the Campaigns screen.

2 In the Campaigns list, drill down on the campaign name that you want to relaunch.

3 Click the Execute view tab.

4 In the Execute link bar, click Execution Status.

5 Locate the Wave that you want to relaunch.

Use the Wave # field to confirm that you are viewing the correct wave.

6 In the Wave list, select the wave record, and click Launch Wave.

Launching a suspended wave resends any email offers, wireless offers, and vendor list files. It 
also causes the campaign members in the wave to reappear in the call center.
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Using the Schedule Calendar View
When you complete a program design using Program Flow, you can schedule a stage of the program 
for automatic execution using the Schedule calendar view. During automatic program execution, the 
Campaign Load and Marketing Campaign Launch workflow processes run for each campaign in the 
stage. If the stage is recurring, when the run of the stage is completed, it reschedules itself 
automatically for the next run. For more information about workflow processes, see Siebel Business 
Process Designer Administration Guide.

The Schedule view displays the details of the selected program in the Program form at the top and 
a calendar at the bottom.

Scheduling a Stage Execution
Use the following procedure to schedule stages of a program for automatic execution.

To schedule the execution of a stage

1 Navigate to the Programs screen.

2 In the Programs list, drill down on the program name.

3 Click the Schedule view tab.

4 In the Calendar view, click the calendar icon for the date that the program will start.

5 In the activity form, complete the fields using Table 24 on page 135 as a guide.

6 Select the Active Flag so that the scheduling will take effect.

If you select the active flag, the stage executes as soon as the activity time arrives. If you do 
not select the active flag, no execution occurs.

7 Click Save This One when you are ready to save the schedule.

The stage name and launch time appear in the Schedule calendar. The calendar also reflects any 
recurrence of the stage.

Table 24. Activity Fields for a Stage Execution

Field Comment

Comment Type additional information about the program schedule, if desired.

Description This field automatically displays the previously added program description. Type 
additional information if desired.

Frequency If the program is repeating, choose the repeat cycle from the list. Options are 
Daily, Weekly, Monthly, Quarterly, and Yearly.

Planned 
Completion

The default value in this field is the program�s end date. Click the calendar select 
button, use the calendar controls to set the date and time.
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To edit the schedule

1 Navigate to the Programs screen.

2 In the Programs list, drill down on the program name.

3 Click the Schedule view tab.

4 In the Schedule�s calendar, drill down on the program name.

Make sure the Active Flag is still checked so that execution will occur.

5 In the Schedule form, make changes, and click Save This One. 

To delete a schedule

1 Navigate to the Programs screen.

2 In the Programs list, click the Schedule view tab.

3 In the Schedule�s calendar, drill down on the program name to open the Schedule form.

4 Click the menu button, and choose Delete This One.

If the stage repeats over time, you will be asked if you want to delete a single instance or every 
repeating instance.

Scheduling the Execution of a Campaign
Do not perform this procedure if you already plan to automatically schedule the parent stage for the 
same campaign. Doing so will cause the campaign to be launched twice.

To schedule the execution of a campaign:

1 Navigate to the Campaigns screen.

2 In the Campaign list, drill down on the campaign name.

3 Select the Schedule view tab.

Planned Start The default value in this field is the program start date. Click the calendar select 
button, and use calendar controls to set the start date and time for program 
execution.

Stage (Required) You must select the stage of the program that should execute.

Type (Required) The Type field displays Stage Execution as the default. If Marketing 
Program does not appear in the field, select it from the list.

Until If the stage repeats over time and you want to delete every repeating instance, 
choose Delete All.

Table 24. Activity Fields for a Stage Execution

Field Comment
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4 In the Schedule calendar, click the calendar icon in the day that the campaign will start.

5 In the activity form, in the Activity Type field, select Campaign Load and complete the remaining 
fields using Table 24 on page 135 as a guide.

NOTE: Be sure to check the Active Flag for the scheduling to take effect. If the active flag is set, 
the campaign load will launch as soon as the activity time arrives. If the active flag is not set, no 
execution will occur.

6 Click Save This One when you are ready to save the schedule.

The campaign name and load time appear in the Schedule calendar. The calendar also reflects 
any recurrence of the activity.

7 Click New to create another activity. 

8 In the activity form, in the Activity Type field, select Campaign Launch and complete the 
remaining fields using Table 24 on page 135 as a guide.

Make sure to set the start time of the campaign launch activity so that the preceding campaign 
load activity will be complete before the corresponding campaign launch begins.

9 Verify that the Active Flag is set so that the scheduling will take effect.

10 Click Save This One when you are ready to save the schedule.

The campaign name and launch time appear in the Schedule calendar. The calendar also reflects 
any recurrence of the activity. 

Understanding the Marketing Campaign Launch 
Workflow Process
When you launch a campaign, the Marketing Campaign Launch workflow process initiates. For more 
information about workflow processes, see Siebel Business Process Designer Administration Guide.

The exported list file is sent to each vendor in the List Distribution list of the Waves view, using 
distribution adapters and profile information. For example:

■ Email. The exported list file is emailed to the vendor�s primary contact.

■ FTP. Each vendor has a profile specifying the host name, user name, and password. The exported 
list file is sent using File Transfer Protocol to the vendor�s FTP server.

For each wave, the server receives a request to send each valid offer in the campaign on the day the 
program is executed, adding to that date any lag days defined in the wave. Only those contacts or 
prospects assigned to a particular wave will receive the offer.
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Viewing Campaign Charts in Siebel 
Campaigns
Campaign charts are used only by Siebel Campaigns and allow you to review performance and 
graphically display results in a chart for areas such as incentive compensation, completed calls, lead 
quality by campaign, and so on. When you view a chart, the saved query in the upper-right corner 
filters the information shown in the chart.

This section contains the following topics:

■ Viewing a Campaign Achievement Chart on page 138

■ Viewing a Call Status Analysis Chart on page 139

■ Viewing a Call Status Analysis by Employee Chart on page 139

■ Viewing a Lead Quality Analysis by Campaign Chart on page 140

■ Viewing a Lead Quality Analysis by Response Chart on page 140

■ Viewing an Opportunity Revenue Analysis Chart on page 141

■ Viewing an Opportunity Revenue Analysis by Employee Chart on page 141

■ Viewing an Order Revenue Analysis Chart on page 141

■ Viewing a Campaign Trend Analysis Chart on page 142

■ Viewing a Trend Analysis by Employee Chart on page 142

Viewing a Campaign Achievement Chart
The Campaign Achievement chart displays the results of the Sales Quota Plan set up for each 
campaign. The chart represents the percent achievement of quota for each campaign and applies 
Incentive Compensation functionality to campaigns.

Perform the following tasks before viewing campaign achievement charts.

1 Create a quota plan, and associate quota plan objectives and participants with the plan. 

Quotas are discussed in �Creating Campaign Quota Plans� on page 107. For more information, see 
Siebel Incentive Compensation Administration Guide.

2 Type achievement values by performing these tasks:

a Navigate to the Sales Quotas screen.

b In the Quota Achievement list, select the quota plan.

c Type the amount you achieved compared to quota numbers. 

Achievements may be added manually or by using a workflow process that automatically 
completes achievements based on actions in Siebel Call Center. 

You can view the Campaign Achievement Chart from the Achievement Analysis view of the Sales 
Quota screen or the Charts view of the Campaigns screen.
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To view Campaign Achievements in Siebel Campaigns

1 Navigate to the Campaigns screen.

2 In the Campaigns link bar, select Charts.

3 In the drop-down list, select Campaign Achievements.

4 In the Objects Against Achievement list, select the plan name.

5 In the By drop-down list, select Campaign Name or Objective Name.

6 Select the chart type from the third drop-down list.

7 Click Go to display the chart.

Viewing a Call Status Analysis Chart
The Call Status Analysis chart displays the number of calls that have been completed compared to 
the number of calls that have not been completed for each campaign. This chart can be used by a 
call center manager to determine which campaigns are lagging and where to shift resources. 

Perform the following tasks before creating the Call Status Analysis chart:

1 Assign any contacts and prospects you will be contacting to the campaign.

For details, see �Adding Contacts and Prospects to a Campaign Individually� on page 126.

2 After each contact or prospect is called, update the status in the Call Status field in the Contacts 
or Prospects list or form.

The chart is based on information from this field�a Call Completed flag indicates that the call is 
completed�and the number of contacts and prospects targeted by the campaign. 

Viewing a Call Status Analysis by Employee Chart
The Call Status Analysis by Employee chart displays completed and uncompleted calls by a specified 
employee for each campaign. The values for this chart may be derived from lists of contacts and 
prospects assigned to the position and the Calls Completed field for the contact or prospect record 
in the Contacts or Prospects view.

A campaign list can be associated with a position. When such association occurs, the position 
becomes the owner of the Campaign Contacts or Campaign Prospects. If the OwnerID is assigned, 
then only the employees of that position can view the Campaign Contacts or Prospects for a 
particular campaign. If the list is not assigned, then the OwnerID is NULL and all employees assigned 
to the Campaign Team or Campaign Group can see the Contacts or Prospects view.

Perform the following tasks before generating the Call Status Analysis by Employee chart.
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1 If the employee position will be evaluated based on lists of contacts and prospects, assign the 
lists to the position in the Campaign Lists view. 

The position becomes the owner of the list�s contacts and prospects.

When you associate a list with a campaign, if the Position field is not empty, then the OwnerID 
or each contact or prospect in that list is associated with that position. 

Most companies do not assign the contacts or prospects to a position, so the OwnerID is NULL. 
In such cases, the chart shows only one employee: Unknown. 

2 Update call status in the Campaign Contacts view. 

The chart draws its values on which contacts have been called based on the Done flag in the Call 
Status field. Make sure this field reflects the current status of the call.

Viewing a Lead Quality Analysis by Campaign Chart
The Lead Quality Analysis by Campaign chart displays the opportunities that have been created for 
the campaign when the Response Type is set to Opportunity. Using this chart, you can display 
opportunities by number of opportunities, by total opportunity revenue, or by average opportunity 
broken out by lead quality.

Perform the following tasks before viewing the chart:

■ In the Campaigns list, drill down on the campaign name, click the Responses view tab, and verify 
that the Response Type field is set to Opportunity. 

■ In the Opportunities screen, for each opportunity created for a campaign, make sure values are 
typed in the Revenue, Lead Quality, and Source fields. 

You can use the My Opportunities or All Opportunities views to see the opportunities you need to 
check.

Viewing a Lead Quality Analysis by Response Chart
The Lead Quality by Response chart displays the opportunities that have been created for a campaign 
when the campaign�s Response Type is set to Response. The chart displays opportunities by number 
of opportunities, by total opportunity revenue, or by average opportunity broken out by lead quality.

Perform the following tasks before generating the chart:

1 In the Campaigns list, make sure the Response Type is set to Opportunity.

The Response Type field is in the Response�s view tab, after drilling down on the campaign name.

2 In the Opportunities screen, make sure that the Revenue, Lead Quality, and Source fields are 
completed for each opportunity.
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Viewing an Opportunity Revenue Analysis Chart
The Opportunity Revenue Analysis chart displays the campaign�s Number of Opportunities and the 
Expected Revenue for those Opportunities. The left axis is Opportunity Revenue and the bar chart 
corresponds to Revenue. The right axis is the Number of Opportunities and the line chart corresponds 
to Revenue. 

When using the chart, Opportunity Revenue Analysis by Campaign, only campaigns set to response 
type Response are used to create the chart.

This chart allows you to view the relationship between the amount of revenue and the number of 
opportunities for campaigns. For example, a campaign administrator might use the chart to identify 
campaigns that are generating a high volume of opportunities but have a low potential for revenue 
and campaigns which generate a smaller number of opportunities but have a higher potential 
revenue per opportunity.

Before generating the chart, navigate to the Opportunities screen and make sure that, for each 
opportunity associated with the campaign, the Revenue field contains a value.

Viewing an Opportunity Revenue Analysis by Employee 
Chart
The Opportunity Revenue Analysis by Employee chart shows the number of Opportunities and the 
potential revenue for opportunities for each employee. It displays information in the same way as 
the Opportunity Revenue Analysis chart, but targets employees in the analysis.

Perform the following tasks before generating the chart:

1 Navigate to the Opportunities screen.

2 Select an opportunity associated with the campaign.

3 Make sure that the Revenue contains a value.

4 In the Sales Team field, type the User ID of the agent generating the opportunity.

Viewing an Order Revenue Analysis Chart
The Order Revenue Analysis Chart shows the total revenue for orders generated by campaign.

Perform the following tasks before generating the chart:

1 Navigate to the Campaigns screen. 

2 Select a Campaign with the Response Type set to Response. 

NOTE: This chart only shows data for campaigns with Response Type set to Response.

The Response Type field is in the Response�s view tab, after drilling down on the campaign name.

3 Drill down on the campaign name.
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4 Click the My Contacts/Prospects view tab.

5 Click Create Response.

6 For this response, click the Orders tab and create a new record.

7 Click the Order number to type details for the order.

Viewing a Campaign Trend Analysis Chart
The Campaign Trend Analysis chart displays the total number of responses for each campaign over 
a period of time. The period can be set to day, week, month, quarter, or year. 

Before generating the chart, review responses for each campaign by navigating to the Campaigns 
view, selecting the campaign, and clicking the Responses view tab.

Viewing a Trend Analysis by Employee Chart
The Campaign Trend Analysis chart displays the total number of responses generated by each 
employee across campaigns over a period of time. The period can be specified by day, week, month, 
quarter, or year. 

Perform the following tasks before generating the chart:

1 Navigate to the Campaigns screen. 

2 In the Campaigns list, drill down on the Name.

3 Click the Track Results view tab.

4 In the Track Result link bar, click Responses.

5 Review the list of responses, making a note of the description and user.

6 Navigate to the Responses screen.

7 For each response you found in Step 5, make sure that the Created By field contains the User ID 
of the employee who handled the response and, therefore, owns it.

Viewing Response Charts in Siebel 
Campaigns
Siebel Marketing and Siebel Campaigns include response charts. Response charts allow you to 
analyze response to your campaigns in areas such as opportunities, revenue, campaign offers, and 
so on. When you view a chart, the saved query in the upper-right corner filters the information shown 
in the chart.

This section contains the following topics:

■ Campaign Analysis (Response) on page 143
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■ Viewing an Opportunity Analysis (Response) Chart on page 143

■ Viewing an Offer Analysis (Response) Chart on page 144

■ Viewing an Offer Type Analysis (Response) Chart on page 144

■ Viewing an Offer Type Analysis (Response) by Campaign Chart on page 144

■ Viewing a Revenue Analysis (Response) Chart on page 145

■ Viewing an Average Opportunity Revenue Analysis (Response) Chart on page 145

To access Response charts

1 Navigate to the Responses screen > Charts view.

2 In the Charts view use the visibility filter to select the type of data you want to display.

3 In the drop-down list below the Show field, select the type of chart and click Go.

To change the type of chart, select a different type and click Go.

Campaign Analysis (Response)
The Campaign Analysis chart displays the total number of responses for each campaign.

Perform the following tasks before generating the chart:

1 Navigate to the Responses screen.

2 In the Campaign Name field, associate the response with a campaign.

Viewing an Opportunity Analysis (Response) Chart
The Opportunity Analysis chart displays the total number of opportunities created for each campaign, 
based on the Source field in the opportunity record.

Perform the following tasks before generating the chart:

1 Navigate to the Responses screen.

2 For each response to your campaign, verify that opportunities are created (if applicable).

To create an opportunity for the campaign

1 Select the response record in the Responses list.
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2 In the Response form, click Create Opportunity.

An opportunity is created for the campaign and the campaign name is typed in the Source field 
for the opportunity.

Viewing an Offer Analysis (Response) Chart
The Offer Analysis chart shows the total number of responses per offer based on the offer associated 
with the response. 

Perform the following tasks before generating the chart:

1 Navigate to the Responses screen.

2 For each response to campaigns featuring the offer, make sure the correct offer is associated with 
the response by reviewing the response record�s Offer field.

Viewing an Offer Type Analysis (Response) Chart
The Offer Type Analysis chart displays the total number of responses for each offer type across all 
campaigns.

Perform the following tasks before generating the chart:

1 Confirm that each offer associated with the campaign has an offer type and offer name specified. 
For information about finding or completing these fields, see �Creating an Offer� on page 52.

2 Add the responses received during the campaign. 

The offer is identified for the response in the Offer Name field.

3 Generate the chart, using the procedure on �Viewing Response Charts in Siebel Campaigns� on 
page 142.

Viewing an Offer Type Analysis (Response) by 
Campaign Chart
The Offer Type Analysis by Campaign chart displays the total number of responses per offer type for 
each campaign. Each campaign can have many offers.

Perform the following tasks before generating the chart:

1 Confirm that each offer associated with the campaign has an offer type and offer name specified. 
For information about finding or completing these fields, see �Creating an Offer� on page 52.
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2 Confirm that the offers you want in the chart have been added to the campaign. For information 
about this procedure, see �Associating Offers with a Campaign� on page 96.

3 Type responses during the campaign.

4 Generate the chart, using the procedure on �Viewing Response Charts in Siebel Campaigns� on 
page 142. 

Viewing a Revenue Analysis (Response) Chart
The Revenue Analysis (Response) chart displays the total revenue for each campaign and the total 
number of opportunities for each campaign. The bar chart shows the revenue by campaign and the 
line graph shows the number of opportunities for each campaign.

Values for this chart are derived from the Revenue and Source fields in the Opportunity screen�s My 
Opportunities or All Opportunities list. The revenue number is derived from the sum of the Revenue 
fields in the Opportunity records, with the Source field set to the campaign name. Before generating 
this chart, make sure to complete these fields for opportunities used in this analysis.

Viewing an Average Opportunity Revenue Analysis 
(Response) Chart
The Average Opportunity Revenue Analysis chart displays the average revenue for each campaign. 
For each opportunity created for the campaign, the revenue is added and the average is taken across 
opportunities created for the campaign. 

Values for this chart are derived from the Revenue and Source fields in the Opportunity screen�s My 
Opportunities or All Opportunities list. The revenue number is derived from the average of the 
Revenue fields in the Opportunity records, with the Source field set to the campaign name. Before 
generating this chart, make sure to complete these fields for opportunities used in this analysis.
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8 List Management
The List Management module is available to users with a license for Siebel Marketing or Siebel 
Campaigns. 

NOTE: The Siebel Campaigns module can be added to any base application, including Siebel Sales, 
Siebel Call Center, and Siebel PRM.

List Management allows you to create and manage lists of contacts and prospects within Siebel 
applications for use in marketing campaigns. A list in Siebel Marketing is a grouping of contact or 
prospect records in the Siebel database.

Contacts are customers already in the Siebel database. Prospects are potential customers that have 
yet to be screened, qualified, and promoted to contacts. By using this distinction, List Management 
allows you to eliminate prospects that do not qualify for promotion to contacts.

For example, you rent a magazine subscriber list containing 1,000 names and addresses. You want 
to contact these people, but because the list is rented, you may not add the records into your Siebel 
database as contacts unless they become customers generating revenue. You must be able to 
remove the names from your database when you return the list. Siebel List Management allows you 
to identify these names and addresses as prospects until they can be promoted to contacts. 

To create, manage and maintain lists, perform the following tasks:

■ �Importing and Managing External Lists� on page 147. List Management allows you to import any 
external file of customer names and their associated contact and profile information.

■ �Creating and Managing Internal Lists� on page 159. You can use List Management to create and 
maintain lists created from records that already exist in your Siebel database.

■ �Promoting Prospects� on page 164.

■ �Viewing and Maintaining Lists� on page 168.

■ �Integrating List Management with D&B� on page 171. For customers who have licensed Siebel Dun 
& Bradstreet Integration Solution for Siebel Sales or another Siebel application, List Management 
allows you to use lists of prospects generated from the D&B source data in marketing campaigns.

Importing and Managing External Lists
External lists are created by importing an external file into your Siebel application using the List 
Import utility. Imported lists can come from any source, as long the list can be saved in one of the 
supported file formats, including Comma Separated, Tab Delimited, and Fixed Width. Common 
examples of list sources include rented or purchased lists from marketing bureaus, registration lists 
from trade shows or events, and output lists from other applications.
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When you integrate Siebel Marketing or Siebel Campaigns with Siebel Data Quality (optional 
module), incoming records can be cleansed and matched against all existing contacts and prospects 
in the database. This additional process helps prevent creation of duplicate records for incoming 
prospects that are already contacts. For information about Siebel Data Quality, see Siebel Data 
Quality Administration Guide.

To import and manage external lists, perform the following tasks:

■ Prerequisites for Importing External Lists on page 148

■ Importing External Lists on page 150

■ Launching Import Requests and Tracking the Import Status on page 154

■ Importing Campaign and Response Data on page 155

■ Maintaining Attributes for List Records on page 156

■ Mapping Fields on page 157

■ Using List Import Formats on page 157

■ Editing the List Import Format Settings on page 158

■ Understanding Import Status and Error Messages on page 159

Prerequisites for Importing External Lists
Before importing a list, you need to perform the following tasks:

■ Verifying Status of Server Components and Tasks on page 148

■ Verifying Data Quality Settings on page 149

■ Validating the Structure of the Incoming Data on page 150

Verifying Status of Server Components and Tasks
Before importing a list, you need to verify that server components are enabled and that server tasks 
are running.

To enable server components and run tasks, you use the Administration - Server Configuration 
screen, Components view. For more information, see the Siebel System Administration Guide.

Make sure that the following server components are enabled and the following server tasks are 
running:

■ List Import Service Manager: Enabled.

Clicking Launch Import in the List Import view tab of the List Management screen submits the 
import request. The actual import is performed by the List Manager server component on the 
Siebel Server. 

■ Server Request Processor: Running.

■ Server Request Broker: Enabled or running.
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To import a list, you must be connected to the Siebel Server. If the Siebel client cannot detect a 
running Siebel Server at the time you launch the import, you will receive a warning message. You 
can continue to submit the import request if you are sure that a Siebel Server will be available to 
handle the request later. 

For the request to be queued, you must have a Siebel Gateway Name Server running in the 
background. The request will be routed through the gateway name server to a Siebel Server that has 
the List Import Service Manager server component enabled. If you do not have a gateway name 
server running, you will receive an error message saying �Unable to connect to gateway name 
server.�

Verifying Data Quality Settings
When you use the optional Data Quality module, you should verify your settings for the following 
server components before importing files:

■ Data Quality Manager.

■ List Import Service Manager.

■ The object manager for the application in which your users promote prospects. For example, if 
you promote prospects using Call Center, you need to enable the Call Center Object Manager.

If you need to enable a server component, see Siebel Marketing Installation and Administration 
Guide. For more information about data quality configuration, see Siebel Data Quality Administration 
Guide.

1 Verify that these server components are set to Enabled.

2 Verify the component parameters for these server components are set for deduplication and data 
cleansing.

■ If you want to enable Data Matching, use the Components view in the Administration - Server 
Configuration screen and query for each of these server components. Click the Component 
Parameters view tab and query for the DeDuplication parameters. The DeDuplication Enable 
Flag should be set to TRUE.

■ If you want to enable Data Cleansing during import, query for the Data Cleansing 
parameters. The Data Cleansing Enable Flag should be set to TRUE.

3 Verify the matching threshold for List Import. The Match Threshold setting in the Data Quality 
Settings view of the Data Administration screen determines if an incoming name is considered a 
match with existing data. To specify a different threshold for List Import than the rest of the Data 
Quality module, navigate to the Components view of the Administration - Server Configuration 
screen and select the List Import Service Manager. Click Component Parameters and query for 
Dedup Threshold. Set the value to the match score threshold that you want to apply to the List 
Import utility.

CAUTION: Reboot Siebel Server before launching any import tasks so that new parameter 
values take effect.

4 Make sure that you set the Data Quality Settings in the Data Administration screen. You should 
generate and refresh the match keys for the existing contact and prospect data before importing 
any files. 
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Validating the Structure of the Incoming Data
Some columns for a prospect correspond to an LOV (List of Values) or MLOV (Multilingual List of 
Values) field in the application. Be sure that your incoming data for these columns only use values 
from the LOV or MLOV. Any nonmatching values will automatically be set to NULL in the new prospect 
record.

The date format is set by the system settings for the machine on which the Siebel Server is running. 
For date fields, you should make sure you use the correct date format that corresponds to the locale 
settings for your Siebel environment. 

Importing External Lists
Lists that you import must be in text (.txt) format. When you import a list, List Management performs 
the following tasks:

■ Loads the list names into the prospects table as individual records.

■ Allows you to set the Matching Approach and Match Resolution values so that matches between 
incoming names and existing records can be handled according to your requirements.

■ Allows you to save and reuse the file structure you develop during the import process by mapping 
the columns of the file. 

■ Controls the matching and address cleansing settings applied by Siebel Data Quality (optional 
module).

When the import is finished, the imported list and its associated contacts and prospects display in 
the List Contacts and Prospects list.

Before you can import an external list, you need to perform the following tasks:

■ Creating a Record for Importing an External List on page 150

■ Selecting Matching Approach and Match Resolution on page 151

■ Mapping External List Columns to Database Columns on page 153

Creating a Record for Importing an External List
Before you import an external list, you must create a record in your Siebel application that describes 
the list. This record tells the list import utility what file to import.

To create a record for importing an external list

1 Navigate to the List Management screen > Lists view.

2 In the Lists list, create a new record and complete the fields.

Some fields are described in Table 25.
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3 Save the record.

Selecting Matching Approach and Match Resolution
You need to specify how you want duplicates handled before importing a list. If Siebel Data Quality 
is not installed or enabled, you can elect to the use the exact match matching approach. If Data 
Quality is enabled, you can use Data Quality (intelligent matching) as the only matching approach 
or you can use Data Quality in conjunction with exact matching. For more information, see Siebel 
Data Quality Administration Guide. You can choose one of the following match resolutions:

■ Reject Import Record Mode. In this mode, if a match is detected by the matching process, 
any incoming records matching existing contacts or prospects will not be added as new records 
in the database. Instead, the matching record which already exists in the database will be 
associated with the list. Each skipped record is recorded in the List Import log file for reference.

Table 25. Fields Used to Create a List Record

Field Comments

Data Type List Import attempts to determine the format of the attached text file. Values are:

■ Fixed Width

■ Comma Delimited. If the first row of data in the file contains a comma in any 
of the field values, it is recommended that you use tab delimited format to 
make sure that the correct file format is detected.

■ Other Delimited. You can enter another character as the delimiter. If you 
attempt to add >1 character, the value will be truncated.

■ Tab Delimited

List Name (Required) This field is automatically generated when you add the record but you 
can modify the name.

List Type Automatic. The possible values are Imported, Internal and D&B. If the file type 
is incorrectly detected during attachment, you can change it.

Source The company from which the list was purchased. The company must be an 
account record in the Siebel database.
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■ Overwrite Existing Record Mode. In this mode, if a match is detected by the matching 
process, any incoming records can overwrite the existing match in the database. The columns 
that are allowed to be overwritten are set by the administrator for the List Import Format used 
by the file. To set which fields will be updated by an incoming record, navigate to the List Import 
Formats view in the List Management screen and select the Allow Field Updates check box. For 
reference, the List Import log file records all records that are updated as well as the old and new 
values for any updated fields. 

If you use Overwrite Existing Record as the matching approach and an imported field value does 
not match any value on the bounded LOV, then the application will not change the field on the 
existing prospect record (the original value is preserved).

NOTE: Update Existing Duplicates Mode only updates prospect records. It will not update contact 
records.

■ Create Additional Record Mode. In this mode, matches are detected but the incoming record 
is added to the database as new prospect without changing or overwriting the preexisting record. 
This mode allows the administrator to resolve any matches later on a case-by-case basis or by 
using the Siebel Data Quality module. To resolve duplicates, you can use the Duplicate Prospect 
Resolution view tab in the Data Quality view of the Data Administration screen. In resolve mode, 
all matches are recorded in the list import log file.

NOTE: If the matching process detects a matching contact, the match results will not appear in the 
Data Quality resolution views. This process can only display matching prospects for resolution.

To select a matching approach

1 Navigate to the List Management screen > Lists view.

2 In the Lists list, select your list.

Some fields are described in Table 26.

3 Drill down on the list name.

4 Click the List Import view tab.

5 Select the Matching Approach to indicate what method of matching you want.   

The choices are:

■ Exact Matching Only. This option uses the fields marked as Exact Match Fields in the List 
Import Format and queries for any existing contacts or prospects that exactly match the 
values from the incoming record.

■ Intelligent Matching Only. This option uses the data quality matching service to search for 
matching contacts or prospects.

■ Exact and Intelligent Match. This option uses both exact matching and data quality matching. 
The option first searches for an exact match in the existing contacts and prospects, and then 
uses intelligent matching to search for matches if no exact match is found.

■ No matching. This option disables matching for the import job.
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6 In the Match Resolution drop-down list, select the action that you want to apply. 

For more details, see �Selecting Matching Approach and Match Resolution� on page 151.

Mapping External List Columns to Database Columns
Every column in the file you want to import must be mapped to an existing column in the prospects 
table in the Siebel Database or to an attribute created for this purpose. If you import response or 
campaign data, you can also map to response and campaign fields. For information about mapping 
attributes, see �Adding Additional Attributes to a List� on page 156.

CAUTION: Make sure that you map every column before launching the import.

To map list columns to database columns in the prospect table

1 Navigate to the List Management screen > Lists view.

2 Drill down on the list name.

3 Click the List Import view tab.

4 Scroll down to the List Import Format list and map every column to an existing database column 
in the prospect table or to an attribute created for this purpose.

5 In the List Import Format list, save the format in one of the following ways:

a The first time you save a format, click Save as New.

Save as New allows you to retain the original format and save the modified format separately. 
All saved formats appear in the List Management screen�s List Imports Formats view tab. 

b Click Save to overwrite the original format.

Use this save option if you make changes to the mappings and want to preserve them.

Table 26. Fields Used for List Import View

Field Comments

Additional 
Actions

Assign to Campaigns, Responses, or Campaigns and Responses. Used 
whenever the import file contains campaign history or response data 
about contacts and prospects. For more information, see �Importing 
Campaign and Response Data� on page 155.

Cleanse Data 
During Import

A check box for which the default is off. When this flag is checked, 
incoming records are cleansed by Siebel Data Quality. If your company 
has not licensed Siebel Data Quality, this feature is not functional.

List Import 
Format

Indicates the saved column sequence for the file. Formats can be 
reused across lists. For more information, see �Using List Import 
Formats� on page 157.

List Import Mode For descriptions, see �Selecting Matching Approach and Match 
Resolution� on page 151.
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6 After you save the List Import Format, perform the following steps to verify the columns that will 
be used for matching and update.

a In the form in the List Import view, copy the name of the List Import Format in the List Import 
Format field.

b In the List Management link bar, click List Import Formats.

c Query for the name that you copied in the List Import view.

d In the lower list, you will see the columns that you mapped from the import file.

e In the Exact Match Column field, check each column from the list that you want to use for the 
exact match. 

NOTE: These settings are only used when you have selected Exact match or Exact and 
intelligent match as the matching approach.

f In the Allow Field Updates field, check any fields that you want to allow to be overwritten when 
using the Overwrite existing record match resolution.

Launching Import Requests and Tracking the Import 
Status
After creating a list record, identifying the Matching Approach and Match Resolution, and mapping 
list columns to database columns, you can import the list and track the status of the request.

To launch a list import request

1 Navigate to the List Management screen > Lists view.

2 Drill down on the list name.

3 Click the List Import view tab.

4 In the List Import form, click Launch Import.

Track the Status of an Import Request
After you submit the import request, the status field on the List Import list contains a value of In 
Progress. You can refresh this view to track the status of your request. When the import is finished, 
the status field contains a value of Successfully Completed.

There are three methods that can used to view the status and details of an import job:

■ During the import process, end users and administrators can review the List Import task status 
in the System Tasks view of the Administration - Marketing screen.

■ Administrators can also view the log details for the List Import server task in the Components 
view in the Server Management Administration screen. In the Component Tasks list, select tasks 
for the List Import Service Manager.

■ Administrators can also review List Import log files stored in the Siebel Server file system.
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Importing Campaign and Response Data
List Import can be used to import campaign and Response Data about contacts and prospects. For 
example, your company might run a campaign against a target list of contacts, but collect the 
responses in an external system or through an outside service company. You can import the response 
results from these sources and attribute the responses to the original campaign.

The List Import view provides the following additional actions that you can select in the Additional 
Actions field to include response and campaign data in the file:

■ Assign to Campaigns. This action will add the contacts and prospects in the import file to the 
campaign included in the file. This action will not create any response data.

■ Assign to Responses. This action will create response records for all the contacts or prospects 
in the list. The action will not add, delete, or modify the set of contacts and prospects already 
associated with the campaign.

■ Assign to Campaigns/Responses. This action will take contacts and prospects records from 
the import file, add them to the campaign, and create responses for them.

Campaign and response data will not be created unless you select one of these additional actions, 
even if you mapped response or campaign fields. If you do not select an additional action, the import 
utility ignores response and campaign columns and only creates a list of contacts and prospects.

Mapping Response and Campaign Fields
The List Import view includes the following response and campaign fields for mapping import data:

Response fields. Fields are Response Description (required), Response Type (required), Response 
Method, Response Status, Response Date, Response Score, Offer Name (required), Offer Code, and 
Offer Language.

Campaign fields. Fields are Campaign Name (required) and Campaign Source Code.

When mapping, response and campaign fields, be sure to map all the fields required to create a 
response in the application. The import provides some default values if the user does not include all 
the required fields.

■ If you do not specify Offer Name, the response defaults to the primary offer for the campaign.

■ If you do not specify Response Type, the type defaults to Unclassified Response.

■ If you do not specify Response Description, the type defaults to Imported Response.

If you enable the response business service that performs automatic lookups for Campaign Source 
Code and Offer Code, you can map the Campaign Source Code and Offer Code fields as an alternative 
to Campaign Name and Offer Name. In this case, the import utility performs the lookup and defaults 
to the related Campaign Name and Offer Name automatically. For more information, see �Using 
Response Management� on page 116.

NOTE: The Campaign Source Code field in the List Import mappings indicates the source code value 
assigned individually to each Campaign Contact and Prospect. It does not refer to the Source Code 
field in the Campaign record (the field displayed on the Campaign form).
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Maintaining Attributes for List Records
Prospects have a predefined set of information fields standard in the application. These are the 
standard types of information about your prospects that normally include address, phone number, 
email address, and so on. These values are defined in Siebel Tools under the Prospect Business 
Component.

If the list you want to import has attributes not contained in the standard Siebel prospect table, you 
can create additional attributes to capture the data. After they are created, additional attributes 
appear on the list of available columns that can be mapped in the List Import view. 

An additional attribute can contain any type of information, as long as it can be contained in a single 
field and can relate directly to the prospect record. For example, additional attributes might include 
hobbies, special contact information (for example, pager #), product interests, survey responses, or 
demographic attributes.

Creating Additional Attributes for List Records
In order to make an additional attribute available during list mapping, you must first make sure your 
desired attribute exists and then associate the attribute with the specific list.

To create additional attributes

1 Navigate to the List Management screen > Additional Attributes view.

2 In the Additional Attributes list, create a new record.

3 In the Additional Attribute field, type the name of the new attribute.

You can create the overall attribute type, such as Hobby or Pager #.

4 Type a description for the additional attribute, if needed.

Adding Additional Attributes to a List
After you create the additional attributes needed to capture all the data in the list you want to import, 
you must add them to your specific prospect list and map them to one of the List Import columns.

To add additional attributes to a list

1 Navigate to the List Management screen > Lists view.

2 Drill down on the list name.

3 Click the List Additional Attributes view tab.

4 In the List Additional Attributes list, create a new record.

5 In the Pick Additional Attribute dialog box, select the attribute, and click OK.
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Mapping Fields
After you import a list, you must map the fields in the imported list to the fields in the Prospect 
Business Component. When you do this mapping, the values in the list fields are transferred 
accurately into the correct fields in the prospect records.

When there is a dedicated column in the prospect table, you should map fields in the imported list 
to existing fields in the prospects record. Try to avoid mapping fields to additional attribute columns 
in the database extension table. When a value is stored in the main Prospect table, there is more 
flexibility to configure the location where the promoted field value should be mapped on the Contact 
record in the promotion map in the repository. Additional Attribute values can only be promoted to 
Contact Category data.

To map fields when importing a list

1 Navigate to the List Management screen

2 In the List Management link bar, click Additional Attributes.

3 Query for each attribute you want to use and verify that they exist.

4 In the List Management link bar, click Lists.

5 Drill down on the list name and click the List Additional Attributes view tab. 

6 To associate attributes with the list, in the attributes list, click New.

7 In the Pick Additional Attribute dialog box, perform the following steps:

a To create new attributes, click New, and in the attributes list, type a name and description.

b To associate predefined attributes to the list, select an attribute, and click OK.

8 Associate the attributes with the list using the List Additional Attributes tab.

9 Navigate to the List Import view tab. At the top of each column in the external list, select the 
appropriate field or attribute to which the column should be mapped. 

10 Click Save as New to save the List Import Format.

11 At the top of each column in the external list, select the appropriate prospects record attribute 
to which the column should be mapped.

12 Create additional attributes for columns in your list which have no corresponding prospect field.

Using List Import Formats
 Before you import a file, you must save the List Import Format (the sequence of columns that 
correspond to your file). The list format name consists of the list name followed by the saved date/
time stamp. For example, My Target List 09/1/2003 12:30:15pm. You can rename the list by 
navigating to the List Import Formats view and editing the record in the list. For more information, 
see �Mapping External List Columns to Database Columns� on page 153.
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To apply an existing List Import Format to your list

1 Navigate to the List Management screen.

2 Drill down on the list name.

3 Click the List Import view tab.

4 In the List Import Formats field, click the select button.

5 In the List Import Formats dialog box, select the format you wish to use. If necessary, perform 
a query to locate the format.

NOTE: You may not be able to apply an existing format to a fixed width file if the data was originally 
created for comma separated or tab delimited file. For CSV or tab delimited files, the column width 
value defaults to 20, and this value may not match the width of the fixed width file that is being used.

Editing the List Import Format Settings
You can administer the precise settings associated with your list import format. If the Import Format 
is to be used in Overwrite Existing Record match resolution, you can specify which columns are 
allowed to be overwritten in the database. You can see which columns are set to be overwritten by 
looking at the Allow Field Updates column in the lower list. If the column is checked, that field will 
be overwritten in any existing prospect record that matches the incoming record. By default, all 
columns are unchecked, so that no existing information can be overwritten without the 
administrator�s consent.

If you are using Exact Match or Exact and Intelligent Match as the matching approach, you need to 
specify the columns that should be used to perform the exact match query.   In the List Import 
Mappings list, check the box in the Exact Match Column column for each list field that you want to 
use in the exact match query.

For files with a fixed width file type, the server will automatically detect the column width and display 
the width in the List Import Formats view. To see the column width settings, from the visibility filter, 
select List Import Formats and in the List Import Formats list, select the list that relates to your list. 
If the List Import Format was originally created from a comma separated or tab delimited file, the 
value will default to 20, although the width will not have any effect during the import task.

NOTE: Columns mapped to Additional Attributes cannot be updated in Update Mode. If you check 
Allow Field Updates for this column in the List Import Formats view, the system will ignore the 
setting.

List Import can load a text file in one of three types: comma separated, tab delimited, or fixed width. 
For files with a fixed-width data type, you can specify the width of each column. The default width 
is 20. In the bottom list, you can see the column sequence that you have defined in the List Import 
list. Type the width in the Width field. 
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Understanding Import Status and Error Messages
When you launch an import task, the List Import list will display the status of the task. The status 
may show any of the following messages: Submitted Import Request, In Progress, Successfully 
Complete, Error, or Completed with Errors.

You can view the detailed results of the List Import task by reviewing the log file from the Siebel 
Server. The log file contains the following information:

■ The status of the file import task (in progress, completed, or error)

■ The number of incoming records

■ The number of records imported

■ Notification of any record that experienced an error

■ Notification of any record that detected a duplicate contact or prospect

■ Notification of any record that was updated (update mode only)

■ Notification of any response record or associated campaign that experienced an error

To view the system task for the List Import job

1 Navigate to the Administration - Marketing screen > System Tasks view.

2 Query for tasks in which the Process Name is List Import and the User is the user who submitted 
the import job.

3 Sort the tasks by date and find the task for your list import job.

To verify that the task is for the correct file, read the logging messages in the lower list.

4 In the System Tasks list, click Refresh.

To view the log file for an import task

1 Navigate to the Administration - Server Management screen.

2 In the Component list, query for List Import Service Manager in the Name field.

3 Scroll down to the Component Tasks view tab.

You will see component tasks for the import. There may be more than one task for the import 
job, based on the Max Tasks parameter for the server component. 

4 In the Component Tasks list, drill down on the Task field to view the Task Information Log.

Creating and Managing Internal Lists
List Management allows you to create lists of contact and prospect records stored within your Siebel 
applications. Internal lists are created within the List Management module by querying existing 
contact or prospect records in the database. After you have created these lists, you can reuse the 
list any number of times for campaigns. Lists are used by Siebel Marketing and Siebel Campaigns.
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To create and manage internal lists, perform the following tasks:

■ Using Prospect Lists in Siebel Marketing on page 160

■ Creating Internal Lists on page 161

■ Adding to Internal Lists on page 162

■ Creating Lists of Prospects Using Additional Attributes on page 163

Using Prospect Lists in Siebel Marketing
Marketing campaigns can include prospects in a using one of the following approaches:

■ Associating an internal list of prospects with the campaign.

■ Associating a segment from the Marketing segmentation module where the campaign load list 
format is configured to load the Marketing Prospect integration object.

To associate an internal list with a campaign

1 Navigate to the Campaigns screen > Campaign List view.

2 Drill down on the campaign Name.

3 Click the Design tab.

4 In the Design link bar, click Segments/Lists.

5 Click Add List to associate an internal list.

Repeat Step 5 if you want to associate any more lists.

6 After all the desired lists are associated, select the Menu on the upper campaign form and select 
Load Campaign to associate all the members of the list to the campaign.

7 Pick a time and date for the load request, and click OK.

Marketing campaigns can include prospects in a using one of the following approaches:

■ Associating an internal list of prospects with the campaign.

■ Associating a segment from the Marketing segmentation module where the campaign load list 
format is configured to load the Marketing Prospect integration object.

To associate a Segment of prospects with a campaign

1 In the Marketing Module, create a segment. Make sure that the Campaign Load List Format for 
the segment is configured to load data into the Marketing Prospect integration object.

2 Navigate to the Campaigns screen > Campaign List view.

3 Drill down on the campaign Name.

4 Click the Design tab.

5 In the Design link bar, click Segments/Lists.
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6 Click Add Segment to associate the segment. 

If the segment has never been used in a campaign previously, click Choose a new segment, and 
select the segment from the folder location where you saved it.

7 Repeat Step 6 if you want to associate any more segments.

8 After all the desired segments are associated, select the Menu on the upper campaign form, and 
select Load Campaign to associate all the members of the segment to the campaign.

9 Pick a time and date for the load request, and click OK.

Table 27 describes how prospects and contacts can be used in segments associated with campaigns.

Creating Internal Lists
The contacts or prospects you target for each campaign will vary depending on the campaign 
objective. For example, you might want to select all the contacts who have a certain job title or live 
in a specific ZIP or Postal code. In another campaign, you might want to combine sets of contacts or 
prospects that were selected by several different criteria into a single list.

Table 27. Scenarios for Using Segments of Contacts and Prospects in Campaigns

Scenario Data Source
Integration 
Object Comments

Segment 
contains only 
contacts.

Siebel OLAP or 
Siebel OLTP

Marketing 
Contact

Fully supported. All contacts exist in the 
Siebel transactional database, so data is 
inserted only into the S_CAMP_CON table.

Segment 
contains only 
contacts.

Non-Siebel 
database

Marketing 
Contact

Fully supported. New contacts and accounts 
(if mapped) are created in the Siebel 
transactional database.

Segment 
contains only 
prospects.

Siebel OLAP or 
Siebel OLTP

Marketing 
Person

Fully supported. All prospects exist in the 
Siebel transactional database, so data is 
inserted only into S_CAMP_CON.

Segment 
contains only 
prospects.

Non-Siebel 
database

Marketing 
Prospect

Fully supported. New prospects are created 
in the Siebel transactional database.

Segment 
contains contacts 
and prospects.

Siebel OLAP or 
Siebel OLTP

Marketing 
Person

Fully supported. All contacts and prospects 
exist in the Siebel transactional database, 
so data is inserted only into S_CAMP_CON 
and S_DD_USER_KEY tables.

Segment 
contains contacts 
and prospects.

Non-Siebel 
database

Currently not supported.
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You create an internal list of contacts or prospects in the List Management screen using the Contacts 
or Prospects view. You can also use these views to add contacts or prospects to existing lists.

NOTE: To create an internal list, your employee login must have a responsibility associated with it 
that includes the List Management views.

You can reuse lists in any number of campaigns or marketing programs.

To create an internal list of contacts or prospects

1 Navigate to the List Management screen > Contacts or Prospects view.

2 In the Contacts or Prospects list, select the individuals that you would like to include, or perform 
a query to find this information.

3 After you receive the results of your query, you can select any number of the records for inclusion 
in the list.

4 With the desired records highlighted, click Add to List.

5 In the Pick List dialog box, click Create New List.

6 In the second Pick List dialog box, type a name for the list, and click OK. 

7 In the Pick List dialog box, select the list you created and click OK.

8 To see the new list, in the List Management link bar, click Lists.

NOTE: The list type is defaulted to Internal. You can rename the list to give it a more appropriate 
reference name or type at any time.

Adding to Internal Lists
Adding to an existing internal list is similar to creating a new internal list. You can use Add to List to 
attach prospects to a list of type Internal, D&B, or Imported. You can attach prospects from the All 
Prospects list or the Prospects by Attribute list.

To add contacts or prospects to an internal list

1 Navigate to the List Management screen > Contacts or Prospects view.

2 In the Contacts or Prospects list, select the individuals that you would like to include or perform 
a query to find this information.

After you receive the results of your query, you can select any number of the records for inclusion 
in the list.

3 With the selected records highlighted, click Add to List.

4 In the Pick List dialog box, select the appropriate list, and click OK.

5 To see the new list, in the List Management link bar, click Lists.

6 Select the appropriate list, and drill down on the list name.
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7 Click the List Contacts and Prospects view tab to verify that your selected contacts or prospects 
have been added.

Creating Lists of Prospects Using Additional Attributes
You can create lists of prospects by querying the additional attribute data for all prospects. For 
example, you might create an additional attribute for hobby and then record these values for many 
of your prospects. For a campaign, you might want to create a list of prospects with certain hobbies, 
such as sailing or painting.

You can create a list of prospects by using the Prospects by Attribute list. In this list, the New Internal 
List and Add to List functions are also available. Simply query the list of all prospects using the 
appropriate attribute and attribute value. Then, highlight the desired records and either create a new 
list or add to an existing list.

Due to the many-to-many relationship between prospects and attributes, you cannot have multiple 
combinations of attributes and values in a single query. If you wish to create of a list that combines 
queries, for example Hobby = Skiing AND Preferred Language = Spanish, perform separate queries, 
and use the Add to List function to combine the results.

To create an internal list of prospects using attributes

1 Navigate to the List Management screen > Prospects by Attribute view.

2 In the Prospects by Attribute list, select one or more prospects that you would like to include in 
your internal list. 

3 With the desired records highlighted, click Add to List.

4 In the Pick List dialog box, click Create New List.

5 In the second Pick List dialog box, type a name for the list, and click Save. 

6 In the Pick List dialog box, select the list you created, and click OK.

7 To see the new list, in the List Management link bar, click Lists.

To add to an internal list using prospect attributes

1 Navigate to the List Management screen > Prospects by Attribute view.

2 In the Prospects by Attribute list, select the prospects that you would like to include in your 
internal list, or perform a query if necessary.

After you receive the results of your query, you can select any number of the records for inclusion 
in the list.

3 With your desired records highlighted, click Add to List.

4 In the Pick List dialog box, select the appropriate list, and click OK.

5 To see the new list, in the List Management link bar, click Lists.

6 Select the appropriate list, and drill down on the list name.
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7 Click the List Contacts and Prospects view tab to verify that your selected contacts or prospects 
have been added.

Creating and Managing Subscription 
Lists
You can use lists in List Management to serve as subscription lists for Email campaigns. A 
subscription list is a set of contacts or prospects that have indicated that they wish to receive 
communications about a certain topic. After creating a subscription list, you can associate the list 
with an Email Offer. Any responses to Subscribe or Unsubscribe from List will automatically add and 
remove members from this list.

Before you can create a subscription list, create an internal list of contacts, prospects, or both using 
one of the following methods:

■ The Add to List button in the List Management views

■ The Create Target List feature (Siebel Industry Applications only)

■ EIM or other custom configuration

To create a subscription list:

1 Navigate to the List Management screen > Lists view.

2 Find the list you created.

3 Change the Type to Subscription.

To associate the subscription to an email offer:

1 Navigate to the Offers screen > Email Offers view.

2 Query for the Email Offer with which you want to associate the list.

3 Drill down on the offer name, and select the Advanced tab. 

4 In the form, select the list name using the Subscription List field.

Promoting Prospects
Prospects are prospective contacts, people who have the potential to become customers or to be 
involved in a business activity in some other way. Prospects are candidates for promotion to a 
contact, an account, or an opportunity. In addition, you can configure the promotion behavior by 
modifying the promotion map in Siebel Tools. In Siebel Marketing, you can promote prospects from 
the List Management screen. In other Siebel eBusiness applications, you can promote prospects in 
views located in the List Management and Campaigns screens.

To promote prospects, perform the following tasks:

■ Promoting a Prospect to a Contact on page 165
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■ Promoting a Prospect�s Response to an Opportunity on page 167

■ Modifying the Promotion Map on page 167

Promoting a Prospect to a Contact
When a prospect satisfies a set of screening criteria, he or she can be promoted to become a contact. 
The new contact record contains the same name and address information as the prospect record. 
The additional attribute data associated with the prospect is automatically promoted to categories 
and category values for the new contact. 

NOTE: You can have duplicate contacts in the same account. For example, duplicate contacts from 
different companies might belong to the same account.

When a prospect is promoted, the application checks for the following items:

■ List Management confirms whether Data Quality deduplication is enabled. If so, the promotion 
will match the prospect against all existing contacts. If a match is found, a pop-up window 
appears showing all the matching contacts. The user can then pick or ignore the matches and 
proceed with the promotion.

■ If the user chooses an existing contact from the pop-up window, the prospect record will be 
removed and its associations with any campaigns, lists, or responses will be linked to the 
selected contact.

■ If the user ignores all the matches in the Pop-up Window, the promotion continues as if no 
match was detected.

■ If Data Quality finds no matching contact or Data Quality is not enabled, the promotion checks 
whether the combination of the Account Name and Account site fields matches an existing 
account record.

■ If the combination of the Account Name and Account Site fields match an existing account record, 
one of the following occurs:

■ If the account name is empty but an account site is specified, an account will be created using 
the prospects last name as the Account Name value.

■ If the account name exists but the account site is empty, the promotion compares with 
existing accounts that have the same Account Name and Account Site. If an identical account 
exists, the promotion will link the contact to the existing account. For the prospect address 
fields, either an update or an insert on the Account Address will be performed, based on the 
Address Name (the user key for Business Address). If there is not a match with an existing 
account, a new account will be created and the prospect personal address becomes the 
account address.

■ If no account location or account name is specified, an account will not be created or 
associated with the promoted prospect. The prospect personal address becomes the contact 
personal address.
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Promoting Multiple Prospects
You can promote multiple prospects using the Promote Many button in some views in the List 
Management screen. This action promotes any prospects for which Data Quality does not find any 
matches. 

CAUTION: Promotion is only intended for promoting relatively small numbers of prospects at one 
time (fewer than 100). If you select more prospects, the process could take many minutes to 
complete. 

Prospects that have at least one matching contact will not be promoted when you click Promote Many. 
If you do not enable Data Quality, selected prospects will be promoted to contacts.

When a prospect is promoted, a contact record is created with matching field information, and the 
prospect is removed from the list of all prospects.

To promote a prospect using the Prospects More Info view

1 Navigate to the List Management screen > Prospects view.

2 Use one of the following methods to promote prospects:

■ In the Prospects list, select a prospect record, and click Promote.

■ To promote multiple prospects, select the prospect records that you want to promote, and 
click Promote Many.

To promote a prospect using the views in the List Management screen

1 Navigate to the List Management screen > Lists view.

2 Drill down on the list name.

3 Click the List Contacts and Prospects view tab.

4 Use one of the following methods to promote prospects:

■ In the Contacts and Prospects list, select a prospect record, and click Promote.

■ To promote multiple prospects, select the prospect records that you want to promote, and 
click Promote Many.

To promote a prospect to an opportunity using views in the Campaigns screen

1 In Navigate to the Campaigns screen.

2 In the Campaigns list, select a campaign.

3 Click the Overview view tab.

4 In the Overview list, select a prospect record and click Create Opportunity.
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Promoting a Prospect�s Response to an Opportunity
A prospect that responds to a campaign offer can be promoted by promoting the response to an 
opportunity in the Responses screen. For more information, see �Promoting a Response to an 
Opportunity� on page 123.

Modifying the Promotion Map
List Management provides a default path for information to move from the prospect record to the 
contact record during promotion. Prebuilt maps specify where in the contact record prospect fields 
should be copied when a prospect is promoted. List Management provides three prebuilt maps for 
moving prospect information during promotion. Refer to Table 28.

Using Siebel Tools, you can redirect any of these prospect fields to a field associated with another 
business component. For example, you may decide that you do not want to use the Alias field for the 
prospect and would like it to hold some other information such as a Back Office Account ID. You may 
also want to promote that ID to populate a specific field on the contact record, possibly an extension 
column added to your implementation. To view or change the promotion map, in Siebel Tools, 
navigate to Business Components >List Mgmt Prospective Contact > Business Component User 
Properties.

You can see the destination business component by looking under Business Component User 
Properties for the List Mgmt Prospective Contact and searching for the Map Name in the Name 
column. The path for the map will be displayed as Destination Business Component: Source Business 
Component. For example, Contact: List Mgmt Prospective Contact.

In this case, all three default maps use the List Mgmt Prospective Contact business component as 
the source.

Table 28. Prospect Information

Map Name
Information 
Promoted

Source Business 
Component

Destination 
Business 
Component

LM Contact Map Contact related 
information such as 
First Name, Email 
Address, and Job Title

List Mgmt Prospective 
Contact

Contact

LM Account Map Account related 
information such as 
Annual Revenue and 
Line of Business

List Mgmt Prospective 
Contact

List Mgmt Account

LM Business Address 
Map

Business Address 
information such as 
City, Country, and 
Postal Code

List Mgmt Prospective 
Contact

Business Address
Siebel Marketing User Guide Version 7.7 ■ 167



List Management ■  Viewing and Maintaining Lists
To modify the promotion map, you can change a user property in the map to promote the information 
to a different field in the Destination Business Component for the map.

Alternatively, if you wish to promote user properties to a destination business component other than 
the three default maps, you might create a new map for those user properties. 

NOTE: Creating promotion mappings to promote data into a contact's multivalue field is not 
supported.

Modifying Map Entries
To insert or modify a map entry, first determine which map to use for a given set of source and 
destination fields. Then add an entry using the following syntax:

Name Column:  [MAP NAME]: [DESTINATION FIELD]

Value Column:  [SOURCE FIELD]

■ Map Name. The name of the map specified under the corresponding row in the Business 
Component User Properties.

■ Destination Field. Field in the Destination Business Component to receive source data. The 
Destination Business Component is map specific, but configurable.

■ Source Field. Field in the Source Business Component from which to extract data. Source 
Business Component is map specific, but configurable. 

Each map only works with a specific source and destination Business Component. However, users 
can make copies of the Business Components and rename them. 

To modify the source and destination Business Components of these mappings, the user must modify 
the following Business Component User Prop:

Name Column: [Map Name]

Value Column: [Destination Business Component]:[Source Business Component]

Viewing and Maintaining Lists
A list in Siebel Marketing is a group of contact or prospect records in the Siebel database. The list 
file name is assigned by Siebel Marketing in the following format:

{P or L}/[campaign source code][wave code]_[unique identifier].txt

NOTE: P stands for Preview and L stands for List.

If there is a need to influence the list�s file name, you can change the Campaign Source Code by 
modifying the Source Code Field in the Campaigns screen�s All Campaigns across Organizations view 
or change the campaign�s Wave Code in the Campaigns screen�s Waves view tab.

List Management contains several features for helping you manage your list data. 

■ Viewing Lists of Contacts or Prospects on page 169

■ Deactivating Lists on page 170
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■ Deleting Lists on page 170

■ Removing Prospects from Lists on page 170

■ Removing Contacts from Lists on page 171

Viewing Lists of Contacts or Prospects
You can view the list members and details about them in several ways. If you know the name of the 
list, you can start at the Lists view. If you want to see what other lists a contact or prospect may be 
on, you can also start at the Contacts or Prospects List view.

To view a contact or prospect list from the Lists view

1 Navigate to the List Management screen > Lists view.

2 In the Lists list, select the list record.

3 Drill down on the list name.

4 Click the List Contacts and Prospects view tab.

The List Member view shows all of the contacts or prospects on the list you selected. If the 
Contact column is checked, the person is a contact. In addition, the person�s name appears either 
in the Contact Last Name or Prospect Last Name column to further identify if the person is a 
contact or prospect.

5 Click the Last Name, and one of the following occurs:

■ If you clicked a Contact name, the Contact Detail view appears, with the Activity view tab 
selected.

■ If you clicked a Prospect name, the List Mgmt All Prospective Contacts view appears, with 
More Info view tab selected.

To view contact or prospect information from the Contacts or Prospects List view

1 Navigate to the List Management screen > Lists view.

2 From the List Management link bar, click Contacts or Prospects.

Depending on which you chose, the Prospect List view or Contact List view appears.

3 Select the record of the Contact or Prospect you are interested in.

4 Click the Last Name, and one of the following occurs:

■ If you clicked a Contact name, the Contact Detail view appears, with the Activity view tab 
selected.

■ If you clicked a Prospect name, the Prospective Contact Market Segment view appears, with 
the Prospect Additional Attributes view tab selected.
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Deactivating Lists
Many times lists are acquired from outside sources such as other companies, Web sites, and events 
such as seminars and trade shows. Because this data typically represents prospective customers who 
are not active customers, you may wish to deactivate any remaining prospects who have not been 
promoted to contacts. Additionally, lists can be generated by different users for a specific campaign 
or business situation, so you may want to keep lists active only for a specified period of time.

NOTE: To deactivate a list, change the values in the Status and Expiration Dates fields. navigate to 
the List Management screen and select the Lists view. In the Lists list, select the list you want to 
deactivate. In the Lists form, change the status to Inactive or set the expiration date. The expiration 
date is an information-only field and does not affect your use of the list.

Deleting Lists
To delete a list, navigate to the Lists view of the List Management screen and select your list from 
the Lists list. Click the menu button and select Delete Record. This action will delete the list as well 
as the association with any contact or prospect records.

NOTE: Deleting a list does not delete the contact or prospect records, because those names may 
also be used on other lists.

Removing Prospects from Lists
A prospect cannot be removed from a list using the List Contacts and Prospects view, because the 
prospect may appear on more than one list. You have more control over individual prospect lists 
when you remove the association between the prospect record and its list. If you remove all list 
associations for a prospect, the prospect record is deleted.

To remove a Prospect from a list

1 Navigate to the List Management screen > Lists view.

2 Drill down on the list name.

3 Click the List Contacts and Prospects view tab.

4 In the List Contacts and Prospects list, select the record you wish to remove, and drill down on 
the first or last name of the prospect.

5 Click the Prospect Lists tab.

6 In the Prospect Lists list, select and delete the list or lists from which you wish to remove the 
prospect.

If you select and delete all of the lists, the prospect record is also deleted.

You can also purge all prospects from a list in a single step.
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To purge all prospects from a list

1 Navigate to the List Management screen > Lists view.

2 In the Lists list, select the list record.

3 In the lower form, click Purge List.

4 When the confirmation dialog appears, click OK and then click OK again to submit the request. 

This action will remove all prospects where the Promoted By and Promoted Date are NULL 
(indicating they have never been promoted). 

5 To confirm the prospects were deleted, drill on the name of the list in the upper list applet, and 
go to the List Contacts and Prospects view tab.

Removing Contacts from Lists
Contacts can be removed from all lists, but the Contact record remains in the database.

To remove a Contact from a list

1 Navigate to the List Management screen > Lists view.

2 Drill down on the list name.

3 Click the List Contacts and Prospects view tab.

4 In the List Contacts and Prospects list, delete the record you wish to remove from the list.

Integrating List Management with D&B
List Management can be used in conjunction with Siebel Dun & Bradstreet Integration Solution to 
generate lists of prospects from the D&B dataset. Within Siebel Dun & Bradstreet Integration 
Solution, the user can perform a query on D&B accounts and generate a list of prospects from the 
results of the query. These prospects can then be targeted in a campaign and promoted to active 
contacts.

List Management uses the D&B D-U-N-S number to provide data consistency throughout this 
process. The D-U-N-S number is associated with all prospects derived from the D&B data. After a 
D&B prospect is promoted to a contact, the D-U-N-S number is used by the D&B update routine to 
continually refresh the data for those new contacts and their associated account information.

To use List Management with Siebel Dun & Bradstreet Integration Solution, perform the following 
tasks:

■ Viewing Account Data for a D&B Prospect on page 172

■ Promoting a D&B Prospect on page 172
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Viewing Account Data for a D&B Prospect
The account related to a D&B prospect may already exist as a Siebel account. You can use the 
following procedure to view account information after you promote an account from a D&B account 
to a Siebel account.

To view the account information for a D&B prospect

1 Navigate to the List Management screen > Lists view.

2 In the Lists list, drill down on the D&B list name.

3 In the List Contacts and Prospects list, drill down on the name in the Prospect Last Name field.

NOTE: Make sure you select the Prospect Last Name and not the Contact Last Name.

4 Click the More Info view tab.

5 In the Prospects list, drill down on the Matched Account Name.

The field will be blank if there is no matching account name.

Promoting a D&B Prospect
When you promote a D&B prospect to a contact, promotion checks to see if a Siebel account with 
the same D-U-N-S number exists and the following actions occur:

■ If a Siebel account exists with that D-U-N-S number, the promotion proceeds according to the 
standard promotion process in �Promoting a Prospect to a Contact� on page 165. After the 
promotion, any other prospects from that same D&B account are removed from the list.

■ If there is no Siebel account with that D-U-N-S number, the application invokes the D&B account 
promotion, which then promotes the account and all its associated contacts, industry 
information, and other information. For more information, see the chapter about D&B in 
Applications Administration Guide.

NOTE: List Management will not promote a prospect with an invalid D-U-N-S number. A D-U-N-S 
number is considered invalid if it is not contained in the D&B Accounts table.
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9 Setting Up and Using Web 
Marketing
Siebel Web Marketing is an optional Siebel Marketing module that provides you with the tools and 
templates to manage and execute Web-based marketing. It provides the Web site visitor a method 
of viewing a Web offer, downloading literature, and using preconfigured Web response forms to 
request more information or ask you to contact them by telephone.

You can modify the look and feel of Web Marketing to match your existing Web site. 

Siebel Web Marketing Web sites can be deployed in more than one language. For information about 
deploying Siebel applications in a multilingual environment, see Global Deployment Guide.

This chapter contains the following topics:

■ About Web Marketing Web Site Visitors on page 173

■ Setting Up Siebel Web Marketing on page 175

■ About the Siebel Web Marketing Web Site on page 180

■ Using the Web Marketing Offers Page on page 180

■ Using the Web Marketing Information Page on page 183

About Web Marketing Web Site Visitors
A Web site visitor can navigate to the Web Marketing home page by typing the URL or by clicking a 
hyperlink on another Web page. At this point, the user is an anonymous visitor and can choose to 
register, log in (with an existing user name and password), or continue to navigate anonymously. 
When the anonymous visitor arrives at the Web Marketing home page, the default campaign offers 
and the details for the first offer in the Featured Offers list appear. If the visitor registers or logs in, 
the visitor sees other campaign offers for which he or she is eligible. For more information about 
default offers and default campaigns, see the description of featured offers in �Using the Web 
Marketing Offers Page� on page 180.

If a contact logs in using the contact�s user ID and password, any responses generated by this 
customer are tagged with the customer�s account ID and with the associated campaign ID. For 
information about setting up users, see �Setting Up Default Responsibilities and Users for Web 
Marketing� on page 176.

Web site visitors can also navigate to the Web Marketing site by clicking an embedded URL from 
within an email offer. Only contacts or prospects receive these offers. When an email contact or email 
prospect clicks an embedded URL, the Web Offer page for this offer appears. Any responses to the 
offer from this contact or prospect are tagged with the associated campaign ID and offer ID, allowing 
marketers to track response rates for specific campaigns. For a list of responses that are captured, 
see �Response Management� on page 179.

Visitors access the Web Marketing home page in the following ways:
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■ Anonymous visitor. Any visitor can type the Web Marketing URL into a Web browser and 
navigate to your Web Marketing home page. This visitor sees no personalized Welcome message 
and responses are not captured when the visitor clicks a Recommended Product link or 
downloads literature. An anonymous visitor can create a product information or call response by 
clicking the Send Product Information or Request a Call link in the Offers page or Information 
page. The profile information that the anonymous visitor types creates a prospect record that is 
associated with the responses.

■ Email contact. When a contact clicks an embedded link in an email, your Web Marketing home 
page appears and the Contact Id is set in an anonymous session. At this point, the email contact 
is not logged in. The contact must be a registered contact and must log in to access profile 
information in the My Accounts link or to perform any other tasks that require the contact to be 
a registered contact. The email contact can generate responses by clicking a Recommended 
Product link, downloading literature, or requesting product information or a telephone call.

In the Web Marketing home page, the contact can log in. After logging in, the email contact 
becomes a logged-in contact.

If an email contact clicks the My Accounts link during an anonymous session, the User Login (user 
registration) view appears, requiring the anonymous visitor to log in before continuing.

■ Email prospect. When a prospect clicks an embedded link in an email, your Web Marketing 
home page appears, and the Prospect Id is set in an anonymous session. At this point, the email 
prospect is not logged in. The prospect must become a registered contact and must log in to 
access profile information in the My Accounts link or to perform any other tasks that require the 
prospect to be a registered contact. The email prospect can generate responses by clicking a 
Recommended Product link, downloading literature, or requesting product information or a 
telephone call.

In the Web Marketing home page, the email prospect must register as a new contact before the 
prospect can log in. In the User Login applet, the email prospect can type a user ID and password 
or click the New User link to register as a new contact and obtain a user ID and password. 

In the User Login view, the User Login (user registration) view appears, requiring the anonymous 
visitor to log in or to register as a new user before continuing. When registration is complete, the 
prospect is converted to a new logged-in contact. However, the original email prospect�s 
responses are not associated with the new contact record. After logging in, the email prospect 
becomes a logged-in contact.

NOTE: If an email prospect clicks the My Accounts link during an anonymous session, the User 
Login (user registration) view appears, requiring the anonymous visitor to log in or to register 
as a new user before continuing.

■ Logged-in contact. This contact has access to the My Account link and can perform all other 
tasks that a registered contact is eligible to perform. The logged-in contact can generate 
responses by clicking a Recommended Product link, downloading literature, or by requesting 
product information or a telephone call. These responses are associated with the contact record 
in the database.
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Setting Up Siebel Web Marketing
This section describes how to set up Siebel Web Marketing. It includes information about customizing 
the user interface, controlling user access, setting up responsibilities, and managing default 
campaigns and offers.

Before Siebel Web Marketing can be used, certain setup tasks must be performed. These include:

■ Installing Web Marketing on page 175

■ Controlling User Access to the Web Marketing Web Site on page 175

■ Setting Up Default Responsibilities and Users for Web Marketing on page 176

■ Setting Up a Default Campaign and Default Offer on page 177

■ Using Siebel Personalization with Web Marketing on page 177

■ Customizing the Web Marketing User Interface on page 177

Installing Web Marketing
Before you install and use Web Marketing, you must install the following:

■ Siebel Web Engine and related components. To deploy information on the Web and customer 
applications, you must install the Siebel Web Engine and the components on which it depends. 
These include a Web server, Siebel Gateway Name Server, and Siebel Server. For information 
about installing Siebel components, see the Siebel Server installation guide for the operating 
system you are using.

■ Siebel Applications. To perform administrative tasks such as server administration, creating 
Web offers, and managing marketing activities, you must install a Siebel employee application 
such as Siebel eSales and add the Siebel Web Marketing license key. For information about 
installing your Siebel employee application, see the appropriate administration guide, for 
example, Siebel eSales Administration Guide.

Siebel Web Marketing is an add-on module to Siebel Marketing. Siebel Web Marketing requires 
the Web Marketing Object Manager component, which is part of the Marketing Component Group. 
For information about installing Siebel Marketing, see Siebel Marketing Installation and 
Administration Guide and the Siebel Server installation guide for the operating system you are 
using.

Controlling User Access to the Web Marketing Web Site
You might want to perform some of the following tasks to control user access in your Siebel Web 
Marketing Web site:

■ Using external authentication using LDAP (Lightweight Directory Access Protocol)

LDAP is an Internet protocol that email programs use to look up contact information from a 
server.
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■ Creating database users for LDAP to use in database access

■ Defining visibility for views and products

■ Assigning a proxy employee

■ Creating users through registration or user administration

■ Associating users with accounts

■ Allowing various levels of access such as Anonymous, Implicit login, and Explicit login

■ Customizing access to home and login pages. For more information, see information about the 
New User link in �Using the Web Marketing Offers Page� on page 180.

■ Using Web Single Sign-on (SSO) functionality

■ Allowing another system to log in

■ Adding fields to registration forms

For more information on controlling user access, see Security Guide for Siebel eBusiness 
Applications.

Setting Up Default Responsibilities and Users for Web 
Marketing
Responsibilities control which views the users can see. The views to which a user has access 
determines the links and page tabs that the user sees. For example, if a user has a responsibility 
that does not permit access to the Credit Cards view, no Credit Cards link appears in the My Settings 
view. If no views within a business object are visible, the page tab that maps to that business object 
will not be visible.

The responsibilities predefined for Siebel Web Marketing include:

■ Web Anonymous User. Grants view visibility to anonymous users such as anonymous visitors, 
email prospects, and email contacts. For more information about these user types, see �About 
Web Marketing Web Site Visitors� on page 173. This responsibility allows the user to access views 
that do not have the Requires_Explicit_Login flags set to TRUE in Siebel Tools. For more 
information, see Using Siebel Tools.

■ Web Registered User. The end user of the application in a business-to-consumer model such 
as a logged-in contact. For more information about these user types, see �About Web Marketing 
Web Site Visitors� on page 173. This user has registered and is recognized by the Siebel 
application either through their login, or because the user enters the site by clicking an 
embedded link in an email offer.

■ Web Corporate User. The end user of the application in a business-to-business model. A Web 
corporate user is associated with an account and must be authorized by the Web Delegated 
Customer Administrator to access the site. A Siebel administrator can add new Web corporate 
users.

For more information about setting up and managing responsibilities, see Security Guide for Siebel 
eBusiness Applications.
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Setting Up a Default Campaign and Default Offer
Assigning a default campaign and offer is part of the Web Marketing setup process. An offer 
associated with the default campaign can be designated as the default offer. 

You specify the default campaign and default offer in the Application Administration screen in the 
System Preferences view. To assign a default campaign, complete the Default Campaign Source Code 
field. To assign the default offer, complete the Default Offer Code field. 

The default campaign and default offer determine which offers are presented to the customer during 
that customer�s Web Marketing session. These offers appear in addition to any targeted offers such 
as an embedded link in an email offer.

For more information about default offers and default campaigns, see the Featured Offers topic in 
�Using the Web Marketing Offers Page.�

Using Siebel Personalization with Web Marketing
Siebel Personalization allows you to deliver personalized content and offers to a customer profile, 
needs, interests, and history. Personalized content includes greeting users by name, presenting them 
with content targeted to their needs and interests, and showing them recommended products and 
offers based on their needs and history. 

Using Siebel Personalization, you can define rules to show and hide content dynamically during a 
user's experience with Siebel Web Marketing. Personalization deployment rules can depend on data 
such as user's profile information, date ranges, company information, products and services that 
user has already purchased or reviewed, and specific session information.

The home page in Siebel Web Marketing includes the salutation applet in the upper left corner. It 
typically includes a personal greeting, but it can be configured to deliver targeted content such as 
product promotions, announcements, birthday greetings, and offer updates. The home page also 
contains a list of recommended products and featured offers, both of which can be personalized 
based on user-specific information. Conditional expressions can be used to hide applets under certain 
conditions.

You manage personalization in the Personalization Administration screen in your Siebel Application. 
For information about administering personalization, see Siebel Personalization Administration 
Guide.

Customizing the Web Marketing User Interface
The Siebel product provides a set of Web templates and cascading style sheets (CSS) to create the 
look and feel of a Siebel application. Customers can create their own look and feel by modifying 
corporate logos, colors, and fonts in the style sheets and Web templates. When you modify these 
elements, make sure you save a backup copy in case you want to restore the original files.

NOTE: These elements are not automatically upgraded during the upgrade process.
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The Siebel Web architecture uses the Siebel Web Engine (SWE) to dynamically generate HTML pages. 
The SWE uses configuration information in the Siebel Repository (SRF) and HTML layout information 
in the Siebel Web Template (SWT) to merge data with the template when creating the HTML page.

To customize the Web Marketing User Interface, perform the following tasks:

■ Using Web Templates on page 178

■ Implementing Web Marketing Without Frames on page 178

■ Full-Text Search on page 179

■ Response Management on page 179

Using Web Templates
A Web template defines the layout and formatting elements of the user interface (UI), such as views, 
applets, and controls. These UI elements are associated with the templates by using Siebel Tools. 
The associated information is stored in the SRF file. For example, you may have a View object with 
three applets. You associate a View Template with the view, and map each applet to a placeholder in 
that template. The advantage of this approach is that the UI objects in the repository are not hard-
coded in individual templates. As a result, a number of View objects can share the same template if 
they share the same layout. The same process and design applies to applet objects.

The three primary templates types are Container, View and Applet. The final HTML pages created by 
the SWE places the applet in the view and the view in the container. Siebel eBusiness Applications 
provide numerous applet and view templates with the product. They can be viewed in Tools, but are 
edited in an external editor. For information about the physical user interface layer, see Using Siebel 
Tools. 

The following is a list of some modifications that you might want to perform to change the look and 
feel of your Web site:

■ Modifying views and applets

■ Modifying Web Templates

■ Changing colors

■ Modifying behavior caused by clicking a button

■ Adding or removing applets

■ Changing controls

■ Making fields in a form appear

For more information about customizing the user interface, see Using Siebel Tools.

Implementing Web Marketing Without Frames
Customer and partner applications use HTML frames for compatibility when running in browser-based 
applications. HTML frames allow portions of the browser window to scroll independently of the rest 
of the window. For example, you can place the navigation elements in one frame and content in 
another frame. You can scroll the content while the navigation elements remain in a fixed location.
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Customer and partner applications can be implemented without using frames. Before choosing this 
method, consider the following limitation. In an unframed application, all UI elements exist in the 
same window. Therefore, the contents list may scroll off the page as a user scrolls down. For 
example, if the user scrolls down to review content, the navigation elements might not be visible.

Full-Text Search
Siebel Search for Customers is a subset of the Siebel Search product. It allows users to scan 
database tables and documents for pertinent information. Siebel Search is included with every 
license of a Siebel application. For information about Siebel Search and Siebel Search for Customers, 
see Siebel Search Administration Guide.

Response Management
Siebel Web Marketing allows marketers to capture a series of responses during a customer 
interaction. Siebel Web Marketing supports automatic capture of the following responses:

■ Clicked on Web Offer. Captured when the recipient clicks the embedded link for a Web offer in 
an email offer.

■ Clicked on Product URL. Captured when the recipient clicks the embedded link for the product 
in an email or Web offer.

■ Clicked on Web Survey. Captured when the recipient clicks the embedded link for the Web 
survey in an email or Web offer.

■ Completed Web Survey. Captured when the recipient clicks Finish on the Web survey view. The 
survey answers are captured if the Save Answer field is checked for the question on the 
SmartScript Administration views. For more information, see Siebel SmartScript Administration 
Guide.

■ Downloaded Info/File. Captured when the recipient clicks the embedded link for the document 
that is downloaded in a Web offer.

■ Requested Unsubscribe. Captured when the recipient submits a subscription preference 
updates after clicking the embedded link in the email offer. In addition to the response, the 
contact profile is automatically updated.

■ Requested call back. Captured when the recipient submits a request after clicking the 
embedded link in an email or Web offer.

■ Requested more info. Captured when the recipient submits a request after clicking the 
embedded link in an email or Web offer.

■ Submitted Source Code. Captured when a contact or prospect types a source code and offer 
code in the Do you have Another Offer form in the Offers page.

Additional responses and Siebel events can be captured through configuration. For more information, 
see the event tracking topics in Using Siebel Tools.
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About the Siebel Web Marketing Web 
Site
The Siebel Web Marketing Web site consists of the Offers page, the Information page, and their 
related views. Using the navigation bar, you can manage your personal profile by changing 
preferences in the My Settings view.

Web visitors access the My Settings view by clicking the My Account link in the navigation bar of any 
Web Marketing page. The My Settings view has the following links that allow users and visitors to 
manage their personal profiles.

■ Address Book. A list of available addresses for the visitor. Visitors can add, delete, and modify 
their address, and the changes automatically update their information in the Siebel database.

■ Credit Cards. A list of available credit cards for the visitor. This view is not required if you do 
not implement the Siebel eSales module or if you do not want to use credit card management.

■ Subscription Preferences. A series of channel-specific and general communication preferences 
for each visitor. This view could be modified through Siebel Tools to include additional 
subscription preferences, for example by product or area of interest. These preferences could 
then be used to drive marketing activities for that visitor. This view appears when a user clicks 
on the Request Unsubscribe embedded URL in an email and a response is automatically created 
when the visitor clicks Submit. The individuals preferences are also updated automatically in the 
Siebel database.

■ User Profile. A series of user profile fields, which the user can modify. Once again, this view can 
be extended to display additional profile information.

NOTE: Notification Preferences, Lister Payment and Shipping Terms, and Auction Privilege are not 
used at this time.

Using the Web Marketing Offers Page
The default home page for Web Marketing is the Offers page. The center applet of this view contains 
the specific Web offer intended for each Web site visitor. The Offers page provides links to other 
views, including additional offers, product information, Web surveys, and account and contact profile 
information.

The Offers page has the following configurable applets:

■ Salutation. The salutation text that appears depends on the personalization rules that are 
applied for the user that accesses the page. After logging in, registered email recipients or Web 
users see a greeting customized with their names. An anonymous Web visitor�s greeting says 
�Welcome!� You can change the salutation greeting text in the Personalization Administration 
views.

NOTE: When Web Marketing is deployed as part of the eCustomer application (a bundle of 
eSales, eService and Web Marketing), the user can see the Offers page (Web Marketing home 
page) and the eCustomer home page. Because the eCustomer home page has a salutation 
greeting, the salutation greeting is suppressed in the Offers page (Web Marketing home page).
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■ The New User Link. You can set up the New User link that appears in the User Login applet to 
allow a Web site visitor to create a user ID and password for limited access to your Web Marketing 
Web site. When a visitor clicks New User on the Web Marketing home page, the registration views 
appear, allowing a visitor to complete a profile. The process is managed by a workflow business 
process that you can modify in Siebel Business Process Designer. For more information, see 
Siebel Business Process Designer Administration Guide.

NOTE: If a prospect registers, the prospect is automatically converted to a contact. After 
becoming a contact, responses captured for the prospect are not associated with the new contact 
record. For more information, see Security Guide for Siebel eBusiness Applications.

■ Web Offer. The center applet of the Offers page displays Web offer details. The applet contains 
the contents of the Web offer presented to the visitor. The Offer that appears is determined in 
the following ways:

■ The offer details are based on the Web-offer link that the visitor selects in an email.

■ The offer details are based on how Siebel Personalization sort the offers in the Featured 
Offers applet. Details for the top offer in the Featured Offers applet are automatically 
presented in the center applet.

NOTE: The Featured Offers area will be empty if no featured offers exist.

■ Recommended Products. This applet contains a list of recommended products, customized for 
each user based on that user�s Web profile attributes. This list can be modified using the 
Personalization Administration views. Unidentified users will see a default listing.

■ Featured Offers. This applet displays every Web offer for which the contact or prospect is 
eligible. When a visitor logs onto a Web site and clicks the Send Product Information or Request 
Call Back link, the response is captured for the default campaign and offer. 

Web-offer types include the following:

■ Web offers associated with the default campaign. When you specify a default campaign, the 
offers associated with that campaign appear in the Featured Offers list. The default campaign 
does not need to be loaded with campaign contacts and prospects. However, the campaign 
and associated Web offers must have active dates, and the Inbound Active flag must be 
checked.

■ Web offers associated with other active campaigns. These have been loaded with contacts 
and prospects. The offers must have active dates and the Inbound Active flag must be 
checked. Only those contacts and prospects targeted will see these Web offers in the 
Featured Offers applet.

For more information about setting the default campaign or default offer, see �Setting Up a 
Default Campaign and Default Offer� on page 177.

■ Information. This applet contains hyperlinks to the following applets in the Information page: 

■ Downloads

■ Send Product Information

■ Request a Call

For more information about these applets, see �Using the Web Marketing Information Page� on 
page 183.
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■ Do you have another offer? After the user types the offer code and source code in these 
required fields and then clicks Submit, that Web offer appears and a response is automatically 
created.

Using Web Marketing Views and Additional 
Unstructured Content
For information about Web Marketing views and content that the visitor might use, see the following 
topics:

■ Using the Web Marketing Product Detail View on page 182

■ Using the Web Marketing Web Survey View on page 182

■ Adding Unstructured Content on page 182

Using the Web Marketing Product Detail View
When a visitor responds to an offer (email or Web) by clicking an embedded product URL, a page 
with product details appears for that offer. This view displays details and incentive pricing for the 
selected offer. The price list associated with the offer determines the price shown in this view. The 
person who created the offer is responsible for associating the products and the correct price list with 
the offer. This combination determines the products that can be embedded in the offers and the price 
that appears. For more information about price list administration, see Pricing Administration Guide.

Additionally, this view contains the Related Items applet, showing products that might be of interest 
to the Web visitor. Items in the Related Items list are based on previous purchases or literature 
requests.

In addition to viewing details, the Web visitor using Siebel eCustomer may purchase the product from 
this view by clicking Add Item. After adding the product, the selected item appears in the Last Item 
Added applet.

NOTE: Checkout functionality exists only if the customer has purchased Siebel eCustomer. If you are 
not using eCustomer, the Add Item button is unavailable.

Using the Web Marketing Web Survey View
When the Web site visitor clicks an embedded URL for a Web survey in an email or Web offer, a survey 
wizard appears that navigates the user through a series of questions about the product. Survey 
results can be automatically stored and then analyzed and used for future marketing activities. Web 
surveys are administered using Siebel SmartScripts. For more information, see Siebel SmartScript 
Administration Guide.

Adding Unstructured Content
Siebel Web Marketing has the ability to display general external and unstructured content in the Web 
Marketing site using the Microsite Management module. For more information, see Applications 
Administration Guide.
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Using the Web Marketing Information 
Page
The Information page allows Web site visitors to download product information and request more 
information. The visitor can reach this page clicking the Information page tab. The Information page 
contains the following applets:

■ Downloads. Clicking a hyperlink opens the literature using the default viewer for that type of 
literature. The visitor can sort this list or search for any specific literature item by name, 
description, type, or date.

■ Request More Information. Allows visitors to request product information (Send Product 
Information) and request a telephone call (Request a Call) using response forms. For more 
information about this applet, see the following topics:

■ Using the Web Marketing Send Product Information View on page 183

■ Using the Web Marketing Request a Call View on page 183

Using the Web Marketing Send Product Information View
The Send Product Information view displays a form that Web site visitors can complete to request 
that product information be sent to them.

This view can be accessed from the Offers and Information pages or as an embedded URL link in an 
email offer or a Web offer. The Available Products area lists products for which additional information 
is available. This is determined by Catalog visibility. For additional information, see Product 
Administration Guide.

When the Send Product Information or Request Call Back views are accessed using an offer�s 
embedded URL, the list of products is restricted to the products associated with the offer. The user 
can browse the list, selecting products of interest, and then move the items to the Selected Products 
list by clicking Add.

A visitor can request information about the one or more items in the Selected Products list by 
selecting the check boxes. To clear an item from the list, choose a Selected Product item, and then 
click Remove. After the Web site visitor chooses the products for which he or she wants more 
information, the visitor clicks Continue to move to the delivery form. In the delivery form, the Web 
site visitor can choose direct mail, email, fax, or phone as the delivery method, and then fill in the 
necessary information for the delivery method. When the visitor clicks Submit, the Confirmation view 
appears listing the products for which the visitor requested information and the delivery information. 
This information is stored as a response of the type Requested More Info.

Using the Web Marketing Request a Call View
The Request a Call view allows the Web site visitor to request a callback about one or more products. 
This view can be accessed from the Offers or Information pages or as an embedded URL in an email 
offer or a Web offer. When accessed from an email or Web offer, the products available are limited 
to those products associated with the offer. When accessed from the Offers or Information pages, 
the products are limited by Catalog visibility.
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Requests for a telephone call are initiated in the same way as requests for product information, using 
Available and Selected product lists. After the visitor chooses the products that he or she wants to 
discuss in a callback, the visitor clicks Continue to move to the Request Call form. There the visitor 
provides a phone number, the time of day to call, and adds comments. When the visitor clicks 
Submit, a Confirmation appears containing a list of products for which the visitor requested a 
callback and a list of call preferences. This information is stored as a response of the type Requested 
Call Back.
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A Assigning Character Sets for the 
Email Marketing Server
If you want to change the character set used for outbound emails, then you need to add a parameter 
to the Email Marketing Server profile that will be used for the outbound email campaign. The 
parameter you need to add or change is Character Set and the value will be one of the values from 
the right column of Table 29.

To assign the character set for the Email Marketing Server configuration, use the following 
guidelines:

■ Navigate to the Administration - Marketing screen > Servers view. 

■ Query for records of type Email Marketing Server. 

■ Select an email server and add a new parameter type with the name Character Set. 

■ Set the parameter value to the value of the character set to which you want to send the email 
offer.

NOTE: You need to upload a document that is saved on your disc as UTF-8, but which can be 
represented in this configured character set.

When the Communications Server processes an email request for a campaign, it identifies the 
character set and locale of the first offer, changes to that offer's character set and locale, and 
processes that offer and all associated offers using that character set and locale.

Table 29 identifies the name of the character set used in an email campaign. For more information, 
see �Applying Globalization Rules to Offers� on page 54.

Table 29. Character Set Values Used in Email Campaigns

Encoding
Character 
Set Name Also Known As

Vendor/Standard 
Body

Character Set 
Value 
(Unicode)

CP10004 Arabic Macintosh Arabic Microsoft & IBM CP10004

CP1256 Arabic  Microsoft & IBM CP1256

CP20420 Arabic (With full-width Latin 
and punctuation)

Microsoft & IBM CP20420

CP28596 Arabic Arabic Alphabet (ISO) Microsoft & IBM CP28596

CP720 Arabic Transparent ASMO Microsoft & IBM CP720

CP864 Arabic  Microsoft & IBM CP864

ISO 8859-6 Arabic ISOLatinArabic International or 
National Standard

Arabic

CP708 Arabic ASMO708 Microsoft & IBM CP708
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CP1257 Baltic  Microsoft & IBM CP1257

CP28594 Baltic Baltic Alphabet (ISO) Microsoft & IBM CP28594

CP775 Baltic  Microsoft & IBM CP775

ISO 8859-4 Baltic Latin4 International or 
National Standard

Latin4, ISO-
8859-4

ISO 8859-13 Baltic Latin7 International or 
National Standard

Latin7, ISO-
8859-13

ISO 8859-14 Celtic Latin8 International or 
National Standard

ISO-8859-14

CCSID 935 Chinese, 
Simplified

 IBM CCSID-935, 
CCSID935

EUC-CN Chinese, 
Simplified

GB2312, EUC-SC UNIX GB2312

GB2312 Chinese, 
Simplified

EUC-CN, EUC-SC International or 
National Standard

GB2312

HZ-GB-2312 Chinese, 
Simplified

HZ-GB-2312 International or 
National Standard

HZ, HZ-GB-2312

CP936 Chinese, 
Simplified 

GBK Microsoft & IBM CP936, GBK

MacChinese 
Simplified

Chinese, 
Simplified 

 Macintosh MacChinese 
Simplified

CCSID 937 Chinese, 
Traditional

 IBM CCSID-937, 
CCSID937

CNS-11643-
1986

Chinese, 
Traditional

EUC-TW International or 
National Standard

CNS-11643-1986

CNS-11643-
1992

Chinese, 
Traditional

EUC-TW International or 
National Standard

CNS-11643, 
CNS-11643-1992

EUC-TW Chinese, 
Traditional

CNS-11643-1986, 
CNS-11643-1992

UNIX CNS-11643, 
CNS-11643-1992

GB12345 Chinese, 
Traditional

 International or 
National Standard

GB12345

Big5 Chinese, 
Traditional 

 International or 
National Standard

Big5

CP10002 Chinese, 
Traditional 

Macintosh Traditional 
Chinese

Microsoft & IBM CP10002

Table 29. Character Set Values Used in Email Campaigns

Encoding
Character 
Set Name Also Known As

Vendor/Standard 
Body

Character Set 
Value 
(Unicode)
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CP950 Chinese, 
Traditional 

 Microsoft & IBM CP950

MacChineseTr
aditional

Chinese, 
Traditional 

 Macintosh MacChineseTradit
ional

MacCroatian Croatian  Macintosh MacCroatian

CP10007 Cyrillic Macintosh Cyrillic Microsoft & IBM CP10007

CP1251 Cyrillic MS Windows Cyrillic 
(Slavic)

Microsoft & IBM CP1251

CP20866 Cyrillic Cyrillic Alphabet, 
KOI8-R

Microsoft & IBM CP20866

CP20880 Cyrillic (with fullwidth Latin & 
punctuation)

Microsoft & IBM CP20880

CP21025 Cyrillic (with fullwidth Latin & 
punctuation)

Microsoft & IBM CP21025

CP21866 Cyrillic Ukranian KOI8-RU Microsoft & IBM CP21866

CP28595 Cyrillic Cyrillic Alphabet (ISO) Microsoft & IBM CP28595

CP855 Cyrillic IBM Cyrillic Microsoft & IBM CP855

CP866 Cyrillic MS DOS Russian Microsoft & IBM CP866 

ISO 8859-5 Cyrillic ISOLatinCyrillic International or 
National Standard

ISOLatinCyrillic

MacCyrillic Cyrillic  Macintosh MacCyrillic

MacDevanaga
ri

Devanagari  Macintosh MacDevanagari

CP10006 Greek Macintosh Greek 1 Microsoft & IBM CP10006

CP1253 Greek  Microsoft & IBM CP1253

CP20423 Greek (with fullwidth Latin & 
punctuation)

Microsoft & IBM CP20423

CP28597 Greek Greek Alphabet (ISO) Microsoft & IBM CP28597

CP737 Greek  Microsoft & IBM CP737

CP869 Greek IBM Modern Greek Microsoft & IBM CP869

ISO 8859-7 Greek ISOLatinGreek International or 
National Standard

Greek

MacGreek Greek  Macintosh MacGreek 

Table 29. Character Set Values Used in Email Campaigns
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MacGujarati Gujarati  Macintosh MacGujarati

CP10010 Gurmukhi Macintosh Gurmukhi Microsoft & IBM CP10010

MacGurmukhi Gurmukhi  Macintosh MacGurmukhi

CP10005 Hebrew Macintosh Hebrew Microsoft & IBM CP10005

CP1255 Hebrew  Microsoft & IBM CP1255

CP28598 Hebrew Hebrew Alphabet 
(ISO)

Microsoft & IBM CP28598

CP38598 Hebrew ASCII + Hebrew and 
private use characters

Microsoft & IBM CP38598

CP862 Hebrew  Microsoft & IBM CP862

ISO 8859-8 Hebrew ISOLatinHebrew International or 
National Standard

Hebrew

CP10079 Icelandic Macintosh Icelandic Microsoft & IBM CP10079

CP861 Icelandic MS DOS Icelandic Microsoft & IBM CP861

MacIcelandic Icelandic  Macintosh MacIcelandic

CCSID 1027 Japanese EBCDIK Microsoft & IBM CCSID-1027, 
CCSID1027

CCSID 290 Japanese EBCDIK Microsoft & IBM CCSID-290, 
CCSID290

CCSID 930 Japanese  IBM CCSID-930, 
CCSID930

CCSID 939 Japanese  IBM CCSID-939, 
CCSID939

CCSID 942 Japanese  Microsoft & IBM CCSID-942, 
CCSID942

CP10001 Japanese Macintosh Japanese Microsoft & IBM CP10001

CP20290 Japanese (full/half width Latin & 
halfwidth katakana)

Microsoft & IBM CP20290

CP21027 Japanese (halfwidth Latin, 
halfwidth 
katakana&private use)

Microsoft & IBM CP21027

EUC-JP Japanese  UNIX EUC-JP, EUC-J

Table 29. Character Set Values Used in Email Campaigns
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ISO-2022-JP Japanese  International or 
National Standard

ISO-2022-JP

JIS_X_0201 Japanese HalfWidthKatakana International or 
National Standard

JIS_X_0201

JIS_X_0208 Japanese  International or 
National Standard

JIS_X_0208 

MacJapanese Japanese  Macintosh MacJapanese

Shift-JISMS Japanese MS_Kanji, CP932 Microsoft & IBM Shift-JIS, SJIS

Shift-JIS78 Japanese Shift-JIS without MS/
IBM extensions

UNIX/Macintosh Shift-JIS78, 
SJIS78

CP10003 Korean Macintosh Korean Microsoft & IBM CP10003

CP1361 Korean Korean Johab (based 
on KSC 5861-1992)

Microsoft & IBM CP1361

CP949 Korean  Microsoft & IBM CP949

EUC-KR Korean KS_C_5861-1992 UNIX EUC-KR, EUC-K

ISO-2022-KR Korean KS_C_5601-1987 International or 
National Standard

ISO-2022-KR

Johab Korean  International or 
National Standard

Johab

KS_C_5601-
1987

Korean ISO-2022-KR International or 
National Standard

ISO-2022-KR

KS_C_5861-
1992

Korean EUC-KR International or 
National Standard

KS_C_5861-
1992

MacKorean Korean  Macintosh MacKorean

CP10000 Latin Macintosh Roman Microsoft & IBM CP10000

CP10029 Latin Macintosh Latin2 Microsoft & IBM CP10029

CP10082 Latin (with mathematical 
symbols)

Microsoft & IBM CP10082

CCSID 1047 Latin EBCDIC (for IBM Open 
Systems platform)

Microsoft & IBM CCSID1047

CP20261 Latin (with private use 
characters)

Microsoft & IBM CP20261

CP20269 Latin  Microsoft & IBM CP20269
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CP20273 Latin (with fullwidth Latin & 
punctuation)

Microsoft & IBM CP20273

CP20277 Latin (with fullwidth Latin & 
punctuation)

Microsoft & IBM CP20277

CP20278 Latin (with fullwidth Latin & 
punctuation)

Microsoft & IBM CP20278

CP20280 Latin (with fullwidth Latin & 
punctuation)

Microsoft & IBM CP20280

CP20284 Latin (with fullwidth Latin & 
punctuation)

Microsoft & IBM CP20284

CP20285 Latin (with fullwidth Latin & 
punctuation)

Microsoft & IBM CP20285

CP20297 Latin (with fullwidth Latin & 
punctuation)

Microsoft & IBM CP20297

CP20833 Latin (with fullwidth Latin & 
punctuation)

Microsoft & IBM CP20833

CP20871 Latin (with fullwidth Latin & 
punctuation)

Microsoft & IBM CP20871

CP28591 Latin ASCII + Latin accented 
vowels

Microsoft & IBM CP28591

CP28593 Latin Latin 3 Alphabet (ISO) Microsoft & IBM CP28593

CP850 Latin MS DOS Multilingual, 
MS-DOS Latin1

Microsoft & IBM CP850

CP870 Latin (with fullwidth 
punctuation)

Microsoft & IBM CP870

ISO 8859-1 Latin Latin1 International or 
National Standard

Latin1, ISO-
8859-1

ISO 8859-15 Latin Latin1 + Euro symbol 
& accented characters

International or 
National Standard

ISO-8859-15

ISO 8859-2 Latin Latin2 International or 
National Standard

Latin2, ISO-
8859-2

MacRoman Latin  Macintosh MacRoman

NextStep Latin  Apple/Next NextStep
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Adobe-
Standard-
Encoding

Latin (used in PS printers) Other Corporate Adobe-Standard-
Encoding

CP863 Latin, 
Canadian 
French

MS DOS Canadian 
French

Microsoft & IBM CP863

CP28592 Latin, 
Central 
European

Central European 
Alphabet (ISO)

Microsoft & IBM CP28592

MacCentralEur
opean

Latin, 
Central 
European

 Macintosh MacCentralEurop
ean

CP1250 Latin, 
Eastern 
Europe

 Microsoft & IBM CP1250

CP20905 Latin, 
Esperanto

(with fullwidth Latin & 
punctuation)

Microsoft & IBM CP20905

CP860 Latin, 
Portuguese

MS DOS Portuguese Microsoft & IBM CP860 

ISO 8859-3 Latin, 
Southeast 
European

Latin3 International or 
National Standard

Latin3, ISO-
8859-3

ASCII Latin, US 
English

US-ASCII, CP367 International or 
National Standard

ASCII

CP037 Latin, US 
English

EBCDIC Microsoft & IBM CP037

CP1026 Latin, US 
English

EBCDIC Microsoft & IBM CP1026

CP1252 Latin, US 
English

MS Windows Latin1 
(ANSI)

Microsoft & IBM CP1252

CP20105 Latin, US 
English

US ASCII Microsoft & IBM CP20105

CP437 Latin, US 
English

MS-DOS Latin US Microsoft & IBM CP437

CP500 Latin, US 
English

EBCDIC Microsoft & IBM CP500 
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CP875 Latin, US 
English

EBCDIC Microsoft & IBM CP875

CP10017 Malayalam Macintosh Malayalam Microsoft & IBM CP10017

CP865 Nordic MS DOS Nordic Microsoft & IBM CP865

ISO 8859-10 Nordic Latin6 International or 
National Standard

Latin6, ISO-
8859-10

MacRomanian Romanian  Macintosh MacRomanian

CP852 Slavic MS DOS Slavic Microsoft & IBM CP852

Adobe-
Symbol-
Encoding

Symbol (used in PS printers) Adobe Adobe-Symbol-
Encoding

Adobe-Zapf-
Dingbats-
Encoding

Symbol (used in PS printers) Adobe Adobe-Zapf-
Dingbats-
Encoding

CP10008 Symbol Macintosh RSymbol 
(Right-left symbol)

Microsoft & IBM CP10008

MacDingbats Symbol  Macintosh MacDingbats

MacSymbol Symbol  Macintosh MacSymbol

CP20838 Thai (with fullwidth Latin & 
punctuation)

Microsoft & IBM CP20838

CP874 Thai IBMThai Microsoft & IBM CP874

ISO 8859-11 
(draft)

Thai ISOLatinThai International or 
National Standard

Thai

MacThai Thai  Macintosh MacThai

CP10081 Turkish Macintosh Turkish Microsoft & IBM CP10081

CP1254 Turkish  Microsoft & IBM CP1254

CP28599 Turkish Turkish (ISO) Microsoft & IBM CP28599

CP857 Turkish IBM Turkish Microsoft & IBM CP857

ISO 8859-9 Turkish Latin5 International or 
National Standard

Latin5, ISO-
8859-9

MacTurkish Turkish  Macintosh MacTurkish

MacUkrainian Ukranian  Macintosh MacUkrainian
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BMP Unicode  Unicode BMP, 
Unicode20:big-
endian

Java Unicode Way of representing 
Unicode characters in 
ASCII

Sun Java, 
Unicode20:BOM:
Java, 
Unicode11:Java, 
Unicode11:BOM:
Java

UCS2 Unicode ISO-10646-UCS2, 
UTF16

Unicode UCS2, Unicode, 
Unicode20:UCS2

Unicode Big-
endian

Unicode  Unicode big-endian, 
Unicode20:big-
endian, 
Unicode11:big-
endian, 
Unicode11:BOM:
big-endian

Unicode Little-
endian

Unicode  Unicode little-endian, 
Unicode20:little-
endian, 
Unicode11:little-
endian, 
Unicode11:BOM:l
ittle-endian

Unicode11-
UCS2

Unicode  Unicode Unicode11-UCS2, 
Unicode11:UCS2, 
Unicode11:BOM:
UCS2

Unicode11-
UTF7

Unicode  Unicode Unicode11-UTF7, 
Unicode11:UTF7, 
Unicode11:BOM:
UTF7

Unicode11-
UTF8

Unicode  Unicode Unicode11-UTF8, 
Unicode11:UTF8, 
Unicode11:BOM:
UTF8

UTF7 Unicode  Unicode UTF7, 
Unicode20:BOM:
UTF7
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UTF8 Unicode  Unicode UTF8, 
Unicode20:BOM:
UTF8

UTF-EBCDIC Unicode  Unicode UTF8-EBCDIC, 
UTF-8-EBCDIC

CP1258 Vietnames
e

 Microsoft & IBM CP1258
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Index
A
activity plans, creating and using

about 87
activity plan and activities, associating to a 

campaign or program 88
activity plan template, creating 87
activity plan template, creating activities 

for 88
programs and campaigns, associating activity 

plans with 88
activity templates

activities, creating for 88
activity plan template, creating 87

actual expenses and revenue, about and 
fields 14

Assignment Manager
assignment skill rules, about using 111
campaign contacts, automatically assigning 

owners to 106
multiple assignment skills, associating with a 

campaign 112
assignment skills, deleting 113
attachments

document to marketing plan 16
documents to programs and campaigns 90
email offers, adding to 67
Web offers, adding to 81

attributes
See also individual attribute entries
internal list, adding using prospect 

attributes 163
list of prospects, about creating using 

attributes 163
list of prospects, creating using attributes 

(procedure) 163
automatic execution of a stage

scheduling (procedure) 135
automatic execution of programs

about scheduling 135
marketing campaign workflow process, 

understanding 137
schedule, deleting 136
schedule, editing 136

automatic response
See response management, using

Average Opportunity Revenue Analysis 
(Response) chart, viewing 145

awards
campaign quota objective, assigning 

to 109
new awards, creating 110

C
call guides

call guide, creating 78
phone offers, creating for 78

Call Status Analysis chart, viewing 139
Call Status by Employee chart, 

viewing 139
Campaign Achievement chart

Siebel Campaigns, viewing in 139
steps before viewing 138

Campaign Analysis (Response) chart, 
viewing 143

campaign assignment skills, setting up
about 111
assignment skills and all its campaign skill 

items, deleting 113
campaign skill items, deleting 113
multiple assignment skills, associating with a 

campaign 112
skill items, associating with a skill 112

campaign charts
Call Status Analysis chart, viewing 139
Call Status by Employee chart, 

viewing 139
Campaign Achievement chart, steps before 

viewing 138
Campaign Achievements, viewing in Siebel 

Campaigns 139
Campaign Trend Analysis chart, 

viewing 142
Lead Quality Analysis by Campaign chart, 

viewing 140
Lead Quality by Response chart, 

viewing 140
Opportunity Revenue Analysis by Employee 

chart, viewing 141
Opportunity Revenue Analysis chart, 

viewing 141
Order Revenue Analysis chart, viewing 141
Trend Analysis by Employee chart, 

viewing 142
types of charts 138
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campaign contacts, automatically assigning 
owners to 106

campaign data
importing 155
mapping fields 155

campaign elements, reviewing 124
campaign execution options, setting up

about setting up 100
campaign contacts, automatically assigning 

owners to 106
Campaign Explorer

campaign elements, reviewing 124
folder, adding items to 124

campaign groups
about 98
groups, adding to a campaign 100

campaign quotas, setting up
about and process 107
campaign quota plan, assigning 

participants 111
new awards, creating 110
quota objective values, editing 109
quota objective, assigning predefined awards 

to 109
quota plan, adding quota objectives to 108
quota plan, creating 108

campaign skills, defined 111
campaign teams, working with

about 98
groups, adding to a campaign 100

Campaign Trend Analysis chart, 
viewing 142

campaign, setting up in Siebel Marketing
campaign, associating campaign elements 

with 95
execution options, setting up 101
team, assigning to a campaign 99

campaigns
 See also segment count, allocating to 

campaigns; waves; multistage 
recurring campaign

about 86
campaigns timeline, about 89
contacts or prospects, adding to 127
documents, attaching to 90
list, adding to a campaign 31
marketing campaign workflow process, 

understanding 137
new campaign with offer, defining 29
note, determining which program is using a 

campaign 29
opportunity, creating for 143
planning suggestions 91
predefined campaigns with associated offers, 

adding 29
using in Siebel Marketing

about 85
Campaigns Opportunity, using to promote a 

prospect 166
campaigns, launching

See also automatic execution of programs
campaign launch status, monitoring 133
email campaign, suspending and 

relaunching 134
manually launching campaigns 

(procedure) 132
manually launching campaigns, 

requirements 132
marketing program, launching 131

campaigns, setting up
new campaign, creating 92
offer, associating with a campaign 96
related event, associating with a 

campaign 96
SmartScript, setting up 97

campaigns, setting up in Siebel Marketing
campaign, associating offers with 96
creating (procedure) 92

charts
Average Opportunity Revenue Analysis 

(Response) chart, viewing 145
Call Status Analysis chart, viewing 139
Call Status by Employee chart, 

viewing 139
Campaign Achievement chart, steps before 

viewing 138
Campaign Achievements, viewing in Siebel 

Campaigns 139
Campaign Analysis (Response) chart, 

viewing 143
campaign charts, about 138
Campaign Trend Analysis chart, 

viewing 142
Lead Quality Analysis by Campaign chart, 

viewing 140
Lead Quality by Analysis chart, 

viewing 140
Offer Analysis (Response) chart, 

viewing 144
Offer Type Analysis (Response) by Campaign 

chart, viewing 144
Offer Type Analysis (Response) chart, 

viewing 144
Opportunity Analysis (Response) chart, 

viewing 143
Opportunity Revenue Analysis by Employee 

chart, viewing 141
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Opportunity Revenue Analysis chart, 
viewing 141

Order Revenue Analysis chart, viewing 141
response charts, about viewing in Siebel 

Campaigns 142
response charts, accessing 

(procedure) 143
Revenue Analysis (Response) chart, 

viewing 145
Trend Analysis by Employee chart, 

viewing 142
contact information, working with

contacts and prospects, viewing 127
imported or internal list, about associating 

with campaign 125
prospects or contacts, adding to a 

campaign 127
prospects or contacts, associating with a 

campaign 126
contact lists, viewing from 169
contacts

data matching and data cleansing 148
definition 147
removing from a list 171

contacts and prospects, about working 
with 125

Contacts List view, using to view contact 
information 169

D
D&B lists, about 125
D&B, integrating list management with

about 171
account data, viewing for D&B 

prospect 172
D&B prospect, promoting 172

data quality settings, verifying 149
deleting

assignment skills 113
Delivery Profiles

about 75
delivery profile, creating 76
fax offer, associating with 77

direct campaigns, targeted at 85
direct mail offers, about and Direct Mail Offer 

view 78
distribution list, generating

generating a list 130
note, previewing not working 129
previewing (procedure) 130
previewing, about 129
sample list example 130

Do you have another offer? applet, 

about 182
documents

marketing plan, attaching to 16
programs and campaigns, attaching to 90

Downloads applet, about 183
drag-and-drop, about Program Flow 

Designer 23
Dun & Bradstreet

See D&B, integrating list management with

E
email

campaign, testing 116
campaigns, stopping, resuming, or 

restarting 134
offers, sending 133
Siebel eMail Response, about configuring to 

capture email responses 117
email offers

See also Delivery Profiles; offers, creating and 
using

about and Email Offers view 65
attachments, adding to email offers 67
offer template, associating with 81
offer template, associating with an email 

offer 66
outbound email distribution 132
outbound email load balancing 132

employees
Call Status Analysis by Employee chart, 

viewing 139
Opportunity Revenue Analysis chart, 

viewing 141
Trend Analysis by Employee chart, 

viewing 142
errors

Internal Communication protocol error 
message 130

events
about using with Siebel Marketing 114
events timeline, about 89
offers, about associating with 72
offers, about how links appear in an 

offer 73
offers, associating with (procedure) 73
promoting, using campaigns 114
promoting, using programs 115

external lists, about 125
external lists, importing and managing

See also internal lists, creating and managing
about 147
campaign and response data, 

importing 155
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campaign and response fields, 
mapping 155

database columns in the prospect table, 
mapping list columns to 153

existing List Import Format, applying to your 
list 158

fields, mapping to when importing a 
lists 157

import mode, selecting (procedure) 152
import request, tracking the status of 154
import status and error messages, 

understanding 159
importing an external list, creating a 

record 150
importing external lists, format and tasks 

performed 150
List Import Format, about editing the 

settings 158
List Import Format, about using 157
List Import mode, selecting 151
list import request, launching 154
list records, maintaining attributes for 156
log file, viewing for an import task 159
mapping fields when importing, about 157
server components and tasks, verifying status 

of 148

F
fax offers

See also Delivery Profiles
about and Fax Offer view 74
offer template, associating with fax 

offer 75
sending 133

Featured Offers applet, about 181
forecast expenses and revenues, about and 

field (table) 14
forecasting for campaigns

See also activity plans, creating and using; 
activities, creating and using; 
timelines

frames, implementing Web Marketing 
without frames 178

fund request
marketing plan, associating with 15

G
global deployment, Web Marketing 173
Globalization Rules

offers, applying to 54

H
HTML

editor, using to edit the offer template 60
frames, implementing Web Marketing without 

frames 178

I
import request, tracking the status of 154
imported lists

campaign, about associating with 125
importing a list

mapping fields when importing 157
incoming data, validating the structure 

of 150
indirect campaigns, targeted at 85
Information applet, about 181
internal lists

about 125
campaign, about associating with 125

internal lists, creating and managing
See also external lists, importing and 

managing; prospects, promoting
about and list of tasks 159
contacts or prospects, adding to an internal 

list 162
creating internal lists, about 161
internal list, adding using prospect 

attributes 163
internal lists of contacts or prospects, 

creating 162
lists of prospects, about creating using 

attributes 163
lists of prospects, creating using attributes 

(procedure) 163

L
Lead Quality Analysis by Campaign chart, 

viewing 140
Lead Quality by Analysis chart, 

viewing 140
List Contacts and Prospects view, using to 

promote a prospect 166
List Import Format

about using 157
editing the settings, about 158
existing List Import Format, applying to your 

list 158
import status and error messages, 

understanding 159
List Import mode, selecting 151
list import request, launching 154
list management

See also external lists, importing and 
managing; internal lists, creating and 
managing
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about 147
list file name format 168
tasks, list of 147

list records
additional attributes, adding to list 156
additional attributes, creating 156
attributes, maintaining for list records 156

Lists view. using to view a contact or 
prospect list 169

lists, generating
generating a list 130
note, previewing not working 129
previewing (previewing) 130
previewing, about 129
sample list example 130

lists, viewing and maintaining
about and format 168
Contact or Prospects List view, using to view 

contact or prospect 
information 169

contacts, removing from a list 171
deactivating lists 170
deleting lists 170
Lists view, using to view a contact or prospect 

list 169
prospects, removing from a list 170

literature
offer, associating with 79

log file
import task, viewing 159

M
manually launching programs, about 131
mapping fields

about 157
when importing a list (procedure) 157

Market Development Funds module (MDF)
fund request, associating with a marketing 

plan 15
Market Plan Explorer, using to review 

marketing plan organization and 
associated tactics 19

Marketing Campaign Launch workflow 
process, understanding 137

marketing planning and budgeting
budgets, developing and assigning for a 

marketing plan 13
goal for marketing plan, creating 11
marketing plan organization and associated 

tactics, reviewing using Plan 
Explorer 19

marketing plan tactics, assigning a budget 
to 15

marketing plan tactics, associating with the 
marketing plan 13

marketing plan, about creating 9
marketing plan, associating a fund request 

with 15
marketing plan, attaching a document 

to 16
marketing plan, creating (procedure) 9

marketing program
See also automatic execution of programs
campaign launch status, monitoring 133
email campaign, suspending and 

relaunching 134
launching 131
manually launching campaigns 

(procedure) 132
manually launching campaigns, 

requirements 132
marketing program, designing

multistage programs, about and types of 
programs 24

marketing programs, designing
See also Program Flow view
creating 25
marketing program tasks, list of 23
multistage programs, about launching 25
programs, about 23
programs, creating (procedure) 26

media offers, about and Media Offers 
view 79

multilingual deployment, Web 
Marketing 173

multistage programs
about and types of programs 24
launching, about 25

O
Offer Analysis (Response) chart, 

viewing 144
offer templates, creating and editing

See also offers, creating and using
about and offer types associated with 55
creating an offer template 56
email offer, associating with 66, 81
hyperlinks (HREF). using in a template 57
offer template associated with an offer, 

editing in the default HTML 
editor 60

offer template associated with an offer, 
editing in the Offers screen 59

offer template associated with an offer, using 
the Siebel HTML editor 60

Offer Templates list, adding a template 
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to 57
Personalization Categories, about using 62
template not associated with an offer, 

editing 58
Offer Type Analysis (Response) by Campaign 

chart, viewing 144
Offer Type Analysis (Response) chart, 

viewing 144
offers

campaign, associating with 96
offer code lookups, performing 119

Offers page, using and configurable 
applets 180

offers, creating and using
See also Delivery Profiles; email offers; offer 

templates, creating and editing
Delivery Profiles, about 75
Delivery Profiles, associating with a fax 

offer 77
Delivery Profiles, creating a delivery 

profile 76
direct mail offers, about and Direct Mail Offer 

view 78
fax offers, about and Fax Offer view 74
fax offers, associating an offer template 

with 75
Globalization Rules, applying to offers 54
literature, associating with an offer 79
media offers, about and Media Offers 

view 79
offer template, associating with an email 

offer 81
offer, creating 52
offers, about 51
offers, modifying 54
phone offers, working with 77
product, associating with an offer 55
Web offers, about and Web offers view 80
Web offers, adding attachments to 81
Web offers, Web surveys, events, and URLs. 

about associating with offers 72
Web offers, Web surveys, events, and URLs. 

about how links appear in an 
offer 73

Web offers, Web surveys, events, and URLs. 
about Web Survey view 72

Web offers, Web surveys, events, and URLs. 
associating with offers 
(procedure) 73

opportunities
campaign, creating for 143

Opportunity Analysis (Response) chart, 
viewing 143

Opportunity Revenue Analysis by Employee 

chart, viewing 141
Opportunity Revenue Analysis chart, 

viewing 141
Order Revenue Analysis chart, 

viewing 141
overwrite existing record mode

about 152

P
Personalization Categories drop-down list, 

about and using 62
Personalization, using with Web 

Marketing 177
phone offers, working with

about phone orders 77
call guides, about and creating 78
call guides, creating a call guide 78

Pick Campaign dialog box, using to define 
new campaign with offer 29

Plan Explorer, using to review marketing 
plan organization and associated 
tactics 19

Preview List, about preview not 
working 129

Product Detail view, about using 182
products, associating with offers 55
program and campaign organizational tools

about 86
program execution schedule

deleting 136
editing 136

Program Execution workflow, about using to 
launch multistage programs 25

program flow
campaigns 27
events 27
lists 27
segment 27
stage 27

Program Flow Designer, about 23
Program Flow view

See also marketing programs, designing
about using 27
campaign, adding list to 31
new campaign with offer, defining 29
predefined campaigns with associated offers, 

adding 29
segments, adding to a program stage 29
stage, adding to the program 27

programs
See also automatic execution of programs
campaign launch status, monitoring 133
documents, attaching to 90
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email campaigns, suspending and 
relaunching 134

manually launching campaigns 
(procedure) 132

manually launching campaigns, requirements 
for 132

marketing programs, launching 131
programs timeline, about 89

promotion map
about modifying and prospect information 

(table) 167
map entries, modifying 168

prospect lists
deleting prospects from list 170
Lists view, viewing from 169

Prospect records, about updating using 
Update Existing Duplicates 
Mode 152

prospects
campaign, adding to 127
campaign, associating with 126
data matching and data cleansing 148
definition 147
list, removing from 170
viewing in Siebel Marketing 127

Prospects List view, using to view prospect 
information 169

Prospects More Info view, using to promote 
a prospect 166

prospects, promoting
Campaigns Opportunity, using to promote a 

prospect 166
List Contacts and Prospects view, using to 

promote a prospect 166
promotion map, modifying, about and 

prospect information (table) 167
prospect, promoting to a contact, about and 

application checks 165
prospect�s response to an opportunity, about 

promoting 167
Prospects More Info view, using to promote a 

prospect 166
prospects, defined 164

Q
quotas

See campaign quotas, setting up

R
Recommended Products applet, about 181
reject import record mode, about 151
related events

campaign, associating with 96

Request a Call view, about using and 
accessing 183

Request More Information applet, 
about 183

requested and assigned budget, about 14
resolve incoming duplicates mode, 

about 152
response charts

accessing (procedure) 143
Average Opportunity Revenue Analysis 

(Response) chart, viewing 145
Campaign Analysis (Response) chart, 

viewing 143
Offer Analysis (Response) chart, 

viewing 144
Offer Type Analysis (Response) by Campaign 

chart, viewing 144
Offer Type Analysis (Response) chart, 

viewing 144
Opportunity Analysis (Response) chart, 

viewing 143
Revenue Analysis (Response) chart, 

viewing 145
Siebel Campaigns, about viewing in 142

response data
importing, about and List Import view 

described 155
response fields for mapping import 

data 155
Response Details form, fields (table) 121
response forms

about 67
definition 67
relationship to response types 67

response management, using
about 116
attachments, adding 120
automatic response, about creating from 

opportunities and orders 123
offer code lookups, performing 119
opportunities, adding 120
orders, adding 119
products, adding 119
Response Details form, fields (table) 121
response information, adding 117
response, promoting to an 

opportunity 123
source code lookups, performing 118

response types
definition 67

responses
adding attachments to 120
adding opportunities to 120
adding orders to 119
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adding products to 119
responses management, about 179
responsibilities, setting up for Web 

Marketing 176
Revenue Analysis (Response) chart, 

viewing 145

S
Salutation applet, about 180
Schedule Calendar view

See automatic execution of programs
Send Product Information view, about using 

and accessing 183
server components and tasks, verifying 

status of
about and list of components 148
data quality settings, verifying 149
incoming data, validating the structure 

of 150
set distribution periods

See waves
charts 142
Siebel Campaigns

Campaign Achievements, viewing 139
Siebel Dun & Bradstreet

account data, viewing for a D&B 
prospect 172

D&B prospect, promoting 172
list management, about integrating 

with 171
Siebel eMail Response, about configuring to 

capture email responses 117
Siebel HTML Editor to edit the offer 

template 60
Siebel Personalization, using with Web 

Marketing 177
Siebel Web Engine, about 175
skills

skill items defined 111
skill items, associating with a skill 112

SmartScript, setting up 97
source code lookups, performing 118
status bars, understanding timelines 90
subwaves, determining the number 

created 131

T
teams

campaign, assigning to 99
organizations inheritance, turning off 25

telemarketing offers, about defining 77
templates

See individual template entries, and offer 

templates, creating and editing
response management, using

See individual campaign items
testing campaigns and offers

See individual campaign items
about 115
business scenario 115
email and fax offers, sending 133
email campaign, testing 116

The New User Link applet. about 181
timelines

See also forecasting for campaigns
about 89
color-code status bars, understanding 90
types of 89

tools
See program and campaign organizational 

tools
Trend Analysis by Employee chart, 

viewing 142

U
URLs

offers, about how links appear in an 
offer 73

offers, associating with 72
offers, associating with (procedure) 73

user interface, customizing
about 177
full-text search, about 179
response management, about 179
Web Marketing without frames, 

implementing 178
Web templates, using 178

W
Wave Batch Size parameter

subwaves, determining the number 
created 131

waves
about using 30
multiple waves, setting up 30

Web Anonymous User responsibility, 
about 176

Web Corporate User responsibility, 
about 176

Web Marketing, setting up and using
about 173
home page, accessing by visitors 173
Information page, about and applets 183
installing, applications to install before Web 

Marketing 175
Offers pages, using and configurable 
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applets 180
Product Detail view, about using 182
Request a Call view, about using and 

accessing 183
responsibilities and users, setting up 

default 176
Send Product Information view, about using 

and accessing 183
Siebel Personalization, using with Web 

Marketing 177
unstructured content, additional 182
user access, tasks to control user 

access 175
user interface, customizing 177
Web site visitor, about 173
Web site, about 180
Web Survey view, about using 182

Web Offer applet, about 181
Web offers

about and Web Offers view 80
attachments, adding to 81
offers, about associating with 72
offers, about associating with 

(procedures) 73

offers, about how links appear in an 
offer 73

Web Offers Downloads, using to add 
attachments to Web offers 81

Web Registered User responsibility, 
about 176

Web site
user access, tasks to control user 

access 175
visitor, about 173
Web Marketing home page, accessing by 

visitors 173
Web Marketing Web site, about 180

Web Survey view
Web Marketing Offers page, about 

using 182
Web surveys

offers, about associating with 72
offers, about links appear in an offer 73
offers, associating with (procedure) 73
Web survey link, about clicking on 72

Web templates, using to customize the user 
interface 178
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